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WOULD YOU LIKE your mobile number listed in a
public directory?

Late August, the Telecom Regulatory Authority of
India (TRAI) released a consultation paper asking cel-
lular service providers to publish directories of their
users’ mobile numbers, just like landline directories
that MTNL and BSNL publish.

Publishing a directory is a mandatory clause of an
Indian cellular service provider’s license agreement,
but service providers have consistently avoided doing
so, citing customer disinterest and privacy issues.
Insiders say the real reason the companies do not
want to publish a mobile directory is to avoid
stretching their already-tight budgets on publishing
a behemoth.

Whatever the reason, a publicly available cellular
directory in India is invitation to trouble—and not
just because telemarketers would take advantage of
the millions of mobile numbers  listed. The primary
cause of individual complaints would be the lack of a
system to address grievances. 

It is no secret that credit card companies, insur-
ance companies, and now even pubs and political par-
ties routinely use mobile messaging to garner new
consumers, or votes. The trouble is, who will address
an individual’s complaint if he or she receives spam
SMSes, or persistent, unsolicited calls, or, horror of
horrors—extortion calls?

The TRAI is, after all, a regulatory body—it does
not have the teeth to punish offenders.

The US has a national Do Not Call Registry, which is
a safeguard against telemarketers misusing publicly
available telephone numbers. If a telemarketer calls
up a number on the register, he is liable to pay a fine
of $11,000 per individual. The fine is imposed swiftly,
and the individual feels vindicated.

WYTY.com, also based in the US, has set up an opt-
in online mobile directory. You can register on the
Web site, and list your number. The biggest safeguard
here is that you need to specify a name to retrieve a
number. This means that only those who know your
name—your friends, relatives and business acquain-
tances—will be able to access your number.

In India, once again, this idea would elicit little
response. Most mobile users are not Net savvy. Besides,

telemarketers will always a find a way to reach you.
The TRAI, meanwhile, had asked cellular opera-

tors to comment on the directory idea by 
September 10. No one did. 

They have now extended the response deadline to
September 30. Is the TRAI expecting a miracle? 

We, then, come full circle, back to the same ques-
tion: would you like your mobile number listed in a
public directory?

I Got Your Mobile Number!

Editorial

“A publicly available
cellular directory in
India is an invitation

to trouble”

Sachin Kalbag Executive Editor

sachin_kalbag@jasubhai.com
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By Demand
You get to choose what goes on Digit
Interactive. This month, you chose:

America’s Army [Full Version]
Size: 728 MB

DirectX 9.0c SDK
Size: 227 MB

Online

Web Special
Goodbye Laptop,
Hello Smartphone
Smartphones of the future
will play 3D games, let you
watch TV, replace your
credit card... 

Digit
Patrons
It really

does pay to

be loyal!

Find out

more on

www.
thinkdigit.
com

Last Month’s Question:

What technology category do you spend
the most on? 

Digit Reader Poll

Spend?
What

spend?

This Month’s Question

Apart from making and 
receiving phone calls,
what else do you use your
mobile phone for?

SMS
MMS
GPRS
E-mail

Log onto www.thinkdigit.com
and vote

General Discussion
From Linkin’ Park to Doom III, 
it’s all here

Digit Discussion
All your feedback about the Magazine

and DVD and CD

QnA
Thousands of answers to every 

question you have

Bazaar
Have money, will buy!

There’s something for everyone on the Digit Forum

DIGIT OCTOBER 2004

taste technology at www.thinkdigit.com

Subscribe
No more snail-mail! No need to visit post
offices! All you have to do is log on to
www.thinkdigit.com/subscribe and use
your Credit Card to make sure you never
miss another issue of your favourite
magazine!

October 2004

Software Discussion
Some opinionated people here

Hardware Discussion
The hangout haven for geeks

Consumer
Electronics

Computers,
accessories

Cell
phones,

accessories
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DVD

Robert Sovereign-Smith

hanks to Digit’s
‘Upgrade to DVD’
offer, we have

received e-mail and phone
calls complaining about
how DVD-ROM and Combo
drives have disappeared
from the market. People
claim the only way to get a
DVD drive, these days, is to
use Digit’s offer, because
vendors just aren’t getting
any stock! Personally, 
I love complaints like this;
who wouldn’t? We love
being India’s Technology
Navigators!

Now that we have
caused such a stir, we need
to help you ‘navigate’
through your Digit DVD. It’s

not just more GBs, or more
software, it’s about the
quality that we are now able
to offer; the large, but use-
ful, tools and mind-blowing
games that we can now
offer our readers. And all of
this is sensibly categorised,
just as the magazine is, into
Digital Passion, Tools,
Business and Leisure.

Inside the October 2004
Digit DVD, you will find four
large games, a Linux distri-
bution for business use, J2SE
5.0 (codenamed ‘Tiger') and
DirectX 9.0c SDK for coders,
our very own MedKit ISO to
rescue you after a format,
and much, much more.

Let’s start with Digital
Passion: In ‘Dev Tools’ this

month, we feature the
DirectX 9.0c Software
Development Kit (SDK),
which includes the DX 9.0c
runtimes, API documenta-
tion for C++ and C#, sample
applications, utilities and
the source code—use it to cre-
ate DX 9 compatible applica-
tions. Also included are the
J2SE 5.0 Release Candidate
(Java 1.5 ‘Tiger') installers,
both for Windows as well as
Red Hat Linux, and the entire
documentation kit.

For those passionate
about games, we have a new
section called ‘Gamers’,
which will provide you with
game videos (sneak peeks),
patches and updates for
your favourite games. This
month we feature
Community Bonus Pack

(CBP) 2 for Unreal Tournament
2004, which offers you 41
maps and 2 new player mod-
els. Also featured are game
videos from a World War II-
based shooter called Brothers
In Arms, a preview of the
realistic looking Colin McRae
Rally 2005, and a special sur-
prise for all Super Mario Bros.
fans out there.

In ‘Digital Tools’, you
need to look out for eTrust
EZ Armor 2005 (an anti-
virus and firewall solution
from Computer Associates),
our very own MedKit ISO,
the past 13 issues of Digit in
searchable PDF format as
well as Tips & Tricks and 
Q & A right from January
2003 to the present set. A

new section called ‘From
The Mag’ will feature soft-
ware that we have tested or
recommended in the maga-
zine. You need not wait any-
more; just read the article
and then just pop the DVD
into your drive to use 
the software.

This month’s features
are Adobe’s Photoshop
Album 2.0 Starter Edition
and Google’s Picasa Image
Organizer. (Page 92, ‘How to
Organise Your Digital Photos’)

The ‘Digital Business’
section features the first
Indian Linux distribution
to be accepted globally—
Everyone’s Linux (ELX)
BizDesktop 4.0 gives you
the security and freedom
that every business target-
ed OS should. It bundles all
necessary applications
such as an office suite, proj-
ect management applica-
tions, scanning applica-
tions, PDF readers, etc—all
with the native Microsoft
Windows look and feel to
minimise the alienation
users might feel when
switching over to Linux. 

Finally, in ‘Digital
Leisure’, try out America’s
Army, a 728 MB FPS game,
sponsored, developed and
distributed by the US
Military—realistic is the key-
word here! The other big
games featured are Evil
Genius, Rome: Total War and
Zoo Empire. At the end of it
all, just sit back and read an
e-book or five by Sir Arthur
Conan Doyle, or watch the
movie trailer of Sky Captain
and the World of Tomorrow
starring Angelina Jolie.

Of course, all this is just
the tip of the iceberg. Pop
that DVD in the drive and
see for yourself… Welcome
to the Digit DVD experience!

robert_smith@thinkdigit.com

Experience The
Power Of DVD

T

Try out America’s
Army, a 728 MB FPS
game...realistic is the
keyword here!
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MS Launches New Range
Milind Deora
Member of Parliament

Twenty-seven-year-old
Milind Deora is India’s

youngest MP. A management
graduate from Boston
University, he intends to
generate employment by
initiating more computer
education classes in schools.

What is technology
to you?

I see technology
as a tool that
enhances the
quality of life. It
makes life

easier—be it in
communication or

entertainment. 
What gadgets do you own?
I own a two-year-old
Compaq Presario laptop, an
HP iPaQ Pocket PC and a
Nokia phone.
Will you use the Web to
serve your constituency?
I have set up www.
milinddeora.com which will
bring me closer to people. 
Do today’s politicians need
to be tech-savvy?
It’s good, but not a must.
Technology helps politicians
interface with the public, but
only where the necessary
infrastructure is present.
How often do you use the
Internet and e-mail? 
I browse the Web regularly
and check e-mail daily.
Do you chat often?
I use Instant Messengers to
keep in touch with my
friends, when I find time.
Any gadgets you are
looking to buy? 
I’m planning to buy an iPoD
soon (the 60 GB model) and
the new, sleek Nokia 7610
camera phone. 

Meera Vankipuram

UPGRADED MICE AND KEYBOARDS

Hello, What Have We Here
Camera phones may soon become the mainstream way
of clicking photos. For $2 a month, a new service from
OurPictures will let users send videos and photos to a
Web site, from where they can be viewed on any PC or
cell phone in the UK and North America.

Sony Takes The OLED Way
Sony has begun high-volume production of next-
generation displays using OLED technology. The
displays will be 3.8 inches diagonally, will offer 480
x 320 resolution, and will display 2,62,144 colours.
The viewing angle will be around 180 degrees.

llustration Farzana Cooper

Microsoft introduced
a new range of
mice and keyboards

after gathering customer
feedback and improving
upon negatives received.
The result is a set of new
innovative input devices
that focus on convenience,
mobility, comfort 
and design.

New features include
the ‘Living Hinge Cut’ on
the mice, which makes
clicks comfortable since you
apply less pressure, a much
more ‘Natural’ Keyboard
that replaces the forceful
split with a ‘Comfort
Curve’, and a slider in place
of the keyboard scroll

wheel, thereby facilitating
zooming into and out of
the document.

The new wireless
notebook mouse features a
receiver that stays snapped
into the belly of the mouse
when not in use. This
receiver also disconnects
the battery supply when it
isn’t required, thereby
conserving power.

For the image-conscious,
there are wireless mice in
20 different colours and
patterns—enough to suit
every mouse connoisseur’s
taste. If you want to go out
of the way, there is the
radical-looking, egg-shaped
optical mouse designed by

celebrated French designer
Philippe Starck. “It was
wonderful to work with
Microsoft and be part of
designing a mouse people
will use every day. As
beautiful juicers can
revolutionise kitchen
design, Microsoft’s new
mouse can modernise
desktop design.” 
said Starck.

There is also a focus on
security, with new
fingerprint-reading mice
and keyboards that aim to
replace the traditional
passwords—not just while
logging into the PC as well
onto protected Web sites. 
A stand-alone fingerprint
reading device is also
available.

Apart from this, the
regular features are all
here: optical technology for
all the mice, tilt wheel
technology to scroll
through large documents in
all directions with ease, a
smart receiver for wireless
products that detect
interference and guide you
to eliminate it.

Enter

Microsoft has expressed keen
interest in launching the XBox
in India, but only after a
careful study of the intended
market, and ‘broadband’
becomes a term you won’t
feel is wrong to describe
Internet access in the
country. Broadband is
essential for XBOX Live, the
online multiplayer service,
without which it is like a PC
without Internet access.

XBox for India?
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LCD MONITORS

The Big
Picture

Bigger is definitely better
when it comes to PC

monitors and television
screens. And when perks
include saving nearly 75 per

cent desk space, less eye-
strain due to zero radiation
and oodles of style, LCDs
beat CRTs hollow.

TFT LCD (Thin Film
Transistor Liquid Crystal
Display) monitors
are making their
presence felt in
the Indian market
over the past year.

With about
40,000 units sold
in India, in the
third quarter of
2003, research
firm IDC
predicted a 5.8 per cent
market share for LCDs in
2004. Yet, CRT monitors rule
the roost in the home and
SoHo segment, primarily
because of the cost-factor.   

Says R Manikandan, LG

India’s Deputy GM (Sales
and Marketing), IT
Products: “LCDs will never
replace CRT monitors in a
price-sensitive market such
as India. Since CRTs are
available at half the cost, it
will take a long time for
the latter to make inroads
into the home segment.” 

Pure View Technologies,
which has collaborated
with Taiwan-based Funet,
plans to woo the Indian
market by offering LCDs at
rates that are 20 per cent
lower than the big brands.
With factories in Sri Lanka,
Pure View has taken
advantage of the Free Trade
Agreement between India
and Sri Lanka.   

Dhananjay Shah,
Director, Pure View,
predicts that LCDs will
replace CRTs in India, in a
little over two years.
“Timing is key,” he says,
pointing out that LCD
prices are likely to fall
towards the middle of next
year. “This is primarily
because the technology is
evolving and with newer

products (read:
plasma displays)
entering the
market, LCD
prices will be
slashed.”   

Apart from
niche
companies such
as Pure View
and UMAX,

Sony, Philips, Samsung,
and LG have also entered
the LCD race in India. 

As of now, hospitals,
banks, and other corporates
have stepped onto the LCD
bandwagon. Pure View has

also joined forces with
channel partners to offer
buy-back schemes on CRTs
to customers. “Corporates
may upgrade to LCDs where
work involves long hours of
computer usage,” says
Manikandan.

LCDs are currently
available in sizes ranging
from 13 to 20 inches, while
plasma display sizes range
from 32 to 60 inches. 

The LCD revolution has
begun. But is India ready
for the makeover?

SEARCH ENGINES

War As Usual

With the advances in
search technologies, how
do we know which search
engine is better?

We started with a
traditional search query:

One Silly Question What is WWW?

Tusharr Tarun, Mumbai

Suraj Wanvari , Mumbai
Sowmya Katathil , Pune

IBM
IBM is developing an
entirely new type of anti-
spam software. The
research draws upon ideas
from programs that find
DNA sequences

The US of A
The US is still
Number 1 in
the dubious
list of
countries that generate the
most spam. It was
responsible for 43 per cent of
all spam sent in August 2004

I don’t know. It’s th
e opening gate

for the layman; makes surfing easy

World Wide Web. It connects people all

over the world. That’s how it got its name
World Wide Web. Great for research.
Gives you whatever you’re looking for

Why Waste Water..(laughs)..Just kidding, it’s World Wide Web, a network of sites

It’s World Wide Web. That’s it?This is a network of Web sites
Akai Ayemi , Dimapur

Ryan ‘Panther’ Mendosa , Mumbai

“LCD monitors
will never
replace CRT
monitors in
India”
-R Manikandan,
LG Electronics

Security Watch

JPEG Vulnerability

The Problem
Unpatched Windows PCs are
vulnerable to attacks by
innocuous image files.
Pictures in the JPEG format
can be embedded with a
malware application, which
eventually launches an
attack on a Windows system.
The vulnerability is present
in at least a dozen Microsoft
software applications, such
as Windows XP, Windows
Server 2003, Office XP,
Office 2003, Internet
Explorer 6 Service Pack 1,
etc. Only Windows XP
Service Pack 2 is not
vulnerable to the flaw.

Damages
PCs using the affected
software are in immediate
threat. In fact, security
software company McAfee
puts the potential for attack
at “very high”.

Precautions
Microsoft has created a
separate tool to deliver the
patches to its software. The
company has issued a
bulletin on at http://www.
microsoft.com/security/bul
letins/200409_jpeg.mspx.
The tool will scan your
computer for affected
software and will
subsequently download the
necessary patches. Even if
you have deployed Service
Pack 2, other software, such
as MS Office, will still be
vulnerable to the attacks.
Microsoft recommends
running the Office update to
tackle this threat.
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Travel And Tourism Within India

www.indiatourism.com
This no-nonsense site keeps it simple.
You will find everything you need—
tours, car rentals, ticketing, etc. It has
bundled information about the state
as well as the city’s history, heritage,
etc., so that you don’t cluelessly
overlook, say, a ruin right in the heart
of your destination!

www.indtravel.com
Notable here is the hotel booking
section. Pick a city from the map
and the hotels that are located
there show up. Choose the hotel
that suits your choice and budget.
It offers guidance on making your
trip memorable. The tips can be
insightful as well as amusing.

www.eindiatourism.com
This site is peppered with travel
guides and tours that take you
through wildlife sanctuaries and
places of pilgrimage. The India
Shopping Guide helps you pick the
right kind of souvenirs while on
holiday. The Travellers’ Tools section
has the Airlines Timetable, Distance
Calculator, Weather Info, maps of
India, a currency converter, and a
Railways Timetable.

indiatourism

indtravel

eindiatourism

Windows XP Service Pack 2
allows users to tag a USB
flash drive as read-only. This
process can be explained by
using the search string
“Storage Device Policies”.
The test was to find which
of the engines displayed the
most relevant results.

All engines did well. The
first hit on Google takes you
to a page where
information is immediately
available. The first hit on
both MSN and
Yahoo! are the
same, a link to a
site that
aggregates
syndicated posts
from the Web.
Some scrolling
here takes you to the
relevant information.

On to image searches,
which is something MSN
Search lacks. We chose
‘Mandira Bedi’ as the search
string. Both Google and
Yahoo! offer relevant results
and both filter images, if
you choose. 

Google offers a wider
range of hits in terms of
sources covered. Yahoo’s
results were somewhat
repetitive. 

Once again, Google

takes a slight lead in terms
of the variety of sources
covered, and the variety of
pictures offered.

In terms of news
coverage, Google News
offers Indian content, and is
frequently updated, while
Yahoo! doesn’t have enough
India-specific coverage. 

Google has a text-only
version of this service which
is a plus for mobile devices;
additionally it lets you

create e-mail
alerts based on
keywords. Yahoo!
offers RSS feeds
for its service, a
global content
similar to Google
News, but it had

no Indian content.
Google News offers

more content in terms of
news items covered under
a section than Yahoo!
News. MSN Search allows a
news search, but does not
link to a standalone News
section like its rivals—
strange, considering that
MSNBC is just such a
service.

To conclude, Google
comes across as a better
service, but its rivals are
catching up.

A man in the US was arrested for
using a GPS tracking device to
monitor his ex-girlfriend’s
movements. This updated a Web site
when her car was on the move

UNITED STATES

Singapore has started a campaign,
urging children to SMS “Be cool, be
bully-free” over their mobiles, hoping
that bullies will yield to peer pressure

SINGAPORE

GERMANY

A Round-up of Technology News from Across the GlobeThe Digital World

In Koblenz, Germany, a thief returned a laptop
he stole from a computer shop. A salesman
from the shop, while chasing him, stumbled
and broke his arm. The thief apologised and
handed the laptop back. He then ran off

CHINA

China’s online gaming industry is
worried that they could lose access to
cyber-cafés, or have games blocked
because of problems over licensing,
piracy and violence

RUSSIA

As part of a British programme to
prevent nuclear proliferation,
programmers who were once nuclear
scientists, are now designing
games for the Internet

UNITED KINGDOM

According to market research firm NOP
World, during the first half of this year,
1.9 million Britons went online for the
first time in their lives—the highest level
of newcomers to the Internet since 2001.

AFRICA 

US band REM, amongst other musicians, got together
on an album released on the Internet, called ‘Songs for
Sudan’, to raise funds for people in the crisis-hit
Darfur region of western Sudan

“Google comes
across as a
better service,
but its rivals are
catching up”

The Holiday Tech Guide

Three Incredibly Useful Sites
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WELCOME, SAHARA

New Kid On
The Block

In a joint venture, Sahara
Computers (Pty) Ltd South

Africa and Sahara India
Pariwar, entered the world of
PC manufacturing. On
September 10, Sahara
unveiled its gala plans to roll
out desktop systems,
notebooks and server
systems. The products are
expected to hit the market
by the end of this year. 

The question now is—
does Sahara stand a chance?
According to NASSCOMM
estimates, PC penetration in
India is a measly 7.81 per
1,000 people—way behind
countries such as China (46)
and Japan (450). This is a
positive sign for Sahara,
since the current PC market
seems to have enough space
for a new entrant. This is
why companies such as AMD
and Intel welcome Sahara’s
entry. Sandeep Keskar,
Country Manager of AMD
says, “The PC market can
only grow when new players
come into the market.” But

will Indian manufacturers
feel the pinch?

Devita Saraf, Executive
Director, Channels, Zenith
Computers, doesn’t think so.
She says, “We welcome
competition and would not
comment further on this.”
Even HCL Technologies, who
have been in the PC business
for the last 28 years, say it is
too early to talk of any
competition because of low
PC penetration.

For Indians, it would be
another PC jostling for
attention boasting of AMD
and Intel processors with
slim desktops and attractive
prices. Sahara’s Chief
Managing Worker and
Chairman, Subrata Roy, has
promised to make India a
leader in the hardware
industry. For now, all we can
say is: Welcome, Sahara!

ZDNET OPEN SOURCE

ZDNet India
Launches
Channel 

In association with IBM,
ZDNetindia.com has

launched its own Open
Source channel. It is dubbed
as an attempt to create a
unified platform for
information related to Open

Source in India. The aim is to
create an online resource
platform for both enthusiasts
and developers. 

The channel offers news,
articles, tutorials and
downloads on Open Source
technology. Articles are
sourced from IBM and the
Internet—including CNet
affiliates and other leading
Web sites. The four main
topics on the site are Apache,
Java, Linux and PHP.

The channel aims to
create a well-stocked database

Pulse

Digit Caption
Yes beta, I have found a
mobile that I think you
should buy...

Every month, Digit will carry a
funny caption for a photo. Come
up with something funnier, and
beat them at their own game!

Photograph Jiten Gandhi

Digital Cameras
The SSiiffyy  MMaallll has some stunning
offers on DVD players. Get the DDoollbbyy
DDiiggiittaall  DDVVDD  PPllaayyeerr  wwiitthh  55..11  CChhaannnneell
OOuuttppuutt for a mouth-watering price
of just Rs 22,,999955, instead of RRss  66,,550000.
Save a whopping RRss  33,,000000  on the
sleek AAkkaaii  DDVVDD--1111000000, originally
priced at RRss  66,,999900. Or just grab that
MMiittaasshhii  MMXX77777777 for RRss  33,,999900,
instead of RRss  55,,449900. There are LLGG
and PPhhiilllliippss sets as well among
some really affordable deals.
wwwwww..ssiiffyy..ccoomm

Telephones
Forget that cell phone for now! Its
raining telephones these days on the
RReeddiiffff  VVaalluuSSttoorree. Pay a meagre RRss
449999 for the RRss  779999  DDeesskkttoopp  CCaalllleerr  IIDD
pphhoonnee..  A set with LLCCDD  CCaalllleerr  IIDD  and
CClloocckk  DDiissppllaayy  will simply leave you
drooling—RRss  11,,442255,,  instead of RRss
33,,999999..  And 44--CChhaannnneell  WWiirreelleessss
IInntteerrccoommss,,  earlier coming for RRss
33,,999999,,  don’t get cheaper than this, as
you save RRss  22,,884499..  A great array of
cheap, yet the latest, telephones en
masse. Go, make your call.
wwwwww..rreeddiiffff..ccoomm

A Selection Of Best Offers From Popular E-commerce Sites

Last Month’s Winner!
Sunny Ravindran — Indian
CenTraino Mobile
Technology!!

Send your captions to
beatthat@thinkdigit.com
and win a Logitech
Optiocal Mouse
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of technical expertise and
information on Linux Apache
MySQL Perl/Python/PHP
(LAMP) technologies under a
single umbrella. It will
complement the numerous
well-entrenched Linux User
Groups (LUGs) in India to

consolidate the Open Source
knowledge base.

The site stresses on
learning from the tutorials,
and sharing on the forum.
Links to any Open Source
project can be uploaded,
along with a short
description, to the ‘links’
section.

ZDNet India Open Source
is also organising what it
calls the ‘biggest contest on
open Source Java’ for Open
Source developers. IBM will
sponsor the prizes for
the contest.

MEGAPIXEL PUZZLE

Pixel Puzzle

You are in the market to
buy a digital camera

that you have been saving

for, but are overwhelmed by
the pixel figures—3.2, 4.1,
and 5.1. The question: does
a higher pixel number,
mean a better picture?
Apparently not! According
to Time magazine, there is a
lot more to digital cameras
than just megapixels.
According to Shyam
Sunder, Manager, Digicam
Products, Canon India, “A
good digital camera
consists of a lens,
resolution and a processor;
a compromise on either of
these affects the picture
taken.” So, why do
companies highlight the
pixel factor?

Kartik Mehta of J J
Mehta and Sons, one of
India’s largest dealers of
digital cameras, says, “It is
a combination of pixel, lens
and processor and hence
the price variation.” Often
digital cameras, advertised
as being very cost effective,
come with a digital zoom
that does not translate to
good pictures. Plus, beware
of the difference between
actual and effective pixels. 

“During mass
production, in one mass
square area, a number of
pixels are dead, which
means they will never
reflect any light. So, look
out for effective pixels in
cameras,” warns Rajeev
Jaswal, National Sales
Manager, Olympus India. 

How will you know then
which is the right camera
for you? As Sunder of
Canon India says, “Do not
get megapixel-hungry. A 3.2
megapixel for a home user
would do just fine.” While
Mehta advises to opt for
branded products, Jaswal
points out that features
such as a lithium battery
and optical zoom are
equally important. So, do
look beyond the megapixel.

MENTAL MUSCLES

Codeprix ‘05 

Want to test your
brawn in writing
sheer code?

Codeprix ’05 can give you
the arena to pit your skills

against other code
gladiators, not just from
one city, but from across
the nation. To be held on
January 17, 2005 at K K
Wagh College of
Engineering, Nashik, it
promises to be an all
round test of
programming skills. 

Codeprix ’05 will have
six different challenges:
‘KnowledgeTest’ will test
quick thinking and
accuracy. ‘Codathlon’ will
test how quickly the
participants can code, and
how compact, efficient
and accurate their code is.
‘Trashcode’, the antithesis
of ‘Codathlon’, will test
the ability of the
participants to write the
worst code possible. The
challenge of ‘X-code’ is to
write a programme to

Trust Busters

Connect in haste and
Repent at leisure seems to

be the motto of Tata Indicom
service. If newspaper reports
are anything to go by, quite a
few subscribers have been
chanting complaints about its
incorrect bills and inept
service. Ankush Tambey from

Mumbai is one such example.
The Indian Express recently
reported that Tambe
(Customer No: 500105566)
was billed twice for the
month of May. He received
two bills from Tata Indicom,
one on June 4, and the other
on June 23. These twin bills
matched right down to the
challan number as well. Kirit
Gore, another Indicom
subscriber, went through all
the gruelling procedures
needed to cut the line, But all
the hassles, it didn't get
disconnected. A month later,
his was still alive and ringing!
As for Tata's response,
Debashish Sur, Head of
Customer Care, couldn't have
been more corporate: “All
complaints have been taken
care of,” he said.

GENDER 

BENDERS

Abhishek, a medical student smirked. “Mission Impossible?
NO WAY!” A swift click on the Start button, and the next
moment, the arrow key was looking up the Programs list.
In a few more moments, he found his way out—Accessories >
System Tools, and there you go, Disk Defragmenter. The
hunt ended almost as soon as it had begun. A second’s
hesitation, a right-click on C:, and that’s it.  
A cakewalk indeed!

Abhishek Kumar vs Vaishali Sanwane
Find and Start the Windows 
Disk Defragmenter 

25 sec.

50 sec.

As Vaishali, also a medical student, hesitated for a while
before launching the hunt, the task suddenly looked stiffer.
But that was not to be. She kept her cool, and steadily ran
the mouse over the Programs list. Oops, where’s the System
Tools? Accessibility… Communication… Entertainment… Ah!
Finally. Soon, the elusive Disk Defragmenter showed up. Not
quite at lightning speed, but still a good job!
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solve a given problem,
while ensuring that no
other can crack that code.
‘bug--;’ is a test of
knowledge of compilers.
The dare would be to
explain a particular
error message
generated by the
compiler compiling
bad code. The final
hurdle, ‘Codessence,’
will be a test in
reverse-engineering
skills, where a given
executable has to be
reverse-engineered,
based on a given set of
inputs and outputs. The
coder who achieves it by
running the executable
the least number of times
wins. The last date for
registration is October 15.
You can register at
codeprix2005@hotmail.com.

N-GAGE INDIA

Nokia eN-
Gages India

On September 14, Nokia
launched the N-Gage QD

Mobile Gaming
Championship, which gives
gamers from all over the
country to take home upto
Rs 10 lakh in cash prizes. The
game, Hero Commando,
specially developed for this
championship, will have to
be played in bronze and
silver rounds, eventually
concluding in a gold round
on October 31. 

Specially designed N-
Gage Challenge Buses, each
with four N-Gage consoles,
will parade through 47
cities inviting players to gun
it out at each other and
prove their worth.

According to The Register,
though Nokia has shipped
out a million N-Gage QDs to
date, about 600,000 units
were announced shipped in
February of 2004 since
October of 2003—the first
six months of the QD
release—leaving only 400,000
units to be sent out in the
next six. This 33 per cent
decline in shipments may
indicate a waning market for
the QD. Even after

reasonably widespread
availability of the N-Gage QD
in India, since its October
2003 launch, and also its
comparatively low price,
sales figures for Nokia’s

mobile gaming contender
are alarmingly low. The
championship is perhaps an
effort to increase the sales by
luring potential mobile
gamers to switch over to the
QD, and with a Rs 10 lakh
bumper prize, it might just
do the trick!

For those who want to
practice the game before the
challenge, download
Commando Bronze by
sending 260668 as an SMS to
5555, although this requires
GPRS connectivity.  

HOT NEW SMARTPHONE

Say Hello to
Blackberry

Thanks to telecom major
Bharti, you will soon be

able to drool over the
Blackberry—one of the
hottest smartphones around,

according to pink newspaper
Business Standard. The tie-up
with Bharti will provide
Blackberry customers an
Airtel connection and other
specialised services. With a
price range of Rs 20,000 to Rs

30,000, the target market is
likely to be corporate clients
in the five big metros.
Cheaper models  may be
introduced soon.

Blackberry smartphones
offer several value-added
services, including the
‘push’ technology by which
office e-mails can be
transferred automatically to
the phone. Blackberry’s
‘SureType’ technology
allows users to dial or type
either by single-handed
operation or two-handed
thumb typing, without the
limitations of traditional

phone keypads.

PHONEY MP3 PLAYERS

It Had to
Happen

In the August issue of Digit
we said that by end-2004,

phones would double up as
MP3 players. We were right!
On September 6, Samsung
unveiled the clamshell SPH-
V5400, touted as the world’s
first phone with a hard drive.
The hard drive stores 1.5 GB,
and the phone will retail for
$800 (Rs 37,000) in South
Korea—Samsung has not
disclosed any plans to sell it
outside of that country yet.

The phone can double up
as a full-fledged MP3 player,
although there are no details
on the interface yet.

The idea of phones with
hard drives has been with us
a long time, so why haven’t
manufacturers come out
with them before? Answer:
disk sizes and reliability.
Even the arrival of 1-inch
drives—which make arming
phones with hard disks a
possibility— hasn’t made
production easy or cheap.

Another interesting
feature is that the phone can
broadcast audio to FM
receivers in its vicinity.

What will spur the
demand for such handsetsis
is the availability of cheap,
small form-factor hard disks.
Seagate has developed a 1-
inch, 5 GB drive, while
Toshiba’s drive is even
smaller—0.85 in in diameter,
and stores 2 to 3 GB. 

What is a DualDisc?
A DualDisc is a new optical
disc format announced by a
group of record labels. It is
designed to make music CDs
more attractive to consumers
by using additional content.

How does a DualDisc work?
A DualDisc will have a full CD
album on one side and its
enhanced version on the
other. It will be compatible
with any device that plays
either CDs or DVDs.

Who is responsible for the
DualDisc format?

It is the work of a consortium
that includes major labels,
such as EMI Music, Sony BMG
Music Entertainment, Warner
Music Group, and Universal
Music Group.

Why do we need DualDiscs?
With DualDisc, musicians will
have more than one medium
to reach their audience. The
DVD side is meant to carry
video clips, interviews, concert
shows and links to Web sites,
in addition to music in the
much richer DVD-audio
format. It is hoped that this
will make the product
experience much more
immersive and interactive.

When was the format
revealed?
The DVD Forum approved the
format this June. However, a
German company, DVD
Plus,claimed a pending patent,
which describes a similar
product. The patent was filed
by DVD Plus chief Dieter
Dierks in March 1999.

Where can I find DualDiscs?
DualDiscs have just been
announced and are expected
to make it to the market by
the end of this year.
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To many, gaming is an addiction, an
obsession. Is a gamer a social outcast,
or just plain misunderstood? Just
what is inside the mind of a gamer?

Im
aging Jayan N
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What Lies
Beneath
Suprotip Ghosh

s we enter the dimly-lit gallery at
Hiranandani, in the distant Mumbai
suburb of Powai, a huge

poster of a female model greets
us. Seductively, she calls the
faithful Underground to satiate a
Need for Speed. 

Elsewhere, speakers pour out
heavy metal. Arclights on pedestals
focus on wall hangings, and
there are PCs strewn around. To
the uninitiated, this seems
chaotic. But once the lights and
sounds become familiar, a
pattern emerges. 

“These PCs are for Unreal
Tournament, those for Counter-
Strike, and the ones here, NFS,”
someone in a World Cyber
Games T-shirt points out.
The computers face each other,
making eye-contact between
opponents impossible. Once you sit and
strap in, your opponent is a cyborg, or a
football team, or a few cars. Unreal.
Positively Unreal!

The team playing Counter-Strike looks tense,
typing in familiar codes and keystrokes. Terse
commands make the rounds, as does the occa-
sional whoop or cry on making a kill, or getting
killed. It is real, very real: the emotions, the
adrenaline, the arclights above, the huge banner
of Counter-Strike with the first character—
female—looking intently just over your shoulder.

The Passion
Psychiatrist Dr Mukul Choksi tells a story: his
friend had brought in his teenage daughter.

A



Apparently, she had developed a habit of playing
computer games at her friend’s place. Naturally,
her parents complained that her studies were
being hampered. They desperately sought meas-
ures to stop this “menace,” which was keeping
their daughter awake night after night. 

Dr Nirmala Rao of Aavishkar, a self-develop-
ment centre in Mumbai, shares two cases. Zee-
shan (name changed) was brought to her by his
father—a doctor. Zeeshan had been frequenting
cyber-cafés since standard XI. Initially it wasn’t a
problem, but by standard XII, he was spending too
much time on the computer, playing games. 

Sensing an addiction, his father arranged for
Rs 45,000 and asked his son to buy himself a PC.
However, one day he found that there was only Rs
10,000 left. 

The boy had gone to the extent of spending
the money, in unspecified ways, in order to be
able to participate in a gaming competition. A rep-
resentative of the official sponsors of the compe-
tition, when contacted, said that there were no
registration fees involved; so the money was prob-
ably spent in practising over LANs in cyber-cafés. 

“Competitiveness turns children into addicts.
It’s an easy addiction, like gambling,” says Dr Rao.

The Lotus-eater
In another twist, an eight-year-old girl com-
plained that her mother stationed herself in
front of the computer the moment she returned
home from work. In a family of working parents,
the kid was on her own most of the time, and
craved for some attention in the evenings—which
her mother failed to satisfy. 

This slowly drove her to depression. The
mother complained that her bank job tired her,
and that the PC—including the games on it—
helped her unwind.

Vishal Seth, a member of Team Acid from
Pune, which won the Counter Strike tournament
at the WCG (World Cyber Games), admits that
games are addictive. But he insists it’s a hobby,
and he will be able to give it up. Reginald Miranda
from Delhi says he gives himself seven out of 10
in terms of level of patience. 

“I used to play eight to 10 hours a day before
joining work.” He says that that is now down to
about four hours. He still plays on weekends,
though. Rahul Rohira, also a member of Team

Acid, and Varun Srinivasan of The International
School, Bangalore (TISB)—both avid gamers—are
silent about how patient they are!

With the exception of Varun, the night is the
time for all gamers. Known as Cybervarun in the
Massively Multiplayer Online Role Playing Game
(MMORPG) Ragnarok, he spends 12 to 24 hours a
week playing over a network. Cyber-cafés being
closed or inaccessible, he does not play at night.

Most gamers insist their parents have no
problems with their gaming habits. They all do
miss dinner at home though.

The Power
“People always look for stimulation,” says Dr
Rao. “Excitement, sensation! Computer games
give them that. In a game, you are the master,
have control and can get a lot of adrenaline
rush. Routine life is boring.”

She says that gamers are addicted to the
“power” that games offer over a PC, the kind of
which they can not wield over people in their age
group in real life. They therefore prefer a com-
puter over people, thereby shunning social life.

It is regularly found that young kids who take
up a game, speedily graduate to a higher level of
skill. Young and tech-savvy people pick up things
faster since the brain is fresh and reacts faster.
Another possible reason, Dr Rao  says, is that
they have to be quick, else they lose points.

Dr Choksi agrees. He suggests a virtual
feeling of satisfaction as the reason for such
craving. Citing the example of chess, he says it
challenges the intellect, but it does not allow for
interaction with another individual, the kind
that is there to be had in virtual games. 

He says, “It is screen fascination. It gives you
a false sense of mastery, a personality in a virtual
world.” He does say, though, “Computer games
are not bad, as long as there is no addiction.” 

This myth of success at the virtual level being
an impetus to addiction is hard to believe. Most
gamers came across as fairly successful, normal
people. True, the adrenaline rushes while they
are playing, but none admit to delusions or an

Reality check

Can you answer the following questions?
1 When was Bill Gates born? 
2 Do you read books? Who is the author of

a. Asterix comics 
b. Calvin and Hobbes 
c. War and Peace 
d. Hitchhiker’s guide to the Galaxy 

3 Who is John Romero?
4 Who is the current deputy PM of India?

Only Miranda got most of them right. The others got a
maximum of 2 or 3 correct. However, they all have their
favourite cartoons and favourite music. They surf the Net, and
are not averse to watching TV.

Answers:
1Oct. 28, 1955
2a. Goscinny and Uderzo

b. Bill Watterson
c. Leo Tolstoy
d. Douglas Adams

3One of the designers of Doomand Quake, and also of 
classic games such as Wolf 3D

4No one! We don’t have a deputy PM

Vishal Seth is the World Cyber Games 2004 (India) champion in FIFA 2004

In a game, you are
the master...
Routine life is
boring
Dr Nirmala Rao
Psychiatrist
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urge to harm people: Miranda works with
Fidelity, a leading investment firm in Delhi. He
says that he has never felt an urge to replicate his
activities in Doom or Quake in real life.

However, the way these people interpret delu-
sion is significant. Says Varun, “Actually, my
gaming life and my real life are separate. I have
never actually felt the need to shoot down hordes
of demons escaping from the gates of hell,
really.” Rohira strongly objects to suggestions of

delusion: “Definitely not. Or everyone playing
Counter-Strike would have a desert eagle.” All
these interpretations of reality, tellingly, are still
in terms of the game!

None of them had an opinion about why
extreme, gruesome incidents could happen—such
as the one in which teenagers in the US last year
shot cars à la Grand Theft Auto III, or the Los Angeles
multiplayer tournament incident wherein a
player held a gun to an opponent’s head.

The doctors though, have an explanation.
They attribute such recklessness and irritability
to a marked lack of exercise. Gamers have hyper-
active, hyper-alert brains and relatively less phys-
ical exercise, which is why they become fidgety
and restless.

Game developers, though, disagree. Samrat
Sharma, on behalf of VBeing Software, pro-
grammers of Kawabonka.com, an online game
site, argues that it is just as possible to become a
deranged killer by playing GTA III as it is to
become a pro golfer by playing Tiger Woods PGA
Tour. If only talented people can become pro
golfers outside of the game, only true psy-
chopaths can kill people outside of the game.

The Pain
It is not fair to comment on the general knowl-
edge of people based on a few questions (see box
“Reality Check”), but except for the last question,
most of the other stuff is somehow available on
the Internet or is related to gaming. The people
quizzed should have been able to answer most
of the questions. This was an indication that
most gamers we studied show a marked lack of
interest in the outside world.

Dr Rao attributes this to preoccupation:
when a person has left something half-done, he
or she is occupied with it for the time when he
or she is not doing it. 

In psychiatric parlance, this is the Zeigarnic
effect. It is similar to when you are reading an
interesting novel at night, and cannot sleep until
you finish it. This preoccupation makes it diffi-
cult for gamers to focus on other tasks.

Thus, social as well as physical activities
suffer. Problems with bone and muscle growth
crop up. Sitting constantly in front of a computer
results in a slouch. Eye strain and neck strain is
on the rise. Growth is stunted. 

Dr Choksi feels addiction is more often than
not a problem associated with some psychiatric
condition that needs to be treated. It appears
that people who are shy, introverted, prone to
depression, or possessing a schizoid personality
are vulnerable to any form of addiction, games
included. 

A well-balanced individual entertains him-
self with a game for a while, and then gives it
up. People with problems cling to the game. 

The Idea
Developers in India recognise the potential of
games and are gearing up for the next wave of
gaming. Sharma of VBeing sheds light on what
goes on behind a successful game. For an immer-
sive experience, the most important aspect is sus-
pension of disbelief. 

The moment the player surrenders his senses

Wasting The Pie

It is as possible to
become a
deranged killer by
playing GTA III as
it is to become a
pro golfer playing
Tiger Woods PGA
Samrat Sharma 
Game Developer

Ever wondered why the guy/gal next door has a bevy of
friends and you don't? (S)he doesn't play games! Time to find
out. Get a pen and paper and write down the following:

Who are you? Son/daughter, brother/sister, friend/colleague?
Let that be your role in life. Write it down.

Identify your goals: What do you want to be? Sportsman?
Doctor? Writer? Manager? Want to have a great physique? A
popular face in college with lots of friends? Want to learn the
guitar and impress? Write this down too.
Draw a clock like the one on the right. It is ticking. It is the
average day. You spend eight hours at work/or college. Point
that out on your clock.

About five hours
in the evening

8 hours spent
working or at
college 

8 hours of
sleep, for a
normal person

Three hours
in the morning

Note the overlapping time

Remember, cutting down on sleep means your body clock
cycle suffers. The next day starts late, and there is a further
skew in the time others are able to give you. Your work/stud-
ies might suffer too. Courtesy: Aavishkaar

Mark the time when you play
games. Note the overlapping
times. That is when you are
losing out on your goals

Point out how much time you can spare for your roles and
goals. Are all the people you need to share your life with to
achieve your goals as well as roles able to give you time in
those two little windows?

Reggie, ace gamer, 
management trainee, dot-
ing friend
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to the game-world, and becomes one with it, the
game designer can lead the player on a fantastic
roller-coaster ride. To establish suspension of dis-
belief, the game-world has to be believable. For
example, flying aliens in a World War 2 game
make no sense. If everything fits, suspension of
disbelief is not hard to achieve.

Another aspect to be considered is player
involvement. The world and the environment cre-
ated should be responsive, and the player should
have a lot of freedom to do things inside it. The
more involved the player is in flying, shooting,
running, giving orders, etc, the more fun he has.
Finally, if it’s not fun, it’s not worth it.

Because players need to mentally surrender
to the game, there is, naturally, a tendency to
call them juvenile. However, as psychologists

point out, most have a rather high
IQ. Dr Rao says, “Some high-IQ

people are not successful in life.
Only the average person has

the tenacity to go on and
succeed. High-IQ people

get bored very easily. They
want something new, something

different, and this desire is exploited by
computer games.” This is why high-IQ people

tend to fall for addiction faster than those with
an average IQ.

Endgame
All the gamers spoken to agreed that it is uneth-
ical to play pirated games. They are aware of the
rights of intellectual property, but they say they

have no choice. Vishal and
Varun reckon that games are too
expensive to buy consistently.
Both, however, admit to having
spent more than a lakh on their
PCs.

“I like to think of games as an
art form for this generation” says
Samrat. As for addiction, “It’s
your involvement that makes a
game addictive,” he says. Maybe
it’s an art form, maybe it’s an
addiction, but in the United
States, there are people who reg-
ularly spend entire nights and
weekends ‘living’ and ‘working’
in virtual lands such as EverQuest.
EverQuest is a virtual world in
which people work for a living
just as in the real world—and
they even trade virtual goods for
real money on real-life auction
sites such as eBay.

Meanwhile, the numbers of gamers increase,
and in a world becoming increasingly devoid of
empty, open spaces and free movement, we have
begun to turn towards virtual worlds, where the
colours are rich, the movement is free, and you
can run, race or kill at your own pace. The bot-
tomline is that there is no limit to what you can
do in a game, as long as you play by its rules.
Maybe that is what it is: dreams come true
inside the mind of a gamer! 

suprotip_ghosh@thinkdigit.com
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Rahul Rohira feels that reality is distinct
from a game
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Solution

Price Rs 6,500

-Here’s how you add an item to IE’s context menu:

Start the registry editor. To do so, go to SSttaarrtt  >>
RRuunn and type ‘‘rreeggeeddiitt’’.

Navigate to key HHKKEEYY__CCUURRRREENNTT__UUSSEERR\\
SSooffttwwaarree\\MMiiccrroossoofftt\\IInntteerrnneett  EExxpplloorreerr\\MMeennuuEExxtt\\

Create a new key and name it the way it should
appear in the context menu,say. ‘‘GGooooggllee  SSeeaarrcchh’’.
If you want a shortcut key, put ‘‘&&’’ before the
name, eg, ‘‘&&GGooooggllee  SSeeaarrcchh’’.

In the right pane, for the (Default) string, enter
the Web site URL, file name or program name
that should run when the user clicks this new
item.

Create a new DWORD value called ‘Contexts’
and put in one of the following values
depending on where you intend the new item
to appear:

All menus: F3
Only in image menus: 2
Selected text: 10
Table content: 1

For example:
To send tabular content of a Web page to an Excel
worksheet, set the (Default) value to:

‘res://C:\\Program Files\\Microsoft
Office\\OFFICE11\\ EXCEL.EXE /3000’ and set the
Contexts value to 8. The path to your Excel exe-
cutable (if installed) may be different.

To search selected text using Google, set the
Contexts value to 7e and the (Default) value to
‘file:///C:\\googlesearch.html’ or the path to
where the .html file is located.

You can find a working GoogleSearch.html on
the ThinkDigit.com forums at http://www.
thinkdigit.com/forum/viewforum.php?f=7.
Modify this file to search your favourite search
engine or a reference site such as IMDB.

This
Month’s

Challenge
Replace the

Windows XP logo
in the General tab

under System
Properties with an

image of your
choice

Rules and Regulations
Readers are requested to

send in their answers by the
15th of the month of
publication.

Employees of Jasubhai
Digital Media and their
relatives are not permitted to
participate in this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any
damage to your system that
may be caused while you are
solving the problem.

Every month, Digit will pose a challenge
that will set you thinking. If you indeed
crack it, send in your answers to Digit

with your full name, address and contact
details to takeacrack@thinkdigit.com.
Digit’s Test Centre will select the correct
answers. In case of multiple correct entries,
the winner will be decided by a draw of lots.

Win!

Last Month’s Challenge Was:
Insert an item in the menu that opens as you right-click on a Web page
in Internet Explorer.  The winner of the Microsoft keyboard and mouse
is Bhavesh Anandpara. Congratulations, Bhavesh!  His solution is
published below...

Insert an item in the
menu that opens as
you right-click on a
Web page in
Internet Explorer

The (Default) value reflects the action to be taken when
you chose the new menu item

Sponsored by

Brought to you by
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Day 1
The sleek 20-inch cinema display arrived

today—the apple of our eyes. The chassis was

big and bulky.

Day 3
In no time, I discovered that the system can be

switched on from the monitor too!

Day 5
I know Windows XP like the back of my hand.

But something with Unix lurking beneath?

Hmm.. I wish my thoughts away and face the

system. Am glad, very glad. The OS was as

simple as simple can be. No hassles. An

intuitive interface led me around swiftly.

Changed desktops, wallpapers, themes and

tinkered a little as

well—all in half a day!

Day 8
A feature called Expose (!) gets all open

windows to show themselves at the push of a

button. Then there is the genie effect that gets 

applications to appear and ‘shrink’ away into

the taskbar. 

Day 10

The colour accuracy impresses. Crystal clear

images with the right shade of blue or the

right tinge in green make other LCDs look like

hand-me-downs! The Mac is the brightest, and

I’m convinced it’s the best.

Day 15

Time to flaunt. I called in the design and the

layout guys. Well, they were dumbstruck to see

something that’s pristine in its visual

representation. I deftly got the G5 to show

those minute differences in colour. 

Day 18

Suddenly, the monitor screen blanked out. My

heart skipped a beat.. Oh well, it turned out to

be a power failure. But the damage had been

done. Something was wrong with the operating

system—it just wouldn’t boot.

Day 20

I made several attempts to revive the system, to

no avail. I called up Apple’s engineers. A solu-

tion was offered politely. Another hour in get-

ting that solution implemented, and the

machine was up and running again. 

Day 25

We got hold of Microsoft’s Office 2004. It’s better

than the 2003 version I use with Windows.

Applications such as iCal, iDVD, iTunes are all

bundled with the system—marvellous!

Day 28

Time’s up. I was in no mood to hand over the

system to Apple. It needed our product co-

ordinator a lot of nagging to persuade me to

put the G5 into the box.

Sanket Naik

It’s difficult to describe the feeling. Elated?

Umm, no. Happy? No, that’s an

understatement. However, one thing is for

sure, the G5 makes the rest of the computing

machines look like ironies.  

Its OS really grows on you. Windows XP held

no fascination anymore. Mac’s smooth

transitions, pristine graphics—beat that XP! My

world of Windows and dialog boxes spun for the

better. Here’s how:  
sanket_naik@thinkdigit.com
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The MPx from Motorola is a lot of things
done right. The message is loud and
clear—move over multiple devices. This

marvel blends the essentials of a cell phone
and a PDA. The dual-hinge design allows the
phone to open in both the traditional
clamshell mode and a rarely-employed
landscape mode. The clamshell is ideal for
normal banter over air-waves, while the
landscape allows the MPx to shine as a data-
centric device. The landscape view comes with
a complete QWERTY keyboard at your
disposal, for SMS and e-mail abuse.

Having captivated the curious, Motorola
makes the deal even sweeter by adding just
the right layers. 

Microsoft Windows Mobile software to
begin with, the operating system lends it the
PDA edge via tools for Internet browsing,
streaming video, access to corporate
applications such as e-mail services, Java and
flash support. You name it, you got it.

The hardware lends it a dollop of credence.
The MPx supports SD and MMC cards. You can
bolster its internal memory by adding an

external card of up to 1 GB capacity. The
beauty boasts of a 1.3 megapixel digicam with
flash, wireless connectivity via Bluetooth 
and WiFi, infrared support, tri-band
GSM/GPRS support, with a 2.8-inch, 16-bit
colour display providing a resolution of
320x240 pixels. Awesome! 

Digital Passion | Geek Dreams
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Motorola MPx

What is fusion
without grace?
Cell phone, PDA,
keyboard—It’s
all in one.
Here’s rolling
out the
Motorola MPx.
Stop drooling!
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Suprotip Ghosh

t was mostly made from junk! I
remember we actually used a hair clip as
a gripper to start with,” recalls

Jnaneshwar Das, as he ruminates upon his col-
lege days, back to the origins of COMRADE—the
Co-Operative Mobile Robots for Autonomous
Decisive Exploration project.

Not a multi-billion dollar, deep-space-explo-
ration-probe this, but a university project that
four students undertook at the Peoples Educa-
tion Society Institute of Technology (PESIT), Ban-
galore. The result was unique in its application

and sheer innovation. Adam and Eve, COM-
RADEs both, headed the same way as another
such endeavour half a world away: the Mars
Rover project, started and developed by NASA’s
Jet Propulsion Laboratory is similar in philos-
ophy and design to COMRADE. Besides,  the
application of Open Source software for Rover
was a first for any NASA project.

COMRADE involves construction of “net-
worked, autonomous mobile robots, equipped
with sensors, grippers and onboard computers.”
Networking is achieved through distributed task
resolution via a wireless link: take a bunch of
robots and give them a task in the form of a 

Fantastic Robots
THE COMRADES AND THEIR

Digital Passion l First Hand

Imaging Sani Mani

I

Four Bangalore engineers try Genesis of a different kind—they have built a
robot couple they like to call Adam and Eve. Evolution is not far behind
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Little did the four know that their robots
assembled at a makeshift workshop—an erst-
while kitchen—would prove that the “50 million
dollars” element is not true. 

The cumulative cost, as their accounts show,
is about Rs 50,000. Of that, around Rs 16,000-
20,000 came from sponsors—Yahoo! Inc and
Encore Software. Samyeer Metrani of Encore also
promised them a Simputer with a WiFi slot. The
innovation that went into COMRADE is revolu-
tionary, in that it used the most unlikely com-
ponents to achieve uncharacteristically
sophisticated results.

Mrinal, well-known in Bangalore for his
involvement with the Bangalore Linux commu-
nity, and his way with computer networks, dove
into robotics by the end of the second year when
he started working on ROAMER, a precursor to
COMRADE. He was the driving force behind all

programming script. Based on their capabilities,
the robots themselves split the main goal or
task into smaller tasks, hence ‘distributed.’
Currently, COMRADE employs only two robots,
Adam and Eve.

For example, a robot without a gripper
assigns itself tasks that do not need one. Each
robot possesses a highly layered architecture;
each layer being capable of interaction at var-
ious levels. 

Though it currently involves just two
autonomous robots, the system is expansible to
control any number of them. Adam and Eve are
“differentially steered vehicles.” Eve is equipped
with an “onboard robotic gripper with three
degrees of freedom.” 

Both have computers onboard for robot-logic
control and image processing. Adam runs on a
2.4 GHz Athlon processor. Eve, as of now, is con-
trolled by a laptop with a 115 kbps serial link
attached to a Simputer.

An important innovation was using WiFi for
communication between the robots. An 802.11b
version of the WiFi link connects the robots. But
why WiFi? Mrinal explains, “With a PC onboard,
WiFi was easier to install, and significantly
cheaper. You just needed to add a LAN card!”

“Nice weather, 50 million dollars, and
no fishing boats—these are all the
requirements for launching a craft 
to Mars” 

Das, Mrinal, and Sharad Nagappa were class-
mates during the Telecommunication Engi-
neering course they took at PESIT. Abhishek Sen
Gupta was the odd man out, studying Elec-
tronics and Communications Engineering. Das
or JD is from Orissa, Sen Gupta from Kolkata,
and Mrinal and Sharad are from Bangalore.

Biometrics is determining
identity based on physiol-

ogy: using fingerprints, iris-

recognition, hand geometry,
and facial recognition.
Microsoft has unveiled its
range of products with biomet-
ric security features. These

include mice and keyboards
with built-in fingerprint recog-
nition capabilities which will
replace your password screen
and protect your computer!

Biometrics

Digital Passion l First Hand

Eve gripping a box while Adam looks on—a revolution at work

Tech Specs

The Vehicle
The vehicle chassis is an aluminium framework
that can negotiate through rough terrain, house
the robotic arm and carry payloads when
required. The onboard power source is a 12V,
32Ah car-battery which can power the vehicle for
at least an hour. The 'robotics fabrication lab' was
a converted kitchen in Jnaneshwar Das's house.
Both vehicles have a maximum speed of 50 cm/s. 

Software And Control
A microcontroller from the AVR series provides
the low-level control. The microcontroller handles
actuator control, monitoring of feedback data
from encoders and the triggering and control of
the SONAR range finders. 

A Simputer supplies control information for
the microcontroller board via a serial link. It uses
the StrongARM SA-1110 processor whose speed is
equivalent to that of a 400 MHz Intel Celeron.
The Simputer handles image processing and
obstacle avoidance, and the onboard PC controls
WiFi communication with other robots. Encore
Software has promised to give a Simputer with a
WiFi slot in the near future.

Sensors
The sensors used on ADAM are SONAR range-
finders, Web cams and electronic compasses. The
range-finders map the environment and data is
processed by the computer. Image data from the
cameras are processed by IRIS.

Write In

Assembled something
just as geeky? 
Tell us about it. 
Write to editor@
thinkdigit.com

We used antenna
rods, broken CD-
ROM drives, tape
recorders and
torch-lights!
Jnaneshwar Das
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things Linux in this project. As he points out,
“We chose Linux for its technical capabilities.
Open Source always means greater function-
ality.” But did they write their code from scratch?
Mostly, says Mrinal; only a few scraps were bor-
rowed, such as the module to control the video
camera.

Before COMRADE, Sharad was involved in
audio processing and DSP experiments. He was
the brain behind the OpenGL GUI for the moni-
toring node. The resident expert in trou-
bleshooting routing problems, he also overcame

petty issues with a rather troublesome WiFi
driver, which refused to support multicasting.

Das was involved in robot construction and
architecture—the most critical part of the
project. In between solving problems in
mechanics, he also found time to team up with
Mrinal to design the motor-controller circuit-
boards and write the code needed to run them.
“The main circuit panel for the smaller motor
control boards was built from scratch,” says
Mrinal. Dasalso designed the interface between
the lower-level microcontroller-based actuator
array and the CPU.

COMRADE’s predecessors—3LER-3, Omnibot,
ROAMER and Dexter, were essentially SONAR-
based robots that found their way about with
the help of sound. Abhishek wrote IRIS, which
helps COMRADEs see via video cameras. 

He also played a critical role in designing
the robot co-operation architecture, and
authored BorgCode, a script that has since
become the language of the COMRADEs. More-
over, he designed the final execution environ-
ment, which integrated IRIS, the
communication system and the control module
into a seamless whole.

“We made the two robots with
material gathered from scrounge
markets and garage junk”

“The hardware wasn’t very sophisticated. The
image-processing software had to take that into
account,” says Abhishek, creator of IRIS, which
is the monitoring node software for ProjectTHE SIX COMRADES: Clockwise from left: JD, Sharad, Sen Gupta, Mrinal, Adam and Eve 

Adam:
Locates ‘intruder’
with on-board
sensors

Eve:
Receives intruder 
coordinates via WiFi
and moves towards it 

DODO:
Supplies
additional information
about intruder
coordinates

Obstacles:
Adam provides information
about their location too.
Required to determine path
for Robots

‘Intruder’

How Adam And Even Work
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COMRADE. Born as a set of simple 2D-image processing
operations, IRIS evolved into an optimised, object-based,
machine-vision system capable of complex vision tasks.
“IRIS is a system that allows robots to see and base their
planning and decision upon visual feedback. It is different
from other image-processing software because it uses
advanced algorithms to achieve functionality and imple-
mentation on a case-to-case basis.” 

The IRIS Engine is not limited to COMRADE. Any other
robotic system can use it as well. Though mainly working
from a command-line interface, it provides a real-time
OpenGL plot of the robots’ location. This node transmits the
collective tasks for Adam and Eve as BorgCode, which is
transmitted through WiFi to the robots.

A robot cannot execute all the instructions present in
the BorgCode. For example, Eve cannot execute an instruc-
tion to visually search for an object since it does not have a
Webcam. 

Thus, a “decompositor” breaks down BorgCode into exe-
cutable chunks of code, each of which calls for a single fea-
ture of the robot; it is these chunks that are downloaded
onto the individual robots for execution.

“We were forced to simplify it. The original idea was two
to three robots interacting,” says Sharad. 

The four underwent a nightmare debugging the code.
Sharad says that it was a great experience, but it didn’t quite
go where they wanted it to go. Pressured by PESIT to finish
the project on time, they compromised on a lot of things.

The autonomous robots are in place and working, but
the four agree that the co-operation part needs to be worked
upon. The robots work well by themselves, but they need to
be “married,” to fulfil the project goal. 

Abhishek wants to pursue artificial intelligence, and
take IRIS forward. And Sharad is leaving for the University
of Edinburgh. “Yeah, it feels bad that he is leaving,” muses
Mrinal, “but you see… it was a college project. And now that
all of us are working, it has become a hobby.” Sharad echoes
his thoughts.

“Once Sharad leaves, we might start working again,” says
Das, uncertainly. “But it requires a team, you know.” Sharad
agrees: “Most of the work happened because we were a
team. Once that breaks…” he trails away.

Das and Sen Gupta are colleagues now, and Mrinal
shares Bangalore with them. He stays in Banshankari, the
other two in Koramangala. 

Das reminisces how Adam once broke down, and Sharad
adds, “It was a nightmare, I mean, a motor short circuits,
and you don’t know what to do.”

Meanwhile, Adam and Eve wait for their final union.
“We thought some of our juniors would be interested in our
project. But no one seems to be ready,” says Sharad. 

His first love was Digital Signal Processing, and he
intends to go back to it in the future. The comrades have
decided to disband. 

The revolution remains unfinished. 
suprotip_ghosh@thinkdigit.com

Helping Hands

Kalyan Varma Alluri: Linux networking guru, has been with
Yahoo! Inc for 3 years. A PESIT Alumnus and a
photographer as well, he helped  get sponsorship from
Yahoo!.
Babu Kalakrishnan: Ex-scientist, ISRO, helped in circuit-
design and communication issues. Was the unofficial
project guide.
Atul Chitnis: Helped procure the Simputer as well as sonar
modules and electronic compasses during a crisis.

1/2 V AD



everything the lens sees, helping you frame a shot
to record what is needed.

How do these disparate elements record your
child’s first birthday party or your company’s
show-stopping presentation?

At the heart of the system beats the CCD. The
lens mechanism gathers light and focuses an
inverted image onto the CCD element. Light is
made up of particles of energy termed photons—
the energy of the photon is directly in proportion
to the intensity of light. A brightly-lit surface will
send forth photons full of  energy, while photons

from a dark area are low on energy. When
both these types of photon reach

the photo-sensitive
cells of the CCD,
their light energy
is transferred to
the cells in the
form of electrical
charges: a stronger
charge from an
energetic photon, a
weaker charge from
a tired one.

An arrangement
such as this will form

a black and white
image with contrast-

ing dark and light
areas, much like an

artist’s charcoal-drawn
impressions of a scene. The

colour information of the
scene shot by the lens needs

to be translated as well. 
Since any shade of colour

can be reproduced by mixing
the three primary colours—red, blue and green—
a camcorder only needs to record the varying
levels of these primary colours in a scene to faith-
fully recreate the colours. 

This is done in either of two ways; the path
taken by a camcorder determines its cost. The cost-
lier method is to use three separate CCDs, one  for
each of the primary colours. Thus, a red CCD
records the variation of the colour red in a scene—
similarly for blue and green. The three separate
colour variation maps are then internally
combined (as an overlay) to form a colour image.
By using three CCDs, the cost increases. Such
camcorders are called three-chip camcorders.

The cheaper alternative is to divide a solitary
CCD into permanent colour filters of red, green
and blue. These can be arranged in a variety of
manner on a CCD: the information captured in

40

Mustali Kachwala
and Ahmed Shaikh

he time is prehistoric. An unkempt,
unshaven caveman reaches for the near-
est flintstone and with the skill of a pres-

ent-day four-year-old draws the previous day’s
successful hunt on the walls. 

Echoing a distant future wherein memories,
cherished or otherwise, are stored and
exchanged over bits of paper and plastic. As was
then and is today, the message and the senti-
ment remains the same—capturing a memory
for future retrieval. The change is in the medi-
um. Presenting a closer look at one such medi-
um—the camcorder.

A camcorder consists of three main ele-
ments. To begin with, you have the lens mecha-
nism, used  to gather light and focus it inter-
nally. The mechanism consists of a series of
lenses, and motors to provide focus and zoom.
Finally, an iris regulates the amount of light
gathered. Next in line is the Charge Coupled
Device or CCD, an electronic element about one
cm in size consisting of anywhere between
three lakh to five lakh light-sensitive cells.
These are basically  photo-sensitive diodes. 

Finally, there is the recording section of a
camcorder, which records everything seen
through the lens, on a variety of media. Apart
from these three areas, there is also the
viewfinder, which is usually an LCD panel in
modern camcorders. The viewfinder shows you

DIGIT SEPTEMBER 2004
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CaptureTheMoment
In an age where
digital memories
rule the roost,
the camcorder
has become an
indispensable
tool. We
demystify the
tech behind 
the magic

MiniDV camcorders are the most widely available
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this manner is then fed to an on-board computer
which interpolates—guesses the final value based
on already gathered information—the available
colour information to form the final image. The
interpolation invariably loses out on information,
and thus you get what you paid for in terms of
image quality.

Now that we have translated the real world
into a series of electrical signals, a layer sitting
below the CCD takes up the charges and writes
them onto the recording medium. A digital

camcorder employs an analogue-to-digital (ADC)
converter at this stage, which converts the
analogue electrical charges into bits of data (0s
and 1s) and then stores them digitally. 

In terms of operation this is the only thing
that separates a digital camcorder from an
analogue one. Practically, the differences are
several. Most importantly, an analogue record-
ing fades with time while a digital one stays the
same with age. A digital record of memories also
affords greater flexibility: take it to a digital tool
such as Adobe Premiere or VirtualDub to add
effects, transitions, time-shifts, etc; e-mail it,
record it to a Video CD, upload it to a Web site for
a client presentation—the uses are only limited
by the imagination.

Know Your Formats
Digital camcorders are all the rage now; the ana-
logue version, while cheaper, doesn’t offer the
flexibility or the features that a digital one does.
You will thus find the market saturated with dig-
ital models from all leading vendors. 

Before investing in either of the available tech-
nologies it is important to learn which recording
medium you go for. Ensure that the total cost of
ownership of your purchase does not go through
the roof because while you bought an affordable
camcorder, the recording media costs a limb, and
then some. 

With that in mind, here are some of the
common media available, their shortcomings and
their features.

8mm
This format, about the size of an audio cassette,
is used in analogue camcorders. The biggest
advantage with this format is that the cam-
corders can be very compact. You can even carry
a compact 8mm camcorder in your pocket—they
can be that small and convenient. The format
carries the same resolution as that of the stan-

The focal length of a lens is the distance between
the lens and the CCD. Using an infra-red

detector, the distance to the subject being shot is
determined and a series of motors automatically
change the lens’ focus to accommodate a sharp
picture. A manual over-ride is of course available. 

By increasing the focal length of the lens, a scene
can be magnified. This is known as the optical zoom
of a lens; apart from this some camcorders also have
a digital zoom. This zoom takes place on the CCD of a
camera: the number of pixels used for the area to be
magnified is increased, thus creating a larger image.
This causes a loss in information, and a digital zoom
is thus not as sharp.

Focus And Zoom 

This camera offers image stabilisation to shaky shots

Inside Stuff: How A Camcorder Works

Captured by a camcorder
with one CCD

CCD Analogue signals

Analogue to
digital 
converter

Analogue to
Digital
Converter

Video is 
stored
here

Capture of colour 
information

R CCD

G CCD

B CCD

The lens mechanism

The lens mechanism
Captured by a 
camcorder with three CCDs
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Analogue
recording fades
with time, while
a digital
recording
doesn’t degrade
at all with the
passage of time. 
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MicroMV
MicroMV allows for very compact camcorders. It
stores video in the MPEG2 format which is a
popular digital format, recognised by almost any
software. A MicroMV cassette is very expensive.
Since MicroMV does not store video in the com-
mon DV format, one is dependent on bundled
software to convert the video to DV or other for-
mats. The MicroMV format also provides less stor-
age space as compared to MiniDV.

Mini-DVD-R/RW/RAM
The recording format is MPEG-2, but the digital
media involved here provides more reliable, con-
venient and portable storage. Since the medium
is about three-quarters of a standard DVD-ROM,
one can play the recorded movie directly on
DVD players. 

Note that if the camcorder supports DVD-
RAM, you might need a compatible DVD player
(See page 40 of the September 2004 issue of Digit
to understand various DVD media.) This medium
provides 30 to 120 minutes of footage.

DVCAM
DVCAM is a proprietary digital format from
Sony which provides better quality by running
the cassette at a higher speed. One subset of the
DVCAM is the MiniDVCAM which provides
shorter recording time compared to DVCAM,
but offers the flexibility of recording on regular
MiniDV cassettes. If you use standard MiniDV
instead of MiniDVCAM, you would lose one-
third of the recording time of the MiniDV cas-
sette. So, if the MiniDV can record for 60 min-
utes, then while substituting for MiniDVCAM, it
would only record 40 minutes.

In The Market
In the local market you will find camcorders
ranging from approximately Rs 16,000 to Rs
2,00,000. Camcorders with Hi8-based cassettes
are available for Rs 16,490, while ones with
MiniDV support start at approximately Rs
30,000. Those with DVD support are priced
around the Rs 60,000 mark. 

All these models come with single CCD;
the 3-CCD, three-chip camcorders start at 
Rs 70,000. 

The major brands in the Indian market are
Samsung, Sony, Panasonic, Canon and JVC. Digi-
tal camcorders start at around Rs 30,000 and go
up as features and performance increase.

mustali_kachwala@thinkdigit.com
ahmed_shaikh@thinkdigit.com

dard VHS, but the audio quality is slightly better.
8mm tapes come with a capacity of two hours of
footage. If you want play 8mm tapes on your TV,
attach your camcorder to the TV set, and simply
use it as a VCR. 

Hi-8
Hi-8 camcorders are also analogue, and are quite
similar to 8mm camcorders. There are some
important differences, though. Hi-8 camcorders
have a much higher resolution—about 400 lines.
Hi-8 tapes cost much more than 8mm tapes.

MiniDV
MiniDV cassettes store videos digitally in the DV
format, which is superior to any other format.
MiniDV is widely supported by most camcorders
and enjoys a wide acceptance by video editing
software. A very good compression ratio ensures
that high-quality recording takes only a small
amount of space. Audio is recorded as 12- or 16-
bit pulse-code modulated (PCM) signal with a

facility to add audio dubbing information. The
DV format uses the DCT method for compression
which, in terms of hard disk space, requires 3.5
MB for each second of video recorded. A MiniDV
camcorder can store 60 to 90 minutes of footage,
it can also take still pictures, much like a camera.

Digital8
Just like MiniDV, the Digital8 digital format
stores video in DV format, thus providing similar
quality and resolution. But the storage medium
used here is the less expensive Hi8 cassette
which can store about 60 minutes of footage.
Another advantage associated is that it is com-
patible with many video editing software as well
as hardware like decks.

A single CCD
camcorder starts
from Rs 16,000
while a three
CCD camcorder
will cost at least
Rs 70,000

Headphone and MIC Depending upon your needs you may need to attach a
high-quality MIC to record distortion-free. Some cameras have a built-in zoom
for audio which follows the lens. Camcorders with XLR ports can be attached to
professional audio equipment. Microphones to consider include the omni-
directional and the shotgun.
Memory Card A memory card can help you download still images to the PC.
Some camcorders can directly store stills to a memory card, saving space.
Extra Battery If you travel a lot, you might need an extra battery set
Tripod Mini tripods are available and are particularly helpful for landscape,
portraits and wildlife photography.
Flash For capturing movies at night or under low-light conditions, the in-built
flash might not be enough. Consider purchasing a more powerful, external one
in that case.

Other Essentials To Purchase 

A MicroMV camera is very small indeed

A camcorder using a Mini-DVD format for recording
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‘Hot Disc’ allows ejection of a disc during
play, and have it continue for another 35 sec-
onds. Tracks can also be looped within the Hot
Disc memory for an unlimited time.

A Technics SL 1210 MK2 turntable plays
Praveen’s 150-strong collection of vinyls—mostly
House music that is yet to hit the Indian mar-
kets. “The stylus (needle) alone costs between 
Rs 6,000 to Rs 8,000 is and may have to be
changed once a year, depending on the usage.”

His WAP-enabled Motorola E365 camera
phone helps Praveen stay in touch with his col-
leagues and studio-representatives. Praveen also
owns a Yamaha MIDI keyboard “which doubles
up as a synthesiser.”

An assembled PC (PIII, with 512 MB RAM and
a Creative sound card) runs professional music-
creation software such as Sony’s ACID Pro,
Apple’s Logic Pro, and Nuendo. Even his head-
phones are worth Rs 10,000. The Pioneer HDJ
1000 headphones (customised for DJs) “are the
hottest headphones around”! They come with
foldable arms, gold-plated wires and produce
clean sound, gushes Praveen. 

As the evening turns into night, young
Praveen, who could just as well pass off as a col-
lege kid, morphs into the funky DJ, juggling his
gadgets simultaneously, and rocking the
crowds all night. 

meera_vankipuram@thinkdigit.com
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Tech My Breath Away

DDeennoonn  DDNN  SS55000000  CCDD
ppllaayyeerr—Rs 50,000

YYaammaahhaa  RRSS77000000—
Between Rs 1,00,000
and Rs 1,50,000

TTeecchhnniiccss  SSLL  11221100  MMKK22
ttuurrnnttaabbllee  aanndd  ssttyylluuss—
Rs 45,000 

VViinnyyllss—Rs 1,05,000
(150 vinyls, Rs 700 each)

PPiioonneeeerr  HHDDJJ  11000000
hheeaaddpphhoonneess—Rs 10,000

MMoottoorroollaa  EE336655 (WAP-
enabled, camera
phone)—Rs 15,000

The DJ Devices

With a business card that reads First
Runner-Up: Times Music War of the DJs,
you’d expect this 23-year-old to have

only music running through his veins. But DJ
Praveen, the current in-house Disc Jockey (DJ) at
the Provogue Lounge, one of the most popular
nightclubs in Mumbai, not only loves the music
he makes, but also the gadgets that make peo-
ple groove to his tunes.

A professional DJ for well over three years
now, Praveen and his partner-in-crime, best
friend DJ Vivek (Winner of the Times Music War of
the DJs), work under the banner ‘Gamemaster
DJs’, and own some of the most high-end equip-
ment in India.

Having survived an Under-Grad degree in
Industrial Engineering at BVIT Belapur,
Praveen also finished a formal course in DJ-ing
at Joe Azaredo’s school in Cuffe Parade. “I was
always fascinated by gadgets, and being in
this profession, one has to be gadget-savvy!”
says Praveen.

A fervent passion for DJ-ing led Praveen and
Vivek to invest in state-of-the-art equipment
that cost nearly Rs 2.5 lakh—“all purchased in
the last one year,” according to Praveen.

The piece de resistance of their collection is
the Yamaha RS7000, “which we bought in the
US, and is quite a unique piece even in the DJ
world.” A complete editing studio, the RS7000 is
portable, and can be used by DJs to compose in
real-time, even during a live performance. “This
is a big advantage for performing duos—Vivek
and I take turns spinning, scratching, and cre-
ating tracks”

Two Denon DN S5000 CD players (digital
turntables) help Praveen decide what music to
play. The equipment helps him control the
speed at which the tracks are played, and also
sample the music before it goes live. 

The DN S5000 which Denon claims “is the
world’s first motor driven active platter for true
vinyl emulation” can playback, mix, loop, sam-
ple and apply scratch effects to tracks. Its Alpha
Track (2-in-1) feature allows independent and
simultaneous playback of another track from
the same disc, and mixes tracks together with
just one unit.  

Meera Vankipuram 
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The time of his life: DJ Praveen shows off his goods before heading for the Provogue
Lounge, one of Mumbai’s hottest nightclubs

I was always fascinated by gadgets,
and being in this profession, one

has to be gadget-savvy

He is the in-house Disc Jockey at one of Mumbai’s hottest nightclubs. Meet 23-year-old Praveen,
who loves the gadgets he uses to keep the dance floor rocking, as much as he loves music
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Ram Mohan Rao

he Land Speed Record honours the
vehicle that, simply put, moves the
fastest on plain ground. Thrust SSC, a

British jet-powered car, set the first
supersonic land speed record in 1997. It
screamed its way across the Nevada desert at
759.333 mph on its first run, and at 766.109
mph on the second attempt. And that’s on
land—we are not talking about a plane here.
Compare this with the speed of a typical
Boeing 747 in cruise mode—about 500 mph.

However, those of us who live in the
digital world are likely to be more impressed
by the following: “Caltech and CERN top new
performance threshold by sending 859 GB at
more than 6.6 Gbps—in less than 17
minutes—across nearly 16,000 km.” That’s the
new Internet2 (I2) Land Speed Record, and
that speed is about 10,000 times faster than a
typical north American home broadband
connection.

Networks are capable of much more than
what the Internet is today—a congested
place—there is no infrastructure for critical
applications to take precedence over spam, for
example. Neither is there the infrastructure
for cutting-edge applications such as high-
performance, low-latency videoconferencing.

Today’s Internet will grow and evolve, and
could eventually become something like I2.

What is I2?
I2 is a collaborative effort at developing
advanced networking technology and appli-
cations important to research and education.
Over 140 US universities, working in collabo-
ration with partners in industry and the US
government, are leading the I2 project. 

The project does not aim at replacing the
Internet: it is working to enable advanced
applications such as digital libraries, telemed-
icine, virtual laboratories, etc, that are not
possible with today’s technologies.

I2 is not a separate network; it joins
member network applications and engineer-
ing development efforts, together with many
advanced campus, regional, and national
networks. I2 is currently US-based, and US-
centric. In fact, it is touted as something to
help America retain world Internet domi-

nance. However, the project is open to
collaboration from international organi-

sations, and there is no reason why we
won’t see I2-like networks everywhere,
in a few years. The bandwidth is there;
the technologies exist; it’s only a
matter of putting them to use.

What’s the big difference?
The first (and most obvious) differ-
ence with I2 is raw speed. The Abilene
backbone, one of the two that
supports I2, “is a proving ground for

high-bandwidth technologies. The
cross-country backbone is 10 gigabits

per second, with the goal of offering 100
megabits per second of connectivity

between every Abilene connected desktop,”
according to internet2.edu. See box “Abilene,
Mean, Stronger” for more information. 

Another change is that I2 is a collabora-
tive, research-and-education effort; it is not
currently used for commercial purposes. Also,
I2 is an experimental testbed for several tech-
nologies and techniques. There are no band-
width restrictions—in fact, members and
affiliates pay a flat fee, and are encouraged to
use the bandwidth available.

So why, in the first place, do we need some-
thing more than today’s Internet? There are
several answers.

God Speed
Networks are capable of much faster speeds
than we generally imagine. Broadcasts over
I2 can go at 250 megabytes per second. IPv6
(See box “IPv6, And What It Means For The
Future”) will support such speed and applica-
tions. For example, IPv6 supports between 64
KB and 4 GB. (The current version of the

T

859 GB across 16,000 kilometres in
17 minutes. Internet2 is the
beginning of an Internet on 
hyper-steroids

Imaging Parag Joshi

Faster, 
Further



49OCTOBER 2004 DIGIT

Internet Protocol—IPv4—supports datagrams of
up to 64 KB.)

Important considerations in IPv6 are the
“flow label” and the “priority setting.” Both
these features improve the Quality of Service.
Using the flow label and priority, you could
indicate to a router that a video stream needs
to go at no more than a particular jitter level.
The router could also be instructed to
optimise transmission and improve efficiency.
These two new fields in the IPv6 header will
become more and more important as we move
toward ultrahigh-bandwidth applications,
such as those available on I2.

Possibilities
I2 is used for applications not possible with
the limited speeds and weak infrastructure of
today’s Internet. Such uses include education,
research, and the like. A music teacher in New
York could make a live lesson available via I2 to
students in Los Angeles, thousands of miles
away. The audio and video would be DVD-qual-
ity, in real-time. Astronomers at the University
of Florida could observe data in real-time from
a telescope at Palo Alto, California.

In fact, it’s already happening. In the near
future, we can envisage telemedicine
happening via the I2-like Internet. Indian
doctors could monitor a surgery in Brazil, and
perhaps even perform actions that have a real-
time effect in the operating theatre.

This is just an indication of what is possible
with I2 and its probable successor, which will

be nothing short of a total revolution in
connectivity—with no speed barriers. I2 is just
showing us the way.

IPv6 comes in here as well. When such high
bandwidths are involved, one would like to
reduce the wastage that happens with “unicast”
—data being sent from one node to another.
Multicast is where a specific list of addresses
receives the data, without it having to be sent to
each node once. IPv4 does have multicast
capabilities, but IPv6 improves on this, in terms
of flexibility of addressing.

Is Internet2 A Harbinger Of These Possibilities?

This might just be
what the Internet
looks like some years
from now, with
exciting new
possibilities

The Current Internet2

A doctor performs
surgery on a patient in
the US... 

A radio telescope in Europe
gathers data from the skies...

A music instructor plays out
his lessons in India....

...while it is being monitored
in South America

...while an African
student watches
them on his HDTV
screen

...while scientists at an
Australian observatory
inspect it

Abilene, Mean, Stronger

The Abilene network is a high-performance
backbone network that enables the

development of advanced Internet
applications, and the deployment of leading-
edge network services by I2 universities and
research laboratories across the US. Abilene
was created by the I2 community, and connects
regional network aggregation points—known as
gigaPoPs—to provide advanced network
capabilities to over 220 I2 university,
corporate, and affiliate member institutions.
The current network is primarily a 10 Gbps
backbone, employing optical transport
technology and advanced high-performance
routers. Abilene is a partnership effort
between Internet2, Qwest Communications,
Nortel Networks, Juniper Networks, and
Indiana University.

With Internet2, a
music teacher in
New York could
give live lessons
to students in
Los Angeles. It
can be that fast
and useful

Digital Passion l Tomorrow
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Is I2 Any Better?
In a world connected by an I2-like network, security con-
cerns would be higher than what they are today.

Is security inbuilt in I2? Is there an emphasis on
security? Speaking in an interview with CREN (Center for
Research and Educational Networking) TechTalk, Ted
Hanss, director of applications development at I2 said, “I
would say that we are not really trying to do anything
different, as much as we are trying to ensure that security
is part of the environment. We have demonstrated that you
can, in real-time, encrypt a video screen—full-motion, full-
screen video—without interfering and putting in so much
delay that it becomes unusable. What we are really doing
is finding a way to make sure that security features are
available to application developers.”

Encryption is of the essence—IPv6 mandates the IPsec
protocol, short for IP Security. It is a set of protocols to
support secure exchange of packets at the IP layer.

Security will obviously be one of the biggest issues to
face I2 in the years to come. In fact, the first well-
documented DDoS (Distributed Denial of Service) attack
occurred in August of 1999, when a DDoS tool was
deployed on at least 227 systems, of which at least 114 were
on Internet2. All this just to flood a single computer at the
University of Minnesota!

The Internet2 environment, with its solid, clean
interface, is an ideal testbed for a lot of things, and is a
crucible of innovation. 

As Hanss puts it: “Application developers with
security features available to them will surely innovate—
and these innovations should trickle down to the rest of
the Internet.”

With Internet2, we can hope for a cleaner, more
secure Internet of the future—not to forget the blazingly
fast speeds! 

ram_mohan@thinkdigit.com

IPv6, And What It Means For The Future

IPv6 is the next generation Internet protocol, designed by
the Internet Engineering Task Force, to replace the

current version (IPv4) of the Internet Protocol. IPv4, which
most of the Internet uses, has been around for 20 years.
Despite being remarkably resilient, cracks are beginning to
show up—most noticeably the growing shortage of
addresses; there are four billion possible. This may seem
like a lot, but at the rate the Internet is expanding, four
billion will become too little.

IP addresses will soon trickle down to everything—the
easiest example being handhelds, and esoteric ones like
dog collars. The larger address space provided by IPv6 will
soon become necessary. IPv6 supports autoconfiguration,
so your phone or dog collar can be configured without your
having to do much. Besides, IPv6 makes for a hierarchical
addressing system: so, for example, your home could have
a top-level address, the rooms in it could have sub-
addresses, each device in each room sub-sub-addresses,
and so on.

IPv6 fixes a number of problems with IPv4; apart from
increasing the number of available addresses, it adds
improvements in areas such as routing. IPv6 is expected to
gradually replace IPv4; the two will co-exist for some years
during the transition period.

An IPv6 address is 128 bits long, unlike today’s 32-bit
addresses. It uses hexadecimal digits. A typical IPv6
address looks something like this:
4FDE:0000:0000:0002:0022:F376:FF3B:AB3F.
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ost the dotcom bust, when
all other start-ups were
losing their head (and

money) and blaming it on bad
luck, a few companies decided to
stick around and ride the trough.

A few others decided to wait
and watch and harness the

potential of the Internet to
provide Web-based services to
individuals and corporates.

One such venture was Delhi-
based Whizlabs Software Pvt. Ltd
(www.whizlabs.com), whose
founders struck upon the idea of
offering e-learning tools and
services to companies that didn’t
have the time or resources to
help employees upgrade their
technical skills. 

Whizlabs’ services are just the
panacea for the ‘so-much-to-do,
so-little-time’ corporate world—
especially the IT sector. Whizlabs
evolved training modules for
exams conducted by leading IT
vendors such as Sun, IBM, Oracle,
Microsoft, BEA, PMI, Red Hat and
Cisco.  They also offer “IT Skill
Assessment, Employee Evaluation,
Recruitment and Certification
Exam Preparation Solutions’ 
for corporates”.

Having obtained an ISO
9001:2000 certification for their
testing methods, Whizlabs
claims to have aided the careers
of over 4,00,000 people by help-
ing them obtain IT certifications. 

P

In its endeavour to contribute
to the Indian IT community,
Whizlabs has partnered with
companies such as TheServer-
side.com, JavaRanch, Certcities,
and Addison Wesley.

The Big Idea
Founded  in October 2000 by
three IIT-Delhi graduates, Purvesh
Sharma, Pradeep Chopra and

Kapil Nakra, Whizlabs was born
with “initial investments of $3000
(Rs 1,40,000) contributed by
friends, along with a savings of Rs
50,000 coming from our own
pockets,” says Chopra.

Purvesh, the Operations
Director, handles the people
management and logistics section
of the business. Pradeep serves as
the Business Development

Director, while Kapil Nakra, is
Director, Sales at Whizlabs. 

All three have prior work
experience in the Indian soft-
ware industry, having worked
with leading firms such as SAP
Labs India and TCS. Says Chopra,
“We didn’t find much motiva-
tion and challenge in a regular
software professional’s career.”

Whizlabs’ Services
Whizlabs, which claims to have
customers in nearly 90 countries,
provides IT skill assessment and
certification examination prepa-

Lessons That Click Right
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The incredible story of a Delhi-based
company that struck gold with their
e-learning tools and services
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Whizlabs’ online training sessions
come with an ‘Unconditional Test
Pass Guarantee!’, which means
that customers will be reimbursed
the entire course fee if they do not
clear the exam for some reason!

Whizlabs has helped compa-
nies such as Cisco, Accenture,
Infosys, Nucleus Software, Coface
and Bunge in recruitment, skill
assesment, employee evaluation
and certification exam prepara-
tion. Apart from their corporate
clients, Whizlabs has  also helped
thousands of individual
customers—mostly software
professionals, get certified.

With certifications becoming
increasingly relevant to enhance
career prospects, several IT
companies are now using certifi-
cations as a standard to measure
an individual’s technical skills
vis-à-vis industry standards.

Says Parag Phise, Vice-
President (Testing) at Delhi-based
Nucleus Software, “We
purchased assessment tests for
Java and other technologies. A lot
of people in our company work
on Java-based platforms.
Whizlabs’ reports and percentile
scores make it easy for us to eval-
uate and enhance our skills.”

Deepak Adlakha, a software
engineer working with an
offshore development centre in
New Delhi, purchased training
materials for Sun certifications.
Says Adlakha, “The mock tests
were extremely useful.”

Vamsi Polimetla, a senior
systems analyst at National
Computer Systems, Singapore,
availed of Whizlabs’ services for
SCEA, SCBCD, Java Web and
Business Component (all Sun certi-
fications). “I scored more than 85

per cent in these tests. While I’m
not sure whether the certifications
will directly benefit my career,
they will help update my knowl-
edge levels in these areas,” he says.

Distance, therefore, is not a
constraint when it comes to 
learning. Atlanta-based Rashmi
Banthia, and Geoffrey Chu, based
in West Virginia, are both look-
ing to get certified in XML and
UML (IBM), thanks to Whizlabs.
“These guys are pretty popular in
the software market,” says Chu.

Next-Gen Learning Tools
With customers in over 90 coun-
tries, and a monthly turnover of
$40,000 (Rs 19 lakh) per month,
the company is on an upswing.
Customer referrals account for a
large proportion of their sales. 

India being an IT haven these
days, Chopra firmly believes that
there is a market for such serv-
ices in India and abroad. “The
availability of a large pool of IT
talent and presence of global
players in the Indian IT industry
makes a big market for our kind
of services,” he says.

Future plans will expand their
existing services across IT skills.

With biggies such as NIIT, Tata
Interactive Services (TIS),
Lionbridge and ICICI Convergys
dominating the e-learning arena,
Whizlabs, like the others, has
recognised the changing trend in
learning patterns—from conven-
tional tools to e-methods, which
not only saves time and resources,
but facilities easy testing as well. 

Companies such as Whizlabs
have given a new twist to the
learning curve—will educational
institutions take the cue? 

meera_vankipuram@thinkdigit.com
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ration tools, for corporates and
individuals. Most often, business
transactions occur online. 

Whizlabs’ IT certification
exam preparation solution offers
mock exams, quizzes, revision
notes, an online testing environ-
ment, and free technical support
from authors. Exam Simulator
services are available for Sun,
IBM, PMI, Oracle, Microsoft,
Cisco and Novell certifications
with online training modules for
Sun and Red Hat. 

This solution comes with an
‘Unconditional Money Back
Guarantee’, if the customer is
not happy with the product. (Find
the sample test papers on this
month’s Digit DVD.)

Their LAN/Web-based Skill
Assesment solution includes test
delivery and reporting which  lets
users access their preparation
material from anywhere. With
just a browser required to access
the server, this system also helps
users obtain percentile scores
within a particular community.
This feature helps corporates
manage assessment procedures. 

Whizlabs online training
sessions, which cost anywhere
between US $300 (Rs 14,000) and
US $500 (Rs 23,500), per user
license, apart from the cost of
the product—are likely to save a
company nearly four times the
amount, in providing boarding
and lodging facilities and travel
expenditures; more impor-
tantly, it saves the company
plenty of time. Online training
sessions also remove location-
based constraints.

Built with smart algorithms,
Whizlabs’ modules make it easy
for participants to obtain test
results and relevant feedback,
almost immediately. 

For the certification exams,

Prepare for certification
exams through instructor-led
online training sessions

From left: The founders of Whizlabs—Purvesh Sharma,
Pradeep Chopra and Kapil Nakra

I scored
more than 85
percent in
these  tests.
The
certifications
will help
update my
knowledge
levels in
these areas.
Vamsi
Polimetla
Senior Systems
analyst, NCS
Singapore

Certify yourself — The Whizlabs way

1 Take IT certification
exams online2 Boost your professional

career and enhance
knowledge 

3
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Suprotip Ghosh

Flickr.com is a photo manage-
ment application, an online site
for sharing photos. It stands out

for its user-friendliness, intuitive
interface, design, and the emphasis
on the fact that sharing photos
means sharing memories. True to
this spirit, anyone can log on to Flickr
and actually post a remark, add a tag,
or simply comment on any photo.
Flickr supports camera phones as
well—photos clicked on camera
phones can be directly e-mailed to
your Flickr page.

Registration 
A basic account on Flickr is free.
However, there is a 10 MB upload
limit per month on free accounts.
The terms and conditions page
reflects the spirit of the site
admirably— “We claim no intellec-
tual property rights over the mate-
rial you provide to the Flickr serv-
ice. Your profile and materials
uploaded remain yours.”

Getting Started 
After the brief registration process,
a profile page shows up, where you
can optionally, at any time, fill in a
few personal details. You are then
taken straight to the home page.
Fairly straightforward and self-
explanatory links on the right ensure
great usability. You can also specify
here whether the photos you upload
are to be private, or can be viewed by
everyone on the Net.

Uploading Photos
You can either click on a link and
upload a photo directly on the
Web site. You can also download
one of the plugins available for
most popular OSes, and upload
through it.

Tagging And 
Description 
The next page allows for more
detailed tagging. Descriptions
can be added to the photos here.

Your Photos!  
This page is where you see all the
photos you have uploaded. The page
also contains the links you need to
organise and upload. It links to your
user profile, a calendar, a few other
necessary links, and a tag-search
engine. The page contains the
archive, as well as an upload history.

The Organizr 
The neatest link on the photos page is
the Organizr. This interface supports
drag-and-drop, complete with a time-
line at the bottom that contains
reminders about which photo has
been uploaded,
and when. You can
create a ‘photoset’,
or manage your
group(s). 

“Edit these
as a batch” 
This link points
back to the tagging
and description
page. There is
enough flexibility
to either update
photo description
and tags one by
one, or as a bunch.

Every page has

a navigation bar on top that includes,
among others, the following links:

Everyone’s 
This is a preview of photos picked up
either randomly, or from among the
most recently posted stuff on the site.
You can search according to tags, or

according to a list of pre-
specified favourites.

Contacts 
This page keeps track of
your contacts and their
activities on the site.

Groups, People and
Invite are community tools
to locate or track people,
and join groups.

There are a few
features apart from all the
above, including:

A mobile version of the
Web site so you can see the latest
photos on your web-enabled cell
phone or PDA

Group photo pools, so everyone at a
wedding, for example, can put their
photos in one place 

suprotip_ghosh@thinkdigit.com

Blog, E-mail
Photos
ON Flickr.com
you can blog
your photos on
all the major
blogging sites.
You can even
upload photos
directly from
your camera
phone into
Flickr. There is
an e-mail
address set up
for you. All you
need to do is
enter that e-
mail address
into your Web-
enabled cell
phone and send
it Flickr’s way!

Collection of memories: Comments can be added both by
you and your friends to individual elements in a photo

“Now I have a home on the Net”

Jigsaws in your mind: It supports drag and drop!

All you have to do is click!

Flickr.com
Digital Tools l Net Gain

Here’s an online photo-sharing stopover that
offers beyond the usual album creation tools
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Taking Pictures?
Experiment!

Don’t always stand
upright when taking

pictures. Experimenting with
your posture, and the
position in which you hold
the camera. Get it lower,
position yourself higher, dive
to the side, etc, and see how
your pictures turn out. With
a digital camera, it costs
nothing to experiment!

The Flash
Most inbuilt flashes do
their job for about 12 to

18 feet. Beyond that, they are
just not powerful enough. 

Set the ISO (or ASO) setting 
to around 400, so that the
flash doesn’t need to work as
hard. The trade-off will be a
few artefacts—akin to the use
of higher-speed film in a non-
digital camera. Generally
speaking, a higher ISO (or
ASO) setting makes for better
pictures in dim light.
However, do not use the
highest ISO setting all the
time since higher the ISO, the
more the artefacts, and hence,
the grainier the picture.

Do not stand in front of a 
reflective surface such as
glass or polished doors,
when using a flash. The
flash reflected creates a very
bright reflection and thus,
spoils the image.

If there is a reflective 
surface around, stand at an
angle from the surface, so
that the flash reflects away
from the camera.

Decide when to use a flash 
and when not to—especially
indoors. A low-contrast
picture without flash is often
preferable to the jarred, high-
contrast pictures obtained if
you use the flash in certain
situations. 

When On Vacation...
Remember to carry 
everything you need: a

charged battery, a spare
battery, a charger, a spare
memory card, and anything
else you can think of. For
example, make sure your
memory card is empty before
you leave.

Keep a soft cloth as well

as a lens-pen handy, and
remember to clean your 
lens regularly—preferably
daily.

Do not carry a brand new 
camera on a trip unless you
are familiar with the
controls.

You need not reach your 
destination before you start
clicking—it’s a great idea to
take pictures along the way,
beginning as soon as you
leave home, so you can later

compile a ‘digital photo
diary’ of your trip.

You never know what may 
look interesting in a new
place. You might have heard
of a tourist attraction, and
your first impulse might be
to go ahead, face it and click.
Resist the temptation to do
so—try and find a unique
angle to snap it. For instance,
a marketplace that looks
chaotic and uninteresting
while you are in it may make
a charming picture when
shot from above. Keep trying
unusual angles.

The Rule Of Thirds
This rule has been
proven to result in

better-looking, pleasing
pictures. It goes something
like this: mentally divide your
viewfinder (or LCD screen)
into three parts, both
horizontally and vertically.
Also, imagine lines—two
vertical and two horizontal—
demarcating these parts. Now,
place objects of interest at the
points of intersection of these

lines in the photograph. Take
two pictures of a similar
scene: one following the rule
of thirds, one not following
it—and observe the difference.
Of course, the rule of thirds is
only a guideline. It is not a
hard-and-fast rule.

Portraits
Digital cameras are
ideal for portraits.

Shoot several poses and see
which one is the best
instantaneously.

Know your subject. This is 
important to capture his or

her interesting moods 
and angles.

Natural light is best for 
portraits. This includes both,
outdoor sunlight as well as
that coming through the
curtains. Direct sunlight is
not advisable—the perfect
lighting would occur in the
shade of a tree or building,
for example. This is also good
from the point of view of the
digital camera—it will not
have to deal with extremes of
light and dark.

Backgrounds distract when 
we are talking portraits.
Hence, set your lens to wide
aperture and the zoom to
high, to get the background
out of focus.

Sports Photography
‘Shutter lag’ can be a 
problem with sports

photography. This is the time
between when you depress
the button and when the
photo being clicked. Those
one or two seconds can be
vital as you shoot a game.
Therefore, shoot a test
photograph and note the
shutter lag: depress the
button fully, and observe
when the photo actually gets
clicked. Now that you know
the lag time, be prepared
when you take the actual
photo. It takes time getting
used to it.

You can also depress the 
shutter-release button halfway
while you are still composing.
Thus, you can snap quickly
when the moment arrives—
you will not have to depress
the button entirely.

Use the compressed JPEG 
format instead of
uncompressed formats such
as TIFF, although the latter
give better quality. As it is,
the digital camera’s CCD
(Charge Coupled Device,
which is a type of imaging
sensor used in digital
cameras) takes some time to
‘wipe off’ a picture and move
on to the next one; it takes
longer if the image is larger.
Thus, you may miss out on
some of the action, if you
snap using the TIFF format
continuously.

Similarly, when you use 
the flash, it takes some time
before it charges up for the
next picture. Hence, do all
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your sports photography
without flash as far as
possible.

Speed is of the essence 
here. Try buying several
smaller memory cards
instead of one large one. This
is because larger memory
cards take up more
resources—and time—while
‘searching’ for a location 
to store.

White Balance
Different light sources
illuminate objects

differently. Halogen bulbs, for
example, produce a yellow or
orange colour cast.
Fluorescent lamps may result
in a greenish cast. Set the
White-Balance on the camera,
if your source of illumination
is not the flash or daylight.
Alternatively, you can let it
White-Balance automatically.
In a nutshell, White-Balance
is the method used to colour-
correct light sources other
than flash or daylight, so that
the light appears correct.
White-Balance forces the
brightest parts of the image
to appear pure white. These
brightest parts are often
indeed white, but appear as
some other shade if White-
Balance is not used. Basically,
White-Balance dictates what
is white and what is not.
Note, also, that photographs
come out different when you
use automatic White Balance
as against using the features
of the camera to do it
manually. The photos
alongside illustrate this

difference—the first
photograph was White-
Balanced for cloudiness. Here
again, you will need to
experiment.

Indoors/Outdoors
The ideal lighting for
indoor and outdoor

photography is different. For
example, indoors, a flash
serves to light up objects,
whereas outdoors, it serves to
fill in shadows.

Daylight and artificial light
have different ‘colour
temperatures’, and give
different lighting effects and
hues. Avoid mixing the two.
Also, different sources have
different effects—halogen
lamps cast a yellow hue,
while incandescent bulbs
produce a bluish tint. So,
experiment with indoor
lighting.

Most cameras come with
an inbuilt red-eye reduction
feature. However, this
involves what is called a ‘pre-
flash’, which might cause the
subject to blink. To avoid this,

turn on a light somewhere at
a distance to reduce the effect
of the pre-flash on the
subject. You can also redirect
the flash so it doesn’t fall
directly onto the subject’s
face. Yet another solution is
to diffuse the flash by pasting
some translucent tracing
paper over it.

Use a bounce flash to 
get natural, diffused light
that highlights features
evenly. You can do this by
placing a mirror at a 45-
degree angle in front of the
flash, to reflect the flash off
the ceiling.

If your subjects are in a 
room, opt for light-coloured
ceilings and walls, as this
tends to diffuse light.

Outdoors is a different 
story: The subject is already
well-lit. You have to take care
of other things. For example,
it is often best to click with
your back to the Sun.
However, an LCD screen is
difficult to see in bright
sunlight. Hence, try and get a
digital camera that has a
viewfinder in addition to the
LCD screen.

In bright daylight, use the
flash to fill in shadows.
Imagine a scene where the
subject is backlit by, say, a
setting sun; if you don’t use
the flash here, the subject
will appear as a dark
silhouette.

Extreme temperatures can
damage your digicam. Do not
leave it too long in direct
sunlight. Cover it with light-
coloured or reflective
material.

Outdoors isn’t really a good
testbed for digicams. Consider
a tree: if your camera has a
million pixels, and the tree
has a few lakh leaves, then
that translates to about two or

Digital Push
A problem that you may
have faced quite often is
the difficulty in clicking
good, sharp images in
dim light. Digital
photography provides a
solution: the digital push.
Use this technique with
regular shots as well as
high-zoom shots, or
macros.

Essentially, if you are
in doubt whether the
light is sufficient, set a
higher shutter speed, and
later augment the
photograph on a PC.

The problem is that in
low-light conditions, you
need more exposure, and
hence a slower shutter
speed. This can be
problematic if you have
shaky hands—camera
jitter can ruin a low-
light, slow-shutter-speed
photo. To overcome this,
offload the brightness
aspect to the PC. Just 
use a higher shutter
speed, and enhance the
image digitally. Several
software, many of which
come bundled with
digital cameras, help 
you do that. You can
adjust brightness,
gamma, contrast, and
other settings.

Bet You Didn’t Know

This picture was shot manually
adjusting the White Balance using
the features on the digicam...

...while here, the White Balancing
was done by the camera. Note the
difference in naturalness of shade 
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Keep The PC Out Of The Picture

Aalaap Ghag

Here is something that actually
leaves the computer out of the

cluttered loop of printing photo-
graphs with a digicam. PictBridge
standardizes the manner in which
printers interact with digital cam-
eras. Earlier, when you wished to
take a printout directly from a dig-
ital camera, you had to ensure that
the printer was of the same brand as
that of your digital camera. With
hardware equipped with PictBridge,
you no longer need the PC for a
printout of the photos. You can
directly print them from a printer
using your digital camera, keeping
the computer out of the picture.

To take full advantage of
PictBridge, both your printer
and the digicam must sport
the PictBridge logo. In the

example here, we used an HP
PhotoSmart R707 digital camera to
print using a Kodak EasyShare
Printer Dock.

Shoot
First things first: grab that
camera and go trigger-happy.

Connect
Find your PictBridge cable. It
is essentially a USB cable.

Take the smaller end of the cable and
plug it into your digital camera. The
other end goes into your printer’s
PictBridge port. Ensure that the
devices are powered on and that the
printer has sufficient paper. See to it
that the battery of the digicam is suf-
ficiently charged.

Choices
Once the HP camera is con-
nected to a printer, it shows

up directly on the printing menu. You
can choose to print just one picture, a

few selected ones, or the entire lot.
The camera also lets you specify the
exact size of the print. The default
size is set at 4 x 6 inches. If your
printer supports other sizes, you can
choose them here.

Print
Click on the Print button on
your camera and your printer

gets to work. If you can’t find the
Print button on the device model,
simply refer to the manual. If you use
a Kodak camera with this printer
dock, all you have to do is to click on
the Print button on the dock itself.
For HP cameras, the Print button is on
the digicam.

Using a PictBridge printer to bypass your PC for printing photos

Here is another way of printing
photos without using a PC. Some
printers come with reader slots for
SD, MMC, or CF memory cards. Your
digital camera supports at least one
of these. If your printer has such a
slot, simply take the card out of the
camera, and put it into the printer.
Now, select the pictures on the
printer’s LCD panel and get your
photos printed.

No PictBridge?

One end of the PictBridge cable to the
cradle...

...The other end goes to your camera

Access the Print menu of your camera Photos without the PC!
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three pixels per leaf. This
means the picture will lose
out on details. For best
results, shoot subjects that
are clearly defined with
smooth and distinct outlines,
i.e., subjects that stand out
well from the background.
Unfortunately, most natural
objects do not have this
characteristic. When
outdoors, the subjects to
shoot are cars, buildings,
cityscapes, and the like.

Black And White
Colour contrast draws 
emphasis to subjects:

Take a red apple against a
green background, for
instance. Use black and white
when this emphasis is not
important. However, in the
apple example, if you shoot in
colour and then convert to
black and white in
Photoshop, you find that
green and red turn out
almost identical. So, such
photographs need to be shot
in greyscale mode itself.

Remember that when you 
take a black and white
picture, aspects such as
shape, lighting, texture, etc,
become dominant. Do you
want it to be so? Also, do you
want to give an old-world,
somewhat sentimental feel to
the picture?

Also, note that lighting 
plays more of a role in black 
and white pictures than in
colour pictures. For example,
when capturing a sunset, the
shadows that the sun throws
on objects are of more
interest than the Sun itself.

Photographers use the 
term ‘high-key’ and ‘low-key’
for predominantly light and
dark tones respectively.
These determine the contrast
level of the photograph. Now,
note that high contrast steers

the observer to look at
particular subjects in the
picture, and low contrast
makes the observer look at
the complete picture—its
mood, subtle nature, etc.

Use filters to enhance your 
black and white pictures. A
filter absorbs its
complementary, or opposite,
colour: for example, blue is
the opposite of orange.
Purchase an adapter ring for
a filter. Perhaps your camera
may already be equipped
with a lens thread, in which
case you will not need an
adapter. Different colour
filters have different effects.

Red filters tend to have a 
dramatic effect, and make a
photo jump to life. Remember
that red filters are not
recommended for low-light
conditions, or when you have
an active subject—that is, one
central object that is the
whole idea of the
photograph.

Yellow filters are the most 
popular for black-and-white
photography. For example,
they darken the blue sky, so
white clouds come through
with greater brilliance.

Orange filters darken blue 
even more, so you can create
dramatic, magical effects. Try
an orange filter for
landscapes.

Green filters make greens 
lighter and reds darker. In
landscapes or close-ups,
leaves look brighter and red
flowers darker.

Sky light or ultraviolet 
filters make for excellent lens
protectors, and also act as a
transparent-layer filter that
absorbs ultraviolet light.

Close-ups And
Macros (Extreme

Close-ups)
One of the problems with 

macro-photography is
lighting. If you are too close
to the subject, you may block
out light yourself. Most
inbuilt flashes are not good
enough to light up macros.
One solution is to use an
external flash with a remote
control. Another, easier one is
to use an ordinary table lamp.
A good idea with the table
lamp is to cover it with
something like tissue paper,
which diffuses light.

Use supplementary lenses 

to magnify objects. These fit
onto your camera’s lens just
like colour filters—you might
need an adapter. They come
in different strengths,
measured in dioptres, such as
+1, +2, etc. You can use more
than one macro lens at the
same time—with the higher-
power lens placed closer to
the main lens. However, this
can result in loss of quality.

How important are
steady hands while
taking a picture?
Yes, the need for that cannot
be overemphasised. Camera
jitters are probably the prime
cause of bad photographs.
The problem is acute at slow
shutter speeds, which are
used in poor light. In other
words, keep your hands as
steady as possible when
taking pictures in the
evening, for example, or
indoors without using a flash.
Also, do remember that
camera jitters worsen as you
zoom in on the subject. A
faster shutter speed is the
simplest solution.
Photographers often use the
‘one-over-the-focal-length’
rule to decide on a good
shutter speed. For general
digital cameras, here is a
reckoner:

Wide-angle shot — 1/30
Medium-angle shot — 1/60
Zoom shot — 1/125
High-zoom shot — 1/250

If you have unsteady hands
(and find it impossible to
improve despite practice!),
double these shutter speeds.
For example, 1/30 becomes
1/60, and so on.

Tip Of The Month

Here is an example of how colour
can bring out the vibrance in a
subject ...

... while black and white loses out
on it altogether, and introduces a
different mood

Th
e 

H
ol

id
ay

 T
ec

h 
G

ui
de



59OCTOBER 2004 DIGIT

Digital Tools l Tips & Tricks

Learn about Depth of Field 
(DOF). DOF is essentially the
range of distance that is
acceptably sharp within a
photo. It varies inversely with
the aperture size. For
example, a wide-open lens
with an aperture of f1.8 has
very little DOF. If it is
squeezed to f16, the DOF
increases, and more things
come into focus.

In macros, the DOF is 
especially shallow. Here is an
example on getting a good
macro shot: if the subject is a
fly on a flower, use a larger
aperture—this will blur out
everything but the fly. If you
want the fly as well as the
flower, you will need a larger
DOF; so a small aperture—f11,
or even f16—is required. This,
however, makes longer
exposure periods necessary,
which in turn calls for steady
hands. In other words,
macros of small objects with
the background blurred out
are easy enough. However, if
you want a macro of say, a
flower, you need steady
hands.

In the example about the 
flower, you can compensate
for exposure time by using a
higher ISO (or ASO) setting,
but this brings in the
possibility of extra image
noise.

Correcting pictures
Remember to back up
your images before you

start to correct or play
around with them to create
different effects!

A colour cast means an 
imbalance of colour, such as
too much red or too much

green. There are two methods
to correct this in Photoshop:
in the first, simply go to
Image > Adjust > Levels.
Here, click ‘Auto’. In the
second, go to Layer > New
Adjustment Layer > Color
Balance. Then, click OK to
create the adjustment layer
and bring up the ‘Color
Balance Layer’ dialog box.
Here, you can experiment.

Underexposed pictures 
are a frequent problem:
you need the correct level
of light exposure to bring
out detail. If an image
turns out underexposed,
here’s what you can do 
in Photoshop:

If the whole image needs
adjusting, go to Windows >
Show Layers. In the Layer
dialog box, locate the Layer
thumbnail. Drag it to the
‘Create A New Layer’ icon to
duplicate the image. To only
fix certain underexposed
areas, go to step 2, else skip
to step 3.

Select the affected areas
using the Marquee tool. Go to
Select > Feather, and type in,
say, ‘5’ in the numerical field
to soften this section by a few
pixels. You can experiment
with that value. Now, copy
and paste to create a
duplicate layer.

In the drop-down menu
of the Layer dialog box, select
Screen.

Adjust the density of this
layer in the Opacity field
until you get the required
density.

Here’s how you selectively 
sharpen certain areas of a
photograph in Photoshop:
Select Filter > Sharpen >
Unsharp Mask. In the dialog
box that comes up,
experiment with the three
sliders—Amount, Radius and
Threshold. View the results
in the preview window. The
Radius setting is the key
here. It controls the width
of the sharpening halo. The
Amount controls the
sharpening strength. A
small Radius setting needs a
higher Amount. 

Finally, set the
Threshold—this helps avoid
over-sharpening light-
textured areas such as skin
tones. Start with an Amount
of 200 to 300 per cent and a
Threshold of 0, and
experiment with the Radius
setting until it matches the
image contents. Then, adjust
the Amount. 

Finally, increase the
Threshold to smoothen out
over-sharpened areas.

...you can bring it back to life
using Photoshop’s Opacity setting,
as described in this article

An example of an underexposed
picture. If you shot a picture like
this one, don’t worry... 

This is a somewhat blurred picture. You may
want to keep it this way, or you can ...

... use Photoshop’s sharpening feature to bring out
more detail
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Digital cameras
cannot give you per-
fect photos unless

you use professional acces-
sories-tripods, soft-lights,
and lenses specific to the
nature of the photograph.
Adobe Photoshop is a
must-have tool for any and
every budding photog-
raphy enthusiast. It gives
you the freedom to make
the pictures look more 
natural and lively than
they are, remove red eyes,
or do away with unwanted
elements.

Adjust Brightness
And Contrast 
If you take a

photograph from the
wrong angle or direction,
the subject will be too dark.
Depending on what angle
the photo was taken at,
adjust its brightness to
make the darker areas

more visible. Adjust the
contrast to lend more
depth. Open the file in
Photoshop, select Image >
Adjustment > Brightness
and Contrast. Adjusting the
contrast sharpens the
image and reveals finer
details.

Colour Level
Correction
Often, pictures

that you have taken end up
with either too much or
too little colour. This
happens due to a low-
quality CCD, or an overcast
of a nearby reflection. You
easily fix this using colour-
level correction tools. In
the image below, there is
too much of green. Choose
Image > Adjustment >
Levels. Go to the Channel
dropdown, choose Green.
Next, slowly drag the little
white knob under the

graph towards the left to
reduce the amount of
green. This feature
controls the lighter
colours. Now, take the
middle grey knob and
move it to the right 
to adjust the mid-tones. 
The black knob controls 
the shadows and the 
darker areas.

Red-Eye
Reduction
Often people forget

to turn on the Red Eye
Reduction feature while
shooting humans. This is
exactly what happened in
this picture. Select the Red
Eye using the Elliptical
Selection Marquee tool. To
smoothen its edge, set the
Feather Radius somewhere
between five to 10 pixels by
selecting Selection >
Feather. Next, open Image >
Adjustment > Hue and

Saturation. Reduce the
saturation by dragging the
slider to the left. This
makes the red portion 
a little darker. After this,
decrease the lightness 
by pulling its slider to 
the right.

Cropping and
Rotating
If you want to

remove unnecessary
details, select the Crop tool,
and select the area that you
want to keep. Sometimes,
photos come tilted if you
don’t use a tripod. You can
orient the tilted picture.
Drag the edges of the
selection to rotate it. 

Perfect! Of course, there
is no substitute to taking
educated, well-arranged
photographs. Nevertheless,
Photoshop is always there
to enhance the quality of
your digital photos!

After the brightness and contrast
are adjusted, the photo has more
depth and better colour

Red-eye removal is as easy as
the problem

Crop and rotate pictures to
compensate for badly framed
photos
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Retouching Pictures with Photoshop
Remove red eyes, adjust colours, or crop as you like—with Photoshop, fine-tune
your photos and make them look natural and lively

Notice how the all the colours
here look balanced. The green
overcast is now gone
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Personal Information
Managers

Personal Information
Managers are programs

that let you manage time and
contact information. Palm
handhelds come with
minimal functionality in this
regard. There are several
replacement programs that
add features to the basic Palm
applications while sharing
the same database, so
information is not lost when
you remove the third-party
application. Agendus
(www.iambic.com/
agendus/palmos/), for
example, is one
such replacement
that lets you
manage
information on
your contacts. It
offers a very
comprehensive
calendaring
option for your
tasks, lets you
read office e-mail, allows for
linking to-dos with contact
history, and much, much
more. DateBk5
(www.pimlicosoftware.com/d
atebk5.htm) is similar to
Agendus. 

If you are looking for
something more lightweight,
consider HappyDays (www.
palmgear.com/index.cfm?fuse
action=software.showsoftwar
e&prodid=6289), a freeware
application to help you
remember birthdays, etc.
Diddlebug (www.palmgear.
com/index.cfm?fuseaction=so
ftware.showsoftware&prodid
=16870) is another free
reminder program. Worthy of
mention is BugMe! Notepad
(www. palmgear.com/
index.cfm?fuseaction=softwar
e.showsoftware&prodid=839),

a reminder program with
alarms.

Databases
Memoware (www.
memoware.com) has

information on databases for
your handheld. You will also
find a healthy collection of
free databases at the
HandDBase Web site
(www.ddhsoftware.
com/handbase_palm.html).

Several programs help you
create a database for the Palm.
Of these, HanDBase is a
powerful solution that is fairly
easy to learn, with database
templates. It offers Microsoft
Excel compatibility, support
for forms, multi-user synching,

conduits for ODBC, Microsoft
Access and FilemakerPro.
Features include linking
between databases, database
views and field data-types, and
timed alarms that can be
attached to records.
MobileDB4
(www.handmark.com/produc
ts/mobiledb) is another
application, compatible with
Excel, Access and Filemaker,
and it brings along a
Windows desktop companion.
It also supports PrintBoy,
using which you can print
databases off an IR printer
using your handheld.

Office suites
Two major suites let you
type, edit and present

documents on the Palm
handheld: Documents to Go

(www.dataviz. com/products/
documentstogo /index.html)
and Quickoffice (www.cesinc.
com/quickoffice/). These offer
applications for word
processing, spreadsheets,
and office presentations.
Both talk fairly well with
Microsoft’s Office suite for
Windows: for example, a
Word file can be viewed on a
Palm handheld with bullets,
headings, hyperlinks, tables
and embedded pictures
intact. Hardware accessories
let you use your handheld as
a mobile presentation
platform. The latest versions
now offer native support for
Microsoft Word, and Excel
files. Quickoffice also lets
you create and view a
PowerPoint file in the 
native format.

Wordsmith (www.
bluenomad.com/ws/prod_
wordsmith_details.html) is a
powerful software that can
read and write Microsoft
Word and RTF documents;
high-resolution font support
makes editing a document
less of a chore. There are
several other features as well.

Password Managers
These are programs
that help you securely

store passwords, logins and
other sensitive information

on your Palm
handheld.
SplashID (www.
splashdata.com/
splashid) and
SecureIt
(www.schau.
com/sit/index.
html) are two
such programs,
both of which
use the Blowfish
algorithm that
employs a 64-bit
block cipher
and variable key

lengths of up to 448 bits. The
security offered by these
programs is good enough for
ordinary use. SplashID
supports high-resolution
displays (320 x 320), and
offers unlimited categories;
there is colour and icon
support, and it comes with a
companion Windows
software. SecureIt is a
freeware application that
also uses the MD5 algorithm
for securing data.

Recommended sites
www.freewarepalm.com: a

repository of freeware titles.
www.handango.com and

www.palmgear.com: forthe
latest and Palm-powered
software.

Palm OS

HanDBase is a powerful database solution

Quickoffice allows importing and exporting of MS
Office documents

A password manager can
transform your Palm into a handy
e-wallet
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Personal Information
Managers

In the PIM category two
software are widely used:

Pocket Informant 5
(www.pocketinformant.com/p
_pocketinformant.php) and
Agenda Fusion 6 (www.devel-
operone.com/agendafusion/).
Both allow for multiple views
of your scheduled appoint-
ments; alarms can be set for
individual notes while tem-
plates help ease setting up of
common tasks. 

Also available is ListPro
4.0 (www.iliumsoft.com/
site/lp/listpro.htm), which
helps in organising to-do lists,
projects, etc. If you are
looking for simple appoint-
ment management software,
Spb Pocket Plus (www.spb-
softwarehouse.com/prod-
ucts/pocketplus/?en), with its
repeating alarms, can help.

Databases
SprintDB Pro 2
(www.kaione.com) is

arguably the best program for
creating databases on a Pocket
PC handheld. It is fast, com-
pact and easy to use, while

supporting both Pocket Access
files and letting you create
custom databases. It also
allows for direct printing from
a handheld via infrared and
serial ports—forms, tables and
graphics, in addition to bar-
codes, can be printed on 
supported hardware.

Office suites
While a single good
product to take care of

all office application needs is
absent on the Pocket PC plat-
form, several stand-alone prod-
ucts do a wonderful job of
filling in the need left by
Microsoft’s offerings. 

SpreadCE
(www.byedesign.freeserve.co.u
k) is a spreadsheet application
generally considered to be
much more powerful than
Pocket Excel.

PhatPad (www.paragraph
.com/phatpad.html), an
advanced notes organiser, is
widely used for basic editing
needs. It allows you to draw
pictures, jot down text notes,
or put a mix of pictures and
typed text on a virtual
scratchpad. You can also
export your notes and draw-
ings as JPEG or BMP files, 
e-mail them as attachments 
or transfer them between
handhelds. 

For reference needs,
ProWord (http://shop.store.
yahoo.com/pilotgearsw/prowo

rd.html) is the best dictionary
program on the Pocket 
PC platform.

Utilities
Resco Explorer 2003
(www.resco-

net.com/explorer.asp) is a
decent tool to browse your
file system with. It is quite
like Windows Explorer - it

shows all the files and folders
on your handheld and storage
card. It is also handy if you
want to encrypt files or com-
press them. PocketExplorer
(www.citadeldevelopment.co
m/products/pexplorer.aspx) is
a similar, freeware program.
If battery life is a concern,
you can underclock your
handheld using a program
like Pocket Hack Master 2.45
(www.pocketgear.com/soft-
ware_detail.asp?id=7258).
BatteryPack Pro
(www.omegaone.com/battery-
pack/default.htm) performs a
host of neat tricks like moni-
toring battery life and storage
space on your handheld.

Password Managers
The Pocket PC platform
has a comprehensive

solution to help you manage
all your passwords. eWallet

(www.iliumsoft.com) stores
information in password-pro-
tected categories which are
encrypted with the RC4
encryption algorithm with a
128-bit key. eWallet does not
store the password in your
wallet file, or anywhere on
your PDA or your PC. Also
available is Nice Start
(www.trancreative.com). The
program protects the entire
handheld from foreign
hands by allowing password
protected access. It can also
lock your handheld after a
certain number of incorrect
password entries, and also
logs all password activities,
allowing you to find out 
if someone tried to use 
your device without your
knowledge. 

Must-haves
Icbar (http://icbar.ict-
inus.com) is a freeware

task bar and application
manager that gives you
greater control over running
applications. 

Microsoft Reader (www.
microsoft.com/reader/down-
loads/ppc.asp) : With the
recent spate of free e-book
releases from Microsoft in
the ClearType font, Reader is
a definite keeper.

Network Monitors: Use
GPRS Monitor (www.spbsoft-
warehouse.com/products/gpr
smonitor/index.html?en) to
track data transfers via GPRS,
CDMA or GSM networks, and
IP Dashboard (www.hudson-
mobile.com/products/ipdash/
index.html) to quickly mon-
itor the state of all your 
wireless and wired network
connections.

Recommended sites
www.freewareppc.com and

www.ppc4all.com: lots of
freeware applications for the
Pocket PC platform 

A personal information manager

Resco Explorer for browsing files
on Pocket PC

PhatPad is ideal for taking 
ad-hoc notes

POCKET PC
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Aparna Krishnakumar

ong stretches of pure white
sand, beautifully carved
glaciers nestled between

snow-capped mountains, plush
green valleys replete with colours
and fauna, rugged terrain punctu-
ated by dangerous gorges—it’s high
time you stop picturing these
beautiful images as mere wallpa-
pers. It’s time for a vacation—you
deserve a break.

With the festive season just
round the corner, a rollicking hol-
iday season due, and travel sounds
a really exciting way to relish that
elusive break. But there’s a catch,
though. You have a crammed
schedule that leaves you with little
time to chase tour operators and
holiday packages. Is there a way
out? The good news is that there is
not one, but many.

London, she thought it would 
be a daunting task going about 
all the arrangements. Until 
she stumbled upon www.trav-
eljini.com. It turned out to be the
one-stop  guide with all the
details that she was hunting for.
Interestingly, travel Web sites go
beyond the routine, mundane
details that tour operators would
otherwise provide. In fact, the
sites take you on a virtual tour,
making the destinations come
alive with vivid descriptions.

Bhatia says that a Web site is
the preferred medium of infor-
mation for Indians when it
comes to travelling abroad. Be it
www.outlooktraveller.com or
www.traveljini.com, sites offer
information on everything, from
a restaurant in Athens serving
vegetarian food, to what an
Indian would fancy while shop-
ping in Malaysia. If you are

L

Look to the Internet—travel
Web sites are willing to do all the
planning. From honeymooners to
adventurers, from short vacations
to designer holidays, sites have
vacation packages. Says Sachin
Bhatia, Chief Marketing Officer,
Makemytrip India Pvt Ltd, “Online
travel transactions account for
over 33 per cent of all e-commerce
across the world.” Travelling has
assumed a whole new dimension
with the growing popularity of
online purchase and auction of
tickets. While Indian Railways
offers online booking, Sahara and
Indiatimes came up with round-
the-clock bidding on tickets. 

A Few Good Sites
Take the case of Priya B, a Pune-
based software professional who
planned her honeymoon trip to
the Andaman and Nicobar
Islands. With her fiancé away in

Photograph Jiten G
andhi Im

aging Atul D
eshm

ukh

Bon Voyage
Calling All Mouse Potatoes!

The holiday season is round the corner. From now on,
you don’t need to go through the hassles of arranging
your entire tour—let Web sites do it for you
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lookout for a hectic adventure or
a quiet spiritual voyage, rest
assured, these Web sites have
wonderful packages for every
kind of traveller. A typical sea
cruise is a popular choice
amongst holiday seekers. Travel
sites offer good deals on cruises
such as the MV Vrinda, which
takes one around the idyllic
backwaters of Kerala. The tour
entails provisions for car rentals
and hotel stay. 

Comparison packages within
a category are often presented,
throwing open a wide variety of
choices for the average traveller.
Traveljini.com, for example, lets
you choose the best adventure
package, while Outlooktraveller.
com lets you search for the best
deals that suit your pocket. 

Enhance The Experience
The essential idea for any travel
site is to make the trip a memo-
rable experience. And the sites
offer loads of features. Traveljini,
for example, offers a Jini mem-
bership that offers discounts on
all of its trips. They assign a 
travel specialist to you, to help
you chart your holiday plans 
better. Outlooktraveller.com and
Indiatravelmall.com have mes-
sage boards and forums that let
you interact with fellow trav-
ellers. Makemytrip.com has a ded-
icated toll-free telephone
number for the US, Canada and
India. It even runs live Web-chat
sessions to handle queries from
would-be travellers.

Everyone has a dream destina-
tion; yet, one is also perpetually on

the lookout for fair price deals for
different holiday trips. Tripad-
visor.com ensures that once you
sign up for their Dealadvisor or
Tripwatch newsletter, you are reg-
ularly updated on the best pack-
ages available.

A big advantage with these
sites is that they allow payment
through secure channels, such as
PayPal. They also accept credit
cards. In fact, ICICI even gives
travel loans that can be repaid in
easy monthly instalments. 

Stress-free Vacations
The idea of going on a vacation is
to spend the time relaxing. How-
ever, we invariably exert our-
selves checking up with tour
operators, arranging for the food,
and ending up at the wrong
places in the hunt for informa-
tion. This is where travel sites
come into the picture. As Bhatia
says, “The advantage to a cus-
tomer is in getting real-time
booking for all elements of 
travel, and for a service provider
in reaching the customer
directly.” He feels that travel sites 
will not only market India inter-
nationally, but will also bring
tech-savvy Indians closer to other
countries. 

Robert Frost put it best: “Two
roads diverged in a wood, and I
took the one less travelled by,
and that has made all the differ-
ence.” If you are planning that
vacation, go the Internet way,
and make your holidays more
fun and less stress. 

Bon Voyage!
aparna_krishnakumar@thinkdigit.com

looking for information that is
diverse, exhaustive and inter-
esting, a travel Web site is the
ideal stopover.

Services, Ahoy!
In 2001, a Jain monk wanted to
travel from Mumbai to New Delhi
on foot. The plan was to visit all
the Jain temples he would come
across on the journey. 

Traveljini charted out this
challenging itinerary. A smart
travel planner, Abhishek Mad-
hukar made a list of the temples
along the route. He calculated
the distance travelled by the
monk in a day and designed a
well chalked out itinerary. The
result—the Jain monk and the
devotee became regular cus-
tomers. This is the tale that Jerry
Pinto, the former editor of Trav-
eljini, loves to narrate when
asked about what makes travel
Web sites stand apart.

Today, travel sites have come
a long way from being dubbed as
mere ornamental getaways on
the World Wide Web. The
makers of these sites have
realised the need to supplement
routine information with all the
services needed for such tours to
get going.

Makemytrip.com offers dis-
counted airfares from the US to
India with offers such as round-
trip and multi-city tours. Ask
them the secret behind the dis-
counts and Bhatia of Make-
mytrip.com explains that they
book tickets at wholesale prices
from Amadeus, which  is one of
the world’s largest ticketing
companies. These savings are
passed as discounts. Others such
as Indiatravelmall.com offer
packages that exclude airfare or
meals.

Most travel sites have
numerous options for the trav-
eller. Whether you are on the

Travel Web Sites To Check Out
wwwwww..ttrraavveelljjiinnii..ccoomm: An Indian portal set up in 2000. It

has tie-ups with ICICI, HSBC and Baazee. It offers a host of
domestic and international packages

wwwwww..oouuttllooookkttrraavveelllleerr..ccoomm: A portal from the Outlook
Group, it offers a comprehensive list of destinations and
theme holidays. Worth checking are the holiday deals and
travelling experiences posted by members

wwwwww..mmaakkeemmyyttrriipp..ccoomm: The portal is preferred by NRIs
for its great planning of itineraries. Ideal for those looking
for good deals to visit relatives and friends abroad

wwwwww..ttrriippaaddvviissoorr..ccoomm: A US-based site with details on
different destinations along with best package deals and a
forum to post and share experiences

5 Steps To Paradise

Visit
traveljini.com
and click on
Holidays

▲

From the list of Domestic
Holidays select Long breaks.
For example, you select Diwali.
Click on Long Breaks again to
select the Diwali package

Tick the boxes marked Compare and
click on the green Compare button

You will get a chart in terms of
package, duration, head count, what
the package includes and what it
excludes. Pick a package and start
packing!

There are
three
options. You
can choose
one or
compare all

▲

▲

▲

▲
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The Initiation Ceremony
After you switch on your cell phone, it asks its
base station for a System Identification Code
(SID), which is then matched with a similar

number stored on the phone. If an SID is not
received, the phone displays a ‘No Network’

message. If it receives a matching SID, the phone
knows it is operating locally. If the numbers do
not match, then the phone knows it is roaming

Getting Registered
Upon receiving an SID, your cell phone registers

its presence at the base-station’s database. Thus,
the station is aware of your phone’s presence.

This tracking is how you receive location
information on your cell phone. It also enables

operators to advertise services by location. After
this registration, the base station hands your cell

phone two frequencies, so that you can speak
and listen simultaneously. This is known as a full-

duplex connection

Changing Stations
Each city is divided into cells—each with a local base station. All base stations
communicate via a central MTSO (Mobile Telephone Switching Office). The MTSO is
different for each operator. Main stations for different operators may talk with
each other to enable roaming

Anatomy Of A Call
A behind-the-scenes look at how a cellular phone network works—from 
receiving calls to roaming

1

2
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Keep Talking
When you recieve a call, the base
station connects the two phones via
the assigned frequencies

How Roaming Works
If the SIDs from Step 1 do not match, the cell phone is roaming.
The MTSO of the cell you are in contacts your operator’s MTSO to
verify your roaming priviledges. It then  tracks your 
movement as you travel through its cells

Text A
hm

ed Shaikh
Infographic Jayan N

arayanan

3

Cells And The City
Each city is divided into frequency cells, depicted
here as hexagons. Cells sufficiently separated re-use
frequencies. As a cell phone transitions from one cell
to another, the MTSO detects this transition and
hands over your data to the second operator’s
MTSO. This does not interrupt an
ongoing call

4
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Digital cameras are not
just about great
technology and
megapixel ratings; they
are about convenience
and storing memories.
Presenting a range of
sub-Rs 30,000
digicams for you to
choose from
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Aliasgar Pardawala and Mustali
Kachwala

A
digital camera can be
a versatile device—it
can capture movie
clips at up to 30
frames per second;

comes with advanced imaging
technology, not to mention cut-
ting-edge inbuilt software; you
can burn captured video on a
DVD; or watch images you have
shot on a TV. And you don’t even
need a PC for all this. Some dig-
ital cameras even provide an
inbuilt slide-show feature.

The PictBridge standard is
another good thing that has
happened to  digicams (See “Keep
the PC Out of the Picture”, on
printing photos directly from
PictBridge-enabled cameras.
Page 57 of this issue of Digit). It
allows a direct connection
between a digital camera and a
printer for printing images.
With the PC out of the picture, it
speeds up the printing process,
and takes away image resizing
and paper quality hassles. You
only need to plug in the camera
to the printer and press a few
buttons.

The price of a point-and-
shoot digital camera that offers
decent image quality is still on
the higher side. But it is worth it
when you consider how much
creative fun you can have. Of
course, one must not forget the
click at will freedom that a dig-
ital camera offers—point, shoot,
delete what you don’t like, and
store the rest as precious memo-
ries, or works of art.

Loading Up
We rounded up 29 cameras from
12 brands. We chose a price
range of Rs 10,000 to Rs 30,000—
it had something for everyone.
We decided upon Rs 10,000 as the
entry level since most cameras
below this price don’t offer sat-
isfactory results. 

The Rs 30,000 barrier was
decided upon because anything
beyond this price is also beyond
the budget of the average Indian.
Of course, if you want something
that is high-end, you are better
off importing it at a lower price.

Orite, Premiere and D’zign
were the new entrants amongst
the lesser known brands. HP was
the new heavyweight that joined

Canon, Kodak and Sony in the
Big Boys’ camp. Fuji did not par-
ticipate in the shootout.

LESS THAN Rs 20,000
Price crash!
Cameras in the price range of Rs
12,000 to Rs 15,000 a year ago are
now available for Rs 7,000 to Rs
8,000. It is now possible to buy a
3-megapixel camera with a 3X
optical zoom, and a degree of
manual override, such as white
balance and flash-mode setting
for Rs 20,000 or less. Our sub-Rs
20,000 category started from Rs
8,500. Eleven models made it to
this category—three from Kodak
and Orite, two each from Canon,
Nikon, Olympus and Samsung,
and one each from Casio, Cre-
ative, D’zign, Premier and Sony.

What They Offered
A new entrant, the Orite VC-
5000Z, made a mark. A 5.3
megapixel camera, this Orite
model is capable of a 2,560 x
1,920 image resolution. The only
other camera to hit the 5
megapixel mark in this category
was the VC-R500—again from
Orite.

Most other cameras were 3.2
megapixel ones, even if there
were a few exceptions such as
the Kodak CX7220 and the Pre-
miere DC2302 with an obsolete 2
megapixel CCD. The Sony was 4.1
megapixels; so were the Kodak
CX7430 and the Nikon Coolpix
4100.

In terms of compactness,
nothing came close to the emi-
nently portable Casio Exilim Ex-
Z30. The Ex-Z30 is just 2.3 cm
thick, and weighs about 125 gm.
This, coupled with its LCD
screen, makes it a great outdoor
companion.

Optical zoom gives you
freedom to capture distant
images without compromising
on quality. Most cameras in this
range had 3X optical zoom, with
only the Kodak CX7220 having
2.1X. However, four models, the
Canon A310, the D’zign, the
Olympus C-160 and the Samsung
301, don’t have this feature at all.
They had digital zoom, which
was as high as 5.1X in the Canon
A310. A digital zoom is not the
same as an optical one, in terms
of quality of image obtainable
while using it.

White balance is a vital fea-
ture for a digital camera.  One
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needs to be extremely careful to
set it correctly to get good photos.
The Daylight and Cloudy settings
play a crucial role for shooting
outdoors. Most cameras that we
tested featured more or less the
same white balance settings,
excepting the Kodak CX7220. It
didn’t have manual overrides.

In most cameras, a Macro
mode, meant for taking extreme
close-ups is present. What differ-
entiates one implementation
from another is the level of close-
up one can obtain. If the subject is
as tiny as an insect, most cameras
in this category won’t capture all
the details. 

The Canon PowerShot A75
and the Casio Exilim Ex-Z30 allow
you to get as close as 5 cm to the
subject. However, one needs really
steady hands while shooting a
subject this close. Weight and sta-
bility of the camera are also
important. 

A light camera, such as the
Casio, tends to jerk when the
shutter button is pressed, and
taking macros gets problematic.
The other extreme is equally dif-
ficult—if it’s the heavy Canon A75,
you have hold it with both hands.
This does get awkward at times.

Memory plays a major role in
any digital camera. What is the

point of having good optics and
electronics if there is not enough
storage space in your camera.

We evaluated the cameras on four main parameters—Features,
Ergonomics, Performance and Price Index. The importance

given to each parameter varied, depending on the category.

Evaluating Their Features
We awarded points based on the capabilities of a camera, such as
its imaging chip resolution, known as the Charge Coupled Device
(CCD), its optical and digital zoom capabilities, presence of
manual focusing, types of metering modes available, its white
balance implementation, the number of flash modes on offer, its
shutter speed range, the storage type supported, the nature of its
battery, and video-out capabilities. We also awarded points to
package contents such as a battery charger, a camera pouch and
so on. Software bundled with the camera and support for various
operating systems was also considered.

Ergonomics Is Important
We noted various aspects of the camera’s build, and looked for
features that enhanced its user-friendliness, such as how
comfortable it was to hold, the ease with which its user interface
could be navigated, the size of its buttons, the placement of the
flash (and whether it avoids the finger-over-flash syndrome), and
the inclusion of dedicated menu-navigation buttons. The size and
weight of the camera were also taken into consideration.

Finally, Their Performance
To evaluate the performance of a camera, we introduced it to a
series of tests and evaluated it on preset criteria. The tests are
noted as follows.

Mother Knows Best: We created an inanimate test scene to
test the camera’s ability to reproduce colour and capture details
correctly. The mock-up scene consisted of a red motherboard
and various slots and connectors in blue, yellow and red. This
setup offered a wide tonal range. 

Gradation in shading was brought out by a blue sheet in the
background, while specular effects (shine) were graded via a
shiny metallic audio connector and the motherboard’s USB
housing. For minute details we looked to the pins adorning the
CPU socket, and the walls of the memory and PCI slots.

The cameras were graded on the level of accuracy with
which these details were captured. The lighting was kept
constant.

The camera was mounted on a tripod, the highest possible
resolution was chosen. The camera’s flash was used, its other
settings such as white balance, metering and flash modes were
on Auto. 

Dummy Shoot: Here, we took a random bystander and shot a
photograph of that person under uniform lighting conditions. If
the camera allowed for a Portrait mode, it was used. With
cameras that did not have a Portrait mode, the picture was taken
in Auto mode. This showcased the performance of a camera
under indoor lighting. In the final image, we looked for accurate
skin tone reproduction, white balance, uniform tonal
reproduction under fluorescent lighting, etc.

Moving Mountains The tendency to be overwhelmed by
natural landscapes is high. Especially, since the landscapes are a
rare sight in our busy lives. To test camera for this, we shot an
image of a mountain covering half the frame, while the rest was
taken up by the sky. The purpose of this test was to gauge a
camera’s performance under natural lighting conditions. Shot in
Landscape mode, other settings such as white balance and
shutter speed were left to the camera. (Unfortunately the
mountain in question is steadily disappearing under quarrying…)

Just Doing It A sport is another visual treat, begging to be
captured in various acts of motion. In this test, we tried to
capture a fast-moving object such as a car. A Sports mode, if
available, was selected. The cameras were rated according to the
clarity of the shot. Cameras that returned blurred images lost
points.

Extreme Close-up A Macro, in photography parlance is an
extreme close-up of an object or a subject. The kind of
photographs you would see in an issue of National Geographic
demonstrating the pollination of a flower, by an insect, for
example. In the Macro test, we tried to capture the tiny grains on
a leaf. We got as close to the subject as possible. Here we looked
for focused and crisp results. (We await the acceptance of our
sample images by NatGeo.)

Taking Price Into Consideration
The price index was calculated taking into account the lowest
price for which the cameras are available. More weightage was
given to price for low-end cameras as compared to that given to
our second, the greater than Rs 20,000 category.

The Awards Process
The score noted from Features, Ergonomics and Performance
tests and from the Price Index was given importance as per the
specific category. An overall score out of 100 was then
calculated. The product that scored the highest in the overall
score was adjudged the winner of the Digit Best Buy Gold Award
for its category. The runner-up received the Digit Best Buy
Silver Award.

How We Tested And Decided The Award Winners

The Canon PowerShot A75
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The first thing that comes to
your mind when you are going
on a holiday is your digital

camera. You are faced with questions
like which camera & features, how
will it enhance your vacation
memories, can it capture moving
pictures, does it have enough battery
life to support the journey and so on.
Let’s find the various elements &
features involved in choosing the right
Digital camera. 

Enhance your enjoyment
The first thing that matters is size and
sporting a camera with a slim and
contemporary square design equipped
with a wide LCD screen allowing you
to view and share photos with
maximum enjoyment. A minimum of
5.1 Megapixels captures every detail
of your subjects with outstanding
clarity & can enlarge images up to A4
size with no loss of quality. Working
together with the super HAD (Hole
accumulated Diode's) CCD, helps
harnessing incidental light more
efficiently, and virtually halving the
picture's noise levels resulting in
cleaner, sharp and vividly beautiful.

Quick and easy operations
Your Camera should be designed to
make your photographic experience
as pleasant and easy as possible.
The Cyber-shot W1 is crafted with
your satisfaction in mind. Sony's
Real Imaging Processor circuit is
designed specifically to enhance
tasks & response time of Digital
cameras. Its extended battery life
delivers up to 340 shots or 170
minutes between power charges.
Your camera should let you
manually adjust exposure to create

the effect you want and Sony Cyber-
shot lets you do just that.

Multipoint Auto focus
This function automatically identifies
5 main focus points for your image,
ensuring that the picture is always
sharp and clear. You're always assured
of perfect clarity from foreground to
background, even if your subject isn't
in the center of the frame.

Optical and Digital Zoom
With Optical zoom, you can get closer
to your subject without distortion,
blur or other loss of image quality.
Digital zoom greatly extends the
optical zoom range by 2x or more,
while still ensuring smooth and clear
close-ups.

Mpeg Movie 
At times when you need to capture
stills as moving memories, your
camera can record Mpeg movies with
sound. There is a range of quality

The newly developed Real
Imaging Processor is the
driving force behind the fast

start-up time, shutter lag and
shooting interval so you never miss the
moments. This processor brings digital
photography into focus. This is built to
give you better colour reproduction,
white balance, exposure, and focus
when you use the automatic mode
setting.

But above all it enhances your
shooting experience in 3 important
ways:

Great Picture Quality
Real imaging Processor cuts
down on image noise, thus
providing us sharper,
smoother & more detailed
pictures which leads you to
experience those moments every year.

High Speed Performance
The highly efficient Real imaging

Processor offers shorter
shooting time, faster burst
shooting, near simultaneous
image processing and high-

speed image display when
compared to conventional DSP

(Digital Signal Processor) technology.

Power Efficiency
Using this Real imaging
Processor gives you lower
power consumption
enabling longer use of the
same.

Make the most of your Holidays 
with Sony Cyber-shot
Sony’s Real Imaging
Processor  enhances shoot-
ing experience

Advertorial
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settings, from Video mails - small files
for emailing; all the way upto Mpeg
Movies. Your Sony Cyber-shot records
non-stop, high-resolution movies in
VGA format that can be played back
full screen on TV using the AV cable.

Lenses
A good pair of lenses such as the Carl
Zeiss Vario-Tessar Lens only on your
Sony Cyber-shot is designed
specially for compact cameras, and
produce top quality images that are
brilliant and sharp, have excellent
contrast and almost no distortion
enabling an extremely compact &
handy cameras.

Super Resolution Converter
Using Digital Signal Processing, a high
signal-to-noise ratio is achieved by
digitizing all signal processing &
recording functions. This leads to
restoration of lost data and getting a
stable image and reliable quality.

Clear Colour Noise Reduction
This function analyses the light 
& colour frequency of an image 
thus smoothening out the distortion
& creating a natural tone

reproduction,  essential for photogr-
aphing landscapes.

Clear luminance Noise Reduction
The picture taken should detail the
true image and not the tricks of the
light. This feature uses a filter to
smoothen the transition between areas
of sudden or significant altercation of
light.

14-bit Digital Extended Processor
This feature enables capturing the
dynamic range between light & dark
areas without losing details thus
producing more accurate, smoother
images, realistic contrast.

Slow Shutter Noise Reduction
When shooting conditions are
demanding, Slow Shutter NR cuts
down noise disturbances and helps
produce clearer & sharper images. 

Accessory - Cyber-shot station
You can enhance your total digital
experience with a Sony Cyber-shot
station. It provides one stop-
connectivity - print with PictBridgeTM,
or browse images on your TV.

Shoot, Store, Edit, Share &
Enjoy

Treat yourself to a digital experience
with Sony Cyber-shot. Explore the
many possibilities - from easy storage
to safekeeping of your images from
videos on Memory Sticks, to sharing
them via email and viewing them on
your TV. One is equipped to express
the creativity with utmost convenience
and connectivity at the same time. 

Shoot
With Sony Cyber-shot digital still
cameras, you enjoy great features and 
user-friendly menu, making both 
still images & long Mpeg movies 
with ease.

Sony Cameras to
choose from
Sony’s Digital imaging technology
equips the photographer or an
amateur with point & shoot sim-
plicity that makes the shooting
experience enjoyable. Sony’s
advanced features like 5.1 mega
pixels or even 3x optical zoom
makes the features of best quality,
high speed & power consumption
possible making the user enjoy
the moment’s seasons
after seasons.

DSC - W1
- 5.1 Effective Mega
Pixels
- Carl Zeiss Vario-
Tessar Lens
- Extra Large 6.35 cm LCD Screen
- Simple Mannual Mode
- 3x Optical Zoom
- 6x Precision Digital Zoom
- Smart Zoom

DSC - P100
- 5.1 Effective Mega

Pixels
- Carl Zeiss Vario-
Tessar Lens
- 3x Optical Zoom

- 6x Precision
Digital Zoom
- Multi-Point Auto Focus
- Scene Selection

DSC - P73
- 4.1 Effective
Mega Pixels
- 3x Optical
Zoom
- Conversion
Lens
Compatibility
- Histogram Indicator

Advertorial
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Store
Memory Stick- Store your precious
images and movies in the convenient
and highly durable Memory Stick
Storage media. With Memory Stick,
you can transfer files to a host of
compatible digital devices.

PC without Memory Stick Slot-
Your Cyber-shot can double as an
external drive for you to download or
upload files from your Memory Stick
to your PC, by using a standard USB
interface.

Edit with Picture PackageTM

Experience the fun of creating
slideshows using you images. With
Picture PackagesTM, you can use your
PC to combine your photos with pre-
installed sounds or even MP3/WAV
music files. Picture Package software
is bundled with year 2004 Cyber-shot
new models. Add in special effects
and words, then burn your slideshow
into a convenient VCD format.

Share
With a Cyber-shot Digital still Camera,
there are so many ways to share the
fun and enjoyment.

Connect Direct and View on
TV/PC - Use Picture Package editing
software (supplied) to create
slideshows, then burn onto a VCD and
share interesting clips with your

friends on TV. You can even enjoy
large-screen viewing of your images
by connecting your Cyber-shot to a TV
using an AV cable.

Mobile Devices - More ways you
can enjoy your photos! Download
your images onto your Sony CliE
PDA or Sony Ericsson phone to use
as personalized wallpaper or send
it to your loved ones via Memory
Stick or MMS.

Do-it-yourself Home Printing - All
new Cyber-shot digital still cameras
support the industry standard
PictBridgeTM technology, which
makes it possible to connect directly
with a PictBridge printer via the USB
cable, and print images without using
the PC. Or use Sony's own Digital
Photo Printer (DPP-EX50), with
PictBridgeTM to print superb digital
photographs directly from your Cyber-
shot. With its high quality dye-
sublimation print method and
high speed processing, the DPP-
EX50 lets you enjoy, brilliant
and professional quality photo
prints.

Now when you go on a vacation,
be sure you have your Sony Cyber-shot
to  capture your precious moments for
life. Use the above-mentioned
software and techniques and share the
moments with your loved ones who
couldn't be with you on your vacation.

Batteries
The action never ends. Ensure
that you are always
prepared with additional
batteries with Sony's
rechargeable
batteries and quick
chargers.

Carrying Cases
Taking your Cyber-shot outdoors

has never been easier or
safer. The two-way
style you can

select from is
shoulder carry or

waist pouch along
with Mini pouch and

shoulder strap.

Lens Adaptor
Enhance your

vision. Get closer to the
action with a tele-
conversion lens or
capture more with a
wide-conversion lens.

Memory StickTM

Memory StickTM enhances
your Cyber-shot and enables easy
editing, viewing and sharing of

photos. Simply
insert your
Memory StickTM

in any device with
a Memory
StickTM slot and

record your still images, high
quality videos or high volume
data.

Advertorial

Accessories you need
to carry

EDIT with Picture PackageTM

Shoot-Store-Edit-Share-Enjoy

Shoot Store

Connect Create/Edit
Download 
onto a CD
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Most cameras came with an
inbuilt memory of 16 MB. SD and
MMC were the formats of choice.
Canon’s cameras came with 32
MB Compact Flash cards and no
inbuilt memory. The same was
the case with the Sony P73, which
had a 16MB MemoryStick. The
Casio was at the bottom of the
list. It had less than 10 MB of
inbuilt memory. It can hold no
more than a paltry five images at
high resolutions. 

Such cameras are handi-
capped in a way. You are com-
pelled to buy additional memory
modules if you plan to take loads
of photos. Moreover, copying a
photo to an external memory

card is a slower process than
storing it internally. The user has
to keep this in mind while taking
fast shots, such as scenes from a
sporting event. 

It is also advisable to carry a

good number of medium-capacity
cards than just one or two high-
capacity cards. The reason is again
speed of access. A large card will
take much longer to refresh with
a new photo than a smaller one.

Another key issue—battery
life. Does your camera support
rechargeable batteries?  Does it
come with a charger? If yes, then
note that these are some features
worth spending on. 

The Canon A75 was the only
camera powered by four AA bat-
teries. Both the Nikon models and
the Sony P73 came with two AA
rechargeable Ni-MH batteries. 

The Casio, the Orite VC-R500
and the VC-5000Z had propri-
etary Li-Ion batteries, the pro-
prietary nature of which turned
out to be both good and bad.
Good because the running cost
is significantly lower as one
doesn’t have to worry about bat-
tery replacement, and bad
because the camera can’t be
used outdoors over long periods
of time. Once the batteries gets
drained, you don’t even have the
option of replacing them with

regular ones.
PictBridge is a standard that

enables a digital camera to
connect directly to a PictBridge-
compliant printer to print
images. Interestingly, this
feature completely bypasses the
PC. Canon, Casio, Nikon, Sony,

Olympus and Samsung 307 were
all PictBridge ready. 

Three models from Kodak
and lesser-known brands such as
D’zign, Premier and Orite didn’t
support the standard. However,
the Kodak cameras came with
connectors at the bottom, which
let them connect to a Kodak
printer dock. You need a Dye-
Sublimation printer for this to
get the printouts directly. 

Were They Easy To Use?
The Nikon Coolpix 3200 and 4100
sported an identical design with
the same layout of buttons, as
well. The cameras are very com-
fortable to hold, and navigating
their interface is simple, with
self-explanatory settings. 

The Casio Ex-Z30 is slim and

light, but the buttons are tiny.
The camera, however, has a very
impressive navigation, especially
when it comes to different
modes. This, coupled with a large
and impressive LCD, makes it an
attractive option.

Three models from Kodak and
two from Olympus were quite
large. However, the menu naviga-
tion on the Kodak was the sim-
plest of them all. The icons are
big, and the tags are explanatory.

The Canon A75 was the
bulkiest of the lot, and its weight
shoots up once the four AA bat-
teries are plugged in. The
camera, however, sports a very
sturdy design and feels comfort-
able to hold.

The button placement, espe-
cially the zoom button, is very

Nikon’s Coolpix 4100 reproduced good
colour tones

In the world of news
photography, Palashranjan

Bhaumick is a pint-sized
giant. He is 48, but looks 10
years younger thanks to the
energy he brings to his work
and life. He is photo editor

of Business India, one of
India’s most respected
business magazines, a post
he has held for several years

now. He has been shooting pictures since he
was 14, and everything that he has learned
is self-taught. His first camera was the
Kodak 620 box camera.

He swears by digital photography, but
also feels that the old world charm and the
quality offered by manual cameras will
never die. He says: “Digital photography is
the order of the day. It has captured the
minds of millions, and is growing
tremendously. In a fast moving world like
ours, digital photography is the only way to
match with its ever growing demand.”

Mukesh Parpiani is
photo editor of Mid

Day, Mumbai’s second
largest selling newspaper.
The multi-award winning
news photographer has
been on the forefront of
news journalism for over
two decades, and has
worked with some of
India’s premier publications, including The
Indian Express. Some of his photographs
depicting human life in India were used in
the award-winning ad campaign of
Indya.com in the year 2000.

He says: “For today’s news professional,
digital photography is a must. Even though
some people still prefer the old way of
functioning, digital cameras give you all the
flexibility you need. Even amateurs find it
easier to shoot on digital. With technology
making rapid progress, there is little
difference in quality between a digital photo
and a photo clicked on manual SLRs.”

Our Expert Panel

Palashranjan
Bhaumik 
Photo Editor,
Business India

Mukesh Parpiani
Photo Editor,
Mid Day

Digit consulted two of India’s top professional news photographers 
before deciding the winners

The Casio Exilim Ex-Z30

Limited
memory in
cameras
belonging to
this price
range (sub-Rs
30,000) is
really sad,
because if the
camera is
used to
capture
images at the
best possible
resolution
the supplied
memory will
not last more
than 10
frames  
Mukesh
Parpiani
Photo Editor, 
Mid Day 

The slim Casio EX-Z30 has the biggest
LCD screen in its category
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good, making it convenient to
operate despite the weight.

The Sony model, with its one-
side-rounded design, stands out.
But the tiny icons on the screen
are a real strain for the eyes. The
button placement is good. The
flash is intelligently tilted
towards the lens to get sufficient
light on the subject.

How Did They Perform?
We tested the credentials of the
cameras at taking shots of
scenery. We shot a mountain for
the test. While taking the photo-
graphs, we selected the Land-
scape mode. For cameras that did
not come with Landscape, we
used the Auto mode. In Landscape
photography, the Nikon Coolpix
4100 fared better than the rest. It
showed good colour reproduction
and saturation. 

The Sony P73 returned a
slightly darker image, whereas
the Kodak CX7330 gave an image
that was a little brighter. The
Casio Exilim was a letdown. The
image was dark, while the colour
reproduction suffered heavily.

The Nikon Coolpix 4100 is the
ideal digital camera for shooting
in hill stations or lush valleys. 

In the Sports mode, we didn’t
come across too much variation
in image quality and finer
details. The Canon A75 and the
Nikon Coolpix 4100 were ahead
of the rest. We managed to cap-
ture a moving trailer as a still.
The text on the trailer’s con-
tainer was clearly visible without
any blur. 

The Casio, too, managed to
capture a moving vehicle, but
there was some blurring on the
photo. In some of the cameras,
such as the Kodak CX7430, the
shutter speed was not fast
enough. So, we managed to cap-
ture the back half of a fast-
moving vehicle, even though we
had released the shutter button
when the vehicle entered the
frame. It effectively means that
with the CX7430, you have to
anticipate and then shoot.

The D’zign returned an image
peppered with red, green and
blue dots. However, it managed to

capture the moving car we were
trying to shoot.  

The Portrait test was done
indoors in a sufficiently lit place.
The room was lit up with tube-
lights, and there were no incan-
descent bulbs. Despite this, some
of the images came across as shot
with lots of studio lights on. 

The Nikon Coolpix 4100,
impressed again, as skin tone was
captured perfectly, and so were the
colours. The flash of the 4100 cre-
ated excess brightness in the
centre of a frame. To negate bright
spots on the photo, we maintained
a distance of three to five feet from
the subject and made use of the
zoom. The Samsung Digimax 301,
too, gave us an impressive portrait
image. However, there were some
minor niggles in reproducing the
skin tone. Due to the powerful
flash, the 301 returned an image

that was really bright. The Canon
A75 impressed with its great
details, but the overall image had a
mild red cast all over. The photo
eventually needed quite a lot of
colour correction. 

The Orite VC-5000Z returned
an image similar to that of the
Canon A75. In fact, the red cast
was even more pronounced in
Orite’s image.

We also set up a test image
comprising a red motherboard. It
had lots of tiny and shining com-
ponents on it. Its CPU socket, the
PCI slot and the memory slots
were used to evaluate the details.
We also used boxes of software
(such as Windows XP Profes-
sional) to test the focus of the
cameras. The colourful nature of
such boxes along with the associ-
ated text made them an ideal for
the test. Once again, the Nikon
topped the list. Its images showed
wonderful colour reproduction.
When it came to details, it fared
much better than the rest of the

The Sony
P100 has the
superior Carl
Zeiss lens and
powers up
instantly. Its
compact
shape and
unique
design allows
for one hand
photography
without
problem  
Palash Bhaumik
Photo Editor,
Business India 

Shutter Speed Indicates how long the shutter
of the camera stays open to expose the
sensor. Higher shutter speeds are required to
take clearer still pictures of fast moving
objects, such as speeding cars or the wings of
a bee, which would otherwise show as a blur. 

For artistic photography, a blur is
sometimes required, for example a flowing
river or the trail left by the light of a firefly.
This is obtained by slowing the shutter speed.
Aperture It is the size of the opening in the
lens that decides the amount of light captured
by the film or sensor. 

A larger aperture (represented by a lower
f-value, for eg f/2) offers a shallow depth of
field. Focus is locked to the main subject,
causing anything ahead of or behind it to
appear out of focus. 

A smaller aperture (i.e. higher f-value, for
eg f/16) offers greater depth of field. This lets
you focus on objects which form the ambience
to your subject.
White Balance To a digital camera, a white
object might take on other hues depending
upon lighting conditions. This is not acceptable.
Depending on the light source, you can adjust
the white balance of a camera to ensure correct
reproduction of colours in the frame. 

Common settings are daylight, cloudy,
fluorescent (to be used for tube lighting), and
incandescent (to be used in bulb lighting).
Red-Eye Reduction A red-eye is caused when
flash-light reflects back to the camera, picking
up the red colour from the blood vessels in
the retina of the eyes. In Red-Eye Reduction
mode, the flash goes off multiple times,
causing the pupils of the eye to contract. The
photo is taken with the last flash, whose light
doesn’t reflect back the red of the eyes.
Burst Mode Also known as Continuous Mode,
this is the camera’s ability to take several
images in quick succession. How fast, how
many, and at what quality, depends on the
inbuilt buffer memory of the camera. Most
consumer digital cameras manage one to
three shots per second, while professional
ones score up to seven. Usually, the quality
increases with the decrease in the number of
shots, and vice-versa.
Electronic View Finder (EVF) An EVF is a small
LCD in place of the optical view finder that you
hold close to your eye. The EVF gets its image
through the lens. It is accurate and does not
suffer from parallax errors. Since it is
enclosed in a casing, it is usable even in bright
light when an LCD can be unreadable.

Jargon Buster
A red cast is prominent in this image
captured with Samsung’s Diigimax 370

The Orite VC-5000Z
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pack. The software box in the corner was well-
focused and the text was clearly visible.

The Orite VC-R500 and VC-5000Z returned very
crisp images with no unnecessary noise or colour
casts. The text in the corner was well-focused, and
the colours of the boxes, too, were quite impressive. 

The Samsung Digimax 370 was simply disap-
pointing. The image was out of focus and dark. The
red colour of the motherboard looked different, and
the small components just didn’t show up because
the image was out of focus. The Creative DC-CAM
3200Z, too, returned an image that was not up to the
mark, and the same was the case with the Olympus
Camedia C-310Zoom.

Extreme close-ups need lots of patience, stable
hands, and a focused mind. This macro test
required us to move back and forth to get a leaf in
focus. Casio’s clarity was simply superb at picking
up the tiny grains on the leaf. The Sony P73 was
also impressive. The Nikon Coolpix 4100 gave us a
hard time in getting the focus right. But our
perseverence paid off. The image it captured was
perfect. 

Final Thoughts
The 19 cameras tested in this category had, more or
less, the same specifications. Their prices ranged
from Rs 9,000 to Rs 20,000. 

Our tests made it obvious that you get what you

Macro shooting involves shooting objects up-close,
such as the nib of a pen or a flower petal. Most
digital cameras offer a macro mode, where the user
is needed to maintain a certain distance between
the camera and the subject. 

Maintaining minimum distance is necessary
because each digital camera has a limit beyond
which it cannot focus. This distance is mentioned in
the camera manual. It is usually 4 cm for entry-level
cameras. It is advisable to use a tripod, if possible,
and the LCD screen of the camera, instead of its
optical viewfinder.

As a rule, capturing small objects is difficult and
calls for some personal, quality time with a camera
before commencing the actual shoot. This will help
you gauge the distance that your camera can
operate best from. Play about with the manual
settings such as white balance, shutter speed,
exposure, etc.

Tips For Shooting Close-ups

1/2 pg V AD
The small grains on a leaf captured by Casio’s EX-Z30 in this
picture were no bigger than 0.5mm
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pay for in terms of image quality.
In terms of features, the Orite

VC-R500 and VC-5000Z were quite
decent, with good image quality.
The Kodak CX7220 was the
only camera that managed
an ideal balance of price
and performance. 

This camera returned
average results in most tests.
It has features such as 2.1X
optical zoom and 16 MB
inbuilt memory. It sells for
just Rs 9,500.

The Casio Ex-Z30 is very
compact, but the combina-
tion of low storage and
high price makes it more of
a flaunt-value gadget than
a daily-use camera.

Olympus, with its two
models, failed to make any

mark despite its low price
and decent features. It lost out

on performance.
The Nikon Coolpix 4100,

which won the Silver in our tests,
came up with some excellent
images, and it is very handy as
well. It is perfect when it comes
to ergonomics. The price is
slightly on the higher side, but
given the performance, it is
worth it.

The winner, the Sony P73,
returned good overall results. It
runs on rechargeable Ni-MH bat-
teries, and has a 16 MB Memory-

Stick. It is definitely a very sturdy
camera. The menu navigation is
the easiest to handle. It has pre-
defined modes such as Night and
Landscape. Given all that, at Rs
18,990, it is a good investment.

LESS THAN Rs 30,000
Features Galore!
When you are eyeing a camera
that costs over Rs 20,000, you
would obviously expect a lot of
features. Indeed, features were
brimming in this category. Some
cameras however, did manage to
surprise by offering quite a lot of
features.

The DX6490 was a surprise
entrant; it was akin to an SLR.
The Canon A80 also featured
with good optics, especially its
tilting LCD screen which allevi-
ates the twisting and contortions
associated with shooting at odd
angles. Ten cameras from five dif-
ferent brands made it to this cat-
egory. There were two models
each from Canon, 

Samsung and Sony, while
Kodak had three and HP just one.
The Kodak DX6490 was the
costliest contender at Rs, 31,900,
because of the 10x optical 
zoom lens.

The Nikon Coolpix 4100

OCTOBER 2004

The Sony Cyber-Shot P73
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What They Offered
Despite offering smart features,
cameras such as the Sony P100,
Canon’s IXUS IIs and the HP
R707 came in a very compact
form and were well supported
with good build quality. The
Sony P100 and the HP R707
impressed with their extremely
solid build quality. 

The Samsung U-CA 3 weighed
just 125 gms, followed by Kodak’s
LS743 at 165 gms. The Kodak
DX6490 at 380 gms and the
Canon A80 at 300 gms—despite
being heavier—have exceptional
ergonomics.

The Kodak DX7630 has a 6.2
megapixel support. With this,
the camera shot at a 2,872 x 2,160
pixel resolution, by far the
highest resolution. If you happen
to own an A3 photo-printer such
as the Canon i9950, then mar-
rying it to the Kodak is a good
prospect. Both the Sony models
and the HP R707 were 5.1
megapixel cameras. Although
the Canon IXUS IIs and Samsung
U-CA 3 offered just 3.2 megapixel
resolution, they were priced
higher than the Sony P100 and
the Kodak LS743, which had
better features.

As for optical zoom, nothing
came close to Kodak’s DX6490
and its 10X. For the motherboard

shoot, the zoom let us capture
the tiny metal contacts which
form the walls of a PCI slot on
the motherboard. The others
averaged at 3X optical zoom
except for the myopic 2X of the
Canon IXUS II. 

Manual focus is considered a
high-end feature for this category
and was, therefore, unexpected.
But the Canon A80 did offer it.
Manual focus gives greater con-
trol to the user when taking
extreme close ups. Even though
the manual focusing is controlled
electronically, it is not as precise
as it is in SLR cameras. 

The Canon A80 had the
shortest macro focus distance of 5
cm, followed by the Samsung V5,
which offered a 6 cm distance. The

5 cm, coupled with manual
focusing, makes way for won-
derful close ups and macros. The
HP had the minimum of 39 cm for
macro focus, which is too far from
the subject to capture details. 

An electronic view-finder is a
useful, power-saving feature that
is extensively used by profes-
sionals. EVF as it is known, also
helps in stabilising the camera
while taking photographs. Unfor-
tunately, only the Kodak DX6490
came with an EVF. The use of EVF
balances the high power-con-
sumption arising from constantly
adjusting the zoom.

ISO settings can do wonders
for the images, if used properly.
Higher the sensitivity, the better
the image quality and sharpness.
Higher sensitivity, however, asks
for lots of stability from the pho-
tographer and therefore ISO 400
and above should only be used if
the camera is either mounted on a
tripod or if it is resting on some-
thing. The Kodak DX6490 was the
only camera that offered high a
ISO setting.

Since these cameras offers
high-resolution images, you
need enough memory to store
them. From amongst the models

1/4 th pg  AD

Casio Exilim
Ex-Z30 is
compact with
a bigger LCD
than the rest.
However, the
camera tends
to get warm
if used
continuously.
This could
damage the
internal
electronics in
the long run 
Mukesh
Parpiani
Photo Editor,
Mid Day

Electronic View Finder

The Canon A80 is the only camera to
offer tilt-screen feature
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that we tested, 32 MB was the
highest available. The Kodak
DX6490 and the Sony P100 had
just 16MB storage, which holds
more than 10 images at their
highest image settings.

Battery life is also a concern
with these high-end beasts. LCD
screens, zoom lenses, video cap-
ture, auto-focus, all serve to drain
a battery faster. Re-chargeable Li-
Ion or Ni-MH batteries go quite a
way to solve the problem. The
Canon PowerShot A80 comes
bundled with non-rechargeable
alkaline batteries, even though it
needs four AA batteries. It was
the same case with the Samsung
V5, with two AA Alkaline bat-
teries. Sony sensibly included two
AA re-chargeable Ni-MH bat-
teries.

Bundled accessories make life
easier for you. For instance, the
Samsung U-CA 3 comes with a car
charger which is ideal while trav-
elling. HP bundled a separate USB
cable for PictBridge compliant
printers.

Except for the Kodak all other
cameras were PictBridge com-
pliant. The absence of the stan-
dard was a huge oversight on
Kodak’s part. Kodak cameras can
be cradled on to the Kodak
Printer Dock, a dye-sublimation
printer, but it should have sup-
ported a standard just like the
other cameras.

Were They Easy to Use?
Ergonomics is vital.  A camera
with tiny or ineptly-placed but-
tons is worth nothing at the end.
The Kodak DX6490 has a jog dial
to set different modes. The dial is
not very easy on the fingers, as it
needs good effort to just rotate it.
This was the only camera to have
an additional jog dial to change
the exposure mode, the shutter
speed or the aperture setting,
without taking the camera off
from the eye-level. The Canon
A80 has small buttons but has
enough breathing space between

them. Sony, with its rounded
contour near the lens, offers an
ideal design for two-hand opera-
tion.

The Kodak had the cleanest
menu navigation to offer—a
simple and linear style. Sony and
Canon cameras display icons that
will leave you rummaging the
manuals several times over. 

Presets are a God-send for
those looking for quick and easy
shooting. The Kodak DX7630 with
its 16 presets including Party,
Beach, Snow or Self-portrait, was
one such camera.

The Sony P100 is the fastest
camera of all when it comes to
starting up. The moment you
press the power button, the lens
is in place and LCD will show the
frame you have focused on, all
this in no time.

How Did They Perform?
For landscape photography, the
Kodak DX6490 impressed us
with its superior lens. The
camera managed to capture a
very lively picture with depth, as
well as, wide reproduction of
colour tones. The Sony P100 gave
an image quality as good as the
Kodak DX6490, but it lacked in
depth. The Sony DSC-W1 man-

aged to capture the scene clearly
in overcast conditions, which is
a commendable showing.

The Kodak LS743 lived up to
expectations with both light and
shadows clearly defined. The
good news in this particular test
was that none of the cameras
returned an image below accept-
able quality level.

Our next focus was on por-
trait shoots. The Sony P100
returned good skin tone as did
the HP R707. The HP, however,
had a flash that was unduly
bright in the centre of a frame.
Therefore, a portrait snap of a
person with glasses needed to
be taken with the camera
pointing slightly upwards, or by
maintaining a five to six feet
distance from the subject, and
then using the zoom. Both the
Canons returned good skin
tones. But, despite maintaining
the correct distance, the subject
was slightly out of focus with
the Canon A80.

The Samsung U-CA 3
returned an image that was on a
darker side, while a red cast was
prominent on the image taken
with Samsung V5. 

In the motherboard shoot,
the Kodak DX6490 dominated,
with amazing picture quality,
near-perfect colour re-produc-
tion, good small-detail repro-
duction, and great specular
effects. The camera also repro-
duced smooth gradation while
handling merging colour
shades. The Sony P100 managed
to shoot well but missed out on
colour separation, as the red of
the AGP slot almost merged with
the red of the motherboard. The
Sony showed one of the finest
gradations in shades.

Despite the studio lights, the
images taken by the Canon A80
turned out to be little on the
darker side. None of the elements

The Samsung Digimax U-CA 3

Telephone Web-siteCompany E-mailBrand

Contact Sheet

Canon
Casio
Creative
D’zign
HP
Kodak
Nikon Coolpix 3200
Nikon Coolpix 4100
Olympus
Orite
Premier 
Samsung
Sony

Canon India Ltd
J J Mehta & Sons
Creative Labs Asia
Wespro Corporation
Hewlett Packard India ltd
Neoteric Informatique
J J Mehta & Sons
Inter Photo India
Komal International
Mediatech India
Wespro Corporation
Samsung India Electronics Ltd
Sony India Ltd

011-26806572
022-24306356
9820357718
022-30916039
1600 11 4141
022-39828600
022-2430 6356
022- 24925151
022-22611274
022-26361111
022-30916039
011-51511234
1600 1111 88

Shyam@canon.co.in
info@jjmehta.com
murali_krishnan@ctl.creative.com
wespro@sify.com
seema.dawar@hp.com
sales@neoteric-info.com
info@jjmehta.com
info@interphotoindia.com
indiaolympus@vsnl.net
sales@mediatechindia.com
wespro@sify.com
sales@samsungindia.com
singhr@sid.in.sony.com.sg

www.canon.com
www.casio.com
www.creative.com
www.dzign.com
www.hp.com
www.kodak.com
www.nikon.com
www.nikon.com
www.olympus.com
www.orite.com.tw
-
www.samsung.com
www.sony.com
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The Kodak DX6490 captured detail as fine as tiny slots on
Memory slots
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within a frame, however, were
overly bright. The Samsung V5
gave us images that were sharp
and had excellent specular
effects. But the colour reproduc-
tion suffered because of a red-
dish-yellow colour-cast.

The silent Sony DSC W1 made
a lot of noise in the macro test. Its
Carl Zeiss lens captured a minute
bud, not more than a millimetre
in diameter. The focus was clear,
without loss of colour or detail.
The HP R707 also returned very
impressive close-ups of tiny thorns
on a young plant. 

The Kodak DX6490 managed
good macros but not without

effort. Focusing took some time,
though. A subject in motion
might cause pain while
this camera watches without
help. The other Kodak, of the
DX7630 moniker, however will
not give you a hard time. It
returned a clear image with
sharp focus. 

Final Thoughts
The Kodak DX6490 ended up as
the king in this category. It
offers a great optical zoom of
10X, and has a really big LCD
screen that helps during
recording and playback. Its EVF
feature, unique to the DX6490

The Kodak EasyShare DX6490

OCTOBER 2004

The Kodak
DX6490
ended up
winning
the Rs 20-
30,000
category

Sub Rs 20,000

Score Board

Note This scoreboard features results for the top 20 of the 29 digital cameras we tested. For the complete
table, please visit, http://www.thinkdigit.com/digicam.html

Canon
PowerShot A310
13.06
11.0x5.8x3.66
190
2048 X 1536
3.2
NA
NA/5.1x
N
5 to 20
Auto, 50, 100,
200, 401
7
1/1200 - 1
3
5
CF

32
JPEG
N
USB1.1
2.2fps
Y
AAx2
NA
Y
5.6
2.5
N
2.5
3.5
21.8

3
2
2
1.5
3

2.5
2.5
2
3
2
10
12,995
50.28

Canon
PowerShot A75
17.93
10.1X6.4X3.15
230
2048 X 1536
3.2
35 - 105
3x/3.2x
Y
5 to 46
Auto, 50, 100, 200,
400
6
1/2000 - 15
3
5
CF

32
JPEG
Y
USB1.1
2.2fps
Y
AAx4
Y
Y
5.9
3
N
2.5
3.5
21.8

3
2
2
1.5
3

2.5
2.5
2
3
2
7
18,995
52.35

Casio
Exilim Ex-Z30
14.75
8.7x5.7x2.3
125
2048x1536
3.2
35 - 105
3x/4x
N
6 to 50
Auto, 50, 100,
200, 400
6
1/2000 - 4
2
3
SD

9.7
JPEG
N
USB1.1
Na
Y
Li-Ion
Y
Y
6.1
2.5
N
3.5
3
22.2

3
2
2
1.5
3.5

2.5
2.5
2
3
1
6
19,995
49.43

D'zign
DZ-320
8.93
11x5x2.7
110
2048x1536
3.2 CMOS
44
NA/4x
N
60 - 130
Auto

4
1/1118 - 1/2
Na
5
SD

8
JPEG
Y
USB 1.1
1fps
Y
AAx2
N
N
5.3
2.5
N
2.5
3
21

3
2
2
1.5
2

2.5
2.5
2
3
1
14
9,000
49.40

Brand
Model
Features
Dimensions (LxWxD) cm
Weight (gm)
Maximum Image resolution
CCD Sensor (Megapixels)
Focal length (35mm equivalent)
Optical/Digital Zoom
Manual focus
Macro focus range (cm)
ISO settings

White balance settings (Nos)
Shutter speed range
Number of Metering modes
Number of flash modes
Memory types supported

Memory included (MB)
Compressed image format
Video out
External interface
Burst mode rate (frames per sec)
Movie capability
Battery form factor
Battery charger included
PictBridge (Y/N)
Ergonomics
Comfortable to hold (0-5)
Rubber grip
Menu navigation ease (0-5)
Comfortably sized buttons (0-5)
Performance
Details (Score out of 5)
Colour reproduction
Text
Details
Specular effect
Shading
Additional Tests (Score out of 5)
Landscape test 
Portrait test
Sport test
Macro test
Warranty Period (Years)
Price Index
Price (Rs)
Overall

Kodak
EasyShare CX7220
9.87
10.4x6.7x4.2
195
1632x1232
2
37 - 78
2.1x/2x
N
70
100, 200

Auto
1/3200 - 1/2
1
4
SD/MMC

16
JPEG
N
USB
2fps
Y
AAx2
NA
N
6.8
3
N
4
3
21.8

3
2
2
1.5
3

2.5
2.5
2
3
1
13
9,500
51.89

Nikon
Coolpix 3200
14.7
8.8x6.5x3.8
155
2048x1536
3.2
38 - 115
3x/4x
N
40
Auto

7
1/3000 to 4
1
4
SD

14.5
JPEG
Y
USB1.1
2fps
Y
Ni-MH AAx2
Y
Y
6.3
3
N
3
3.5
21.8

3
2
2
1.5
3

2.5
2.5
2
3
1
7
17,500
50.09

Nikon
Coolpix 4100
14.7
8.8x6.5x3.8
155
2288x1712
4
35 - 105
3x/4x
N
40
Auto

7
1/3000 to 4
1
5
SD

14.5
JPEG
Y
USB1.1
1.5
Y
Ni-MH AAx2
Y
Y
6.3
3
N
3
3.5
25.3

3.5
3.5
3.5
3.5
3.5

3
3
1.5
1
1
7
19,100
52.98

Orite
VC-R500
13.1
8.8x6x3.27
185
2560 x 1920
5
NA
3x/4x
N
NA
Auto, 50, 100, 
200, 400
6
1/2000 - 1/8
1
4
SD/MMC

9.7
JPEG
Y
USB
0.5
Y
Li-Ion
Y
N
6.8
2.5
N
4
3.5
21.4

3
2
2
1.5
3.5

2.5
2.5
2
3
1
8
16,495
49.94

Olympus
Camedia C-310 ZOOM
13.32
10.2x5.5x3.6
165
2048x1536
3.2
38 - 114
3x/3.3x
N
20 to 50
Auto

4
1/2000 - 2
1
4
xD-Picture card

16
JPEG
N
USB 2.0
0.5
Y
AAx2
N
Y
5.3
3
N
1.5

21.4

3
2
2
1.5
2.5

2.5
2.5
2
3
1
9
13,995
49.14



85OCTOBER 2004 DIGIT

Digital Tools l Test Centre

in this shootout, is also a
helpful feature. The Sony P100,
which came second after the
Kodak, is another attractive
proposition and one of a kind
with its lightning-fast startup
speed. The camera is very well
built and sports an unconven-
tional look. It is PictBridge-
compliant, and is therefore a
handy companion to take along
while travelling.

The Canon A80 put up a good
show in almost all the tests. The
picture quality was good, with
great detail reproduction and
excellent sharpness. It has an
auto-focusing problem, but once

The Sony Cyber-Shot P100

OCTOBER 2004

you get used to manual focusing,
the camera gets easy to handle. 

Both the models from Sam-
sung had good features, but
lacked in picture quality. Despite
good optics on paper, the cam-
eras did not fare well practically
and images reproduced by them
were found lacking in their
colour reproduction. Moreover
these cameras failed to capture
the finer details.

The Kodak DX6490 is correctly
priced at Rs. 31,900. If you are plan-
ning a grand holiday the Kodak
DX6490 is our recommendation.

aliasgar_pardawala@thinkdigit.com
mustali_kachwala@thinkdigit.com

Sub Rs 30,000
Sony
Cyber-Shot DSC-P73
16.36
11.7x5.4x3.6
236
2272x1704
4.1
39 - 117
3x/2x
N
10
Auto, 100, 200, 
400
5
1/1000 - 30
3
5
MemoryStick,
MemoryStick PRO
16MB
JPEG
Y
USB 2.0
1.7fps
Y
AAx2 Ni-MH
Y
Y
5.3
3
N
2.5
2.5
25.5

3.5
3.5
3
3
3.5

2.5
2.5
2
2.5
3
7
18,990
53.88

Canon
IXUS IIs
14.79
8.5X5.6X2.4
180
2048 x 1536
3.2
35 - 70
2x/3.2x
N
27 - 47
Auto, 50, 100,
200, 400
7
1/1500 - 15
3
5
SD

16
JPEG
Y
USB1.1

Y
Li-Ion
Y
Y
5.3
3
N
2.5
2.5
35.1

3.5
3.5
3.5
4
4

3.5
3.5
3.5
4
2
9
26,495
58.96

Canon
PowerShot A80
17.54
10.3x6.5x3.5
300
2272x1704
4
38 - 114
3x/3.6x
Y
5 - 45
Auto, 50, 100,
200, 400
6
1/2000 - 15
2
4
CF

32
JPEG
Y
USB1.1
2.2fps
Y
AAx4
N
Y
6.2
3
N
2.5
3.5
34.4

3.5
3.5
3.5
4
4

3.5
3.5
3.5
3.5
2
8
29,995
59.94

HP
Photosmart R707
17.83
9.6x6x3.5
226
2612 x 1968
5.1
39 - 117
3x/8x
N
39 - 117
Auto, 100, 200,
400
6
1/2000 - 16
3
5
SD/MMC

32
JPEG
Y
USB 2.0
3fps
Y
Li-Ion
Y
Y
6.3
3
N
3
3.5
33

3.5
3.5
3.5
3.5
3.5

3.5
3
3.5
3.5
257
8
29,995
58.84

Kodak
EasyShare LS743
15.73
108x30x49
165
2304x1728
4
35 - 105
3x/3.6x
N
5 - 100
Auto, 80, 100,
200, 400, or 800
4
1/1400 - 16
2
4
SD/MMC

16
JPEG
Y
USB
3fps 
Y
Li-Ion
Y
N
6.8
2.5
N
4
3.5
32.2

3.5
3.5
3.5
3.5
3.5

3
3.5
3.5
3
1
11
20,900
59.42

Kodak
EasyShare DX6490
25.38
10x8x8.1
380
2304 x 1728
4
38 - 380
10x/3x
N
12
Auto, 80, 100, 200,
400, 800
4
1/1700 - 16
3
4
SD/MMC

16
JPEG
Y
USB
3fps
Y
Li-Ion
Y
N
7.4
3.5
Y
4
3.5
35.5

3.5
4
4
3
3.5

4
3.5
3.5
4
1
8
31,900
68.41

Kodak
EasyShare DX7630
16.82
10x6.9x4
270
2872 x 2160
6.2
39 - 117
3x/3x
N
7
Auto, 100, 200,
400, 800
3
1/1400 - 64
3
4
SD/MMC

32
JPEG
Y
USB
2fps
Y
Li-Ion
Y
N
7.1
3.5
Y
4
3
34.7

3.5
4
3.5
3.5
3.5

4
3.5
3.5
3.5
1
8
30,900
59.30

Samsung 
Digimax U-CA 3
16.02
10.2x5.38x3.16
125
2048x1536
3.2
38 - 114
3x/3x
N
30 - 80
Auto, 100, 200,
400
6
1/2000 - 2
2
5
MemoryStick
Duo
32
JPEG
Y
USB1.1
0
Y
Li-Ion
Y
Y
6
2.5
N
3
3.5
26.00

3
3
3
2.5
3

3.5
3
2
3
1
9
25,995
53.15

Samsung
Digimax V5
15.41
10x5.46x3.8 
185
2560x1920
5
38 - 114
3x/4x
N
6 to 30
Auto, 50, 100,
200, 400 
7
1/1200 - 16
2
5
SD/MMC

16
JPEG
Y
USB1.1
0.5fps
Y
AAx2
No
Y
6
3
N
3
3
27.00

3
3.5
3.5
3
3

3
2
3
3
1
8
29,995
51.91

Sony
Cyber-Shot W1
18.5
9.1x6x3.6
250
2592 x 1944
5.1
38 - 114
3x/2x
N
10
Auto, 100, 200,
400
5
1/1000 - 30
3
5
MemoryStick,
MemoryStick PRO
32MB
JPEG
Y
USB 2.0
1.6fps
Y
AAx2 Ni-MH
Y
Y
5.6
3.5
N
2.5
2.5
28.00

3
3.5
3.5
3.5
3.5

3
2.5
2.5
3
3
11
20,990
59.23

Sony
Cyber-Shot DSC-P-100

18.23
10.8x5.2x2.6
183
2592 x 1944
5.1
38 - 114
3x/2x
N
10
Auto, 100, 200, 
400
5
1/1000 - 30
3
5
MemoryStick,
MemoryStick PRO
16MB
JPEG
Y
USB 2.0
1.6fps
Y
AAx2 Ni-MH
Y
Y
5.3
3
N
2.5
2.5
31.00

3.5
3.5
3.5
3.5
3.5

3.5
3
3.5
3.5
3
11
20,990
62.67
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I had two
options: The
first was to visit
the Tirupati
temple on the
Tirumala Hills
for darshan and
offer pooja
there. The
second was to
visit a
devotional Web
site, and go
through the
darshan and
pooja—entirely
online. Here’s a
quick look at
how I went
about the two
contrasting, yet
interesting,
tasks

Tirupati Temple Darshan

At Borivli, a suburb in Mumbai, I spent Rs 30, and
90 minutes in the queue to book a ticket to
Chennai. That’s Rs 684 for the tickets. Next, Rs 100
and four hours of travel to get to Cuffe Parade to
set up accommodation in Tirupati. Make that Rs
750 in room charges for the 3-day stay.

Visited the Web site eprarthana.com, which offers
services for online pooja. Took a mere five minutes
to browse to the site. I had to register first so I
could proceed with the e-darshan and the e-pooja.
That took 10 minutes.

The train journey took me 22 hours, not to
mention miscellaneous expenditures of Rs 200.
Hey, wait! I forgot about the return journey, so all
the above prices and times have to be multiplied
by two.

I rummaged through innumerable temples and
poojas. Finally, I found the Balaji temple at Tirumala.
The next step was as simple as just clicking on an
‘Offer Pooja’ button. I got a visual tour of the temple
and its history. The charges: Rs 275. It took me about
15 minutes.

I settled for a credit card transaction as the mode
of payment. The site offered me a transaction
identification, and added the pooja I selected to
my ‘Pooja Cart’, and I was done! Add another five
minutes for that.

It all cost me just Rs 275. As simple as that.

My Condition: There’s nothing to complain about when
offering pooja online, as long as you are aware that this
is in no way the real thing.

Whew! The entire episode cost me good money—Rs
684 for the tickets, Rs 750 for the stay and Rs 930 in
sundry expenses. 

My condition: Exhausted and cash-strapped, but a
worthwhile trip nonetheless.

A view of the Balaji temple on Tirumala Hills The home page of Eprarthana.com

1

2

3

4

When it comes to convenience and cost, the tech
way wins hands down. Travelling all the way to

Tirupati, waiting in long queues, and then doing it
all over again to come back home, is a tiring affair

indeed. I also had to take four days leave from work!
However, the ambience and fulfilment after visiting
the temple are unsurpassed. The tech way will
never be able to replace the old way here.

OLD
WAY

TECH
WAY

Total Time Spent: Four days
Total cost: Rs 2,364

Total Time Spent: 35 minutes
Total cost: Rs 275

And 
The

Winner
Is...

Rupesh Sreedharan (rupesh_sreedharan@jasubhai.com)

On Sunday evening, I got hold of the arm-tag from
the temple authorities. The darshan was on Tuesday
morning. Another queue, another three hours.
Finally, I get the much-awaited glimpse of Lord Balaji.
Don’t forget the Rs 400 I spent on sustenance
throughout the trip.



Lasts Long, Sounds Good

With 128 MB of flash storage, the Transcend MP3 Player combines a
voice recorder, a USB flash drive, and an MP3 player. It offers good

audio output, with few distortions.
Both preset equaliser modes and an
LCD screen are absent. The single
AAA alkaline battery lasts 11 hours—
enough for your daily commutes.

Company Mediaman Infotech Price Rs 5,000
Phone 022-23828100  Fax 022-23877418
Web site www.transcendusa.com

88

It Debugs, And It’s No Bunny

The RPTech Debug card monitors port 80 of a system’s motherboard
and offers two, 8-segment LCD to a system administrator or an

assembler. To debug, the sys admin can read off the LCD and consult a
supplied manual to hunt down the error. The DR-10 is a tiny PCI-based
card that monitors routines until the BIOS’s job is done. It
supports AWARD, PHOENIX and AMI BIOS. But the
manual only includes POST-codes for AWARD
and AMI bios. The card comes with
a one-year warranty.   

Company Rashi Peripherals
Price Rs 2,000 
Phone 022-28260258 
E-mail ho@rptechindia.com 
Web site www.rptechindia.com

Smallest, Lightest, Wow!

Of the seven notebook models
recently launched by

Zenith, the Presidio is the top-
end model. It’s the smallest and
the lightest of the lot. The
Presidio comes with a dark-grey
casing, and is powered by the
Centrino platform. It includes a
1.5 GHz Intel Mobile processor
with 2 MB of L2 cache. The
notebook sports a 12.1-inch
screen, 256 MB DDR RAM and a
40 GB hard drive. 

Apart from 802.11b Wi-Fi
capability, you also get three
USB 2.0 ports and a FireWire
port. Other ports available are
Audio-out, microphone,
modem, 10/100 Ethernet, and a
VGA port.

Weighing in at just 1 kg, the
Presidio offers decent

performance and usability in an
ultra-portable form factor—a
key requirement of its intended
audience. The great features
apart, the price tag makes the
package even more attractive.

Company Zenith Computers
Price Rs 70,000 plus taxes
Phone 022-28377300
Web site www.zenithpc.com

Transcend JetFlash MP3 Player And Voice Recorder

Quite N-Gaging

The new “improved” N-Gage QD plugs most
of the leaks in the older unloved N-Gage.

Namely, the nefarious side-talking concept
and the inability to swap game cards while
the deck is powered on. The QD shrinks to a
more compact, grip-friendly shape-an
important aspect for hand-held gaming. 

While most games are rather enjoyable
on the deck, the hard-plastic joypad did prove
a little uncomfortable after extended hours
of shooting and racing. SMSing takes a new
learning curve due to the cramped keypad
design. The deck has no radio or camera, but
that’s what pulls the MRP down to an
affordable Rs 11,599 (although most dealers
across India sell it at much lower prices),
considering that the N-Gage QD is also a
smart phone with Bluetooth support. Despite
what they say about MP3-support, you can
play them on the QD!

Company Nokia India Ltd.
Price Rs 11,599
Phone 011-26779000
Web site
www.nokia.co.in

Zenith Presidio

RPTech Debug Card DR-1.0Nokia N-Gage QD Game Deck
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Thumping Sound, No Noise

The Bose Noise Cancellation
2 is surprisingly low-
impedance. You don’t need

a headphone amplifier for great
sound. Plug it to a portable
player, your computer’s sound
card, or any other device. You
can select the input level on the
phones accordingly.

The sound is good and lively.
However, without an equaliser,
the bass refuses to thump, and the
highs aren’t vivid. The mid-
frequencies are emphasised, which is
not a bad thing if you are primarily
listening to vocal tracks. But it really hurts
if you want to use the phones, for say, classical music.

These are closed-ear phones—you don’t get the open ‘speakers’ kind
of sound that you get with high-end Sennheisers.

The set has a noise-cancellation feature, and that’s where you are
spending your money on. We don’t know if it was the noise-cancellation
or the excellent earpads, but we couldn’t hear a squeak from elsewhere
once the phones were on. Good stuff! 

There’s no limit to the volume these phones can take the highs and
lows to without distortion. One glitch though, when the phones get too
much bass, the volume goes down. The volume shoots up  again when
the bass goes down.

The bottomline? These are not audiophile-quality phones, and you
will be better off investing on high-end Grados or Sennheisers. Or in-the-
ear noise-reducing phones such as those from Etymotic, if you are hell-
bent on noise-cancellation.

Company Bose Corporation India Private Limited
Price Rs 21,900
Phone 011-2307 3825
E-mail nandita_sood@boseindia.com
Web site www.boseindia.com

Bose QuietComfort 2 Acoustic Noise Cancellation Headphones

Samsung Yepp Sports YP-60

Intel D925 XCV Motherboard
This LGA775 socket motherboard, based on
the i925X chipset, supports the latest
generation of Pentium 4 processor. 

It support for DDR2 533 MHz memory and
PCI Express X16 graphics slot. An onboard
high-definition audio sub-system pumps
out quality music when
hooked up to a seven-
speaker system. 

Gigabit Ethernet,
two PCI Express X1
slots, and eight USB 2.0
ports offer great speeds
and expandability. 

Company Intel
Web site www.intel.com

Time for Healthy Music
All gadgets are headed for convergence. It’s only natural to marry two
more devices of utmost importance while working out. A portable music
player and a calorie/heart rate monitor. The Samsung Yepp Sports YP-60 is
a featherweight 256 MB MP3/WMA/FM player that records music or radio
to MP3s, and can strap onto your arm. The bundled, and not-
quite-easy-to-use Yepp Studio application lets you transfer
music from your computer on to the player via a
USB cable. The calorie/heart rate monitor and
stopwatch, together with the Fitness
Studio software, helps you burn
calories the right way. At Rs
15,995 though, it’s more
likely to burn a hole in your
pocket!

Company Samsung Electronics 
Price Rs 15,995 
Phone 022-23810713
E-mail sales@samsungindia.com 
Web site www.samsungindia.com

Please write to products@thinkdigit.com. The DIgit Test Centre will be delighted to
respond to your queries.

Looking For More Information On Any Of The Products Featured In New & Notable?

Gigabyte GV NX53128D Graphics Card 
It is the first PCI-Express X16 graphics card
we tested. Based on nVidia’s FX-5300 graphic
core, it is not very powerful. DirectX 9
compliance gives gamers a
decent resolution.

After tucking the
Gigabyte in the X16 slot of
the Intel D925XCV
motherboard, supported by
the 3.6GHz processor, we
ran our usual tests. The
card performed quite
well, and surely falls in
the same league of cards
based on the FX-5200. 

We ran DOOM 3 on it—
the acid test. It runs DOOM 3 at an 800 x 600
resolution and medium details—good choice
for casual gamers.

Company Digi Giga Systems
Price Rs 6,500
Phone 022-26526696
E-mail sales@digigiga.co.in 
Web site www.gigabyte.com.tw

Intel Prescott 3.6GHz Processor 
Clocked at 3.6GHz, Intel’s new chip is based
on the LGA 775 platform. It is meant for the
915 and 925 chipset-based motherboards that
will hit the market by this December.

Installing the processor is as simple as it
was with the Socket 478 ones. With the pins
now transferred to the motherboard, the
motherboard socket surely needs better care
and handling.

We plugged the processor onto Intel’s
D925XCV motherboard with 533 MHz DDR2
memory and a FX5300 PCI-E card. But, the
higher the clock speed, the more is the heat.   

When it came to performance, it cruised
in most of our tests. The performance boost
ranged from
six to 10 per
cent. 

Company Intel
Web site
www.intel.com
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Problem With Memory Slot

I have an Intel 815e motherboard
with a PIII 866 processor in my

system. It has three SDRAM DIMM slots.
I have three 128 MB SDRAM sticks
running at 133 MHz. When I insert the
third module in the third slot, my system
stops working.

The BIOS self-test loops and my
computer refuses to boot any further. I
have verified that all three memory
modules swap and work individually.
Why is this happening?

P Kumaravel

It is likely that the problem lies in a faulty
memory slot on the motherboard, consid-

ering all three memory modules are working
individually. Check for dust inside the memory
slot and clean it, then install all three
modules. If they fail to work, your third
memory slot is faulty and your motherboard
needs to be repaired.

If the three modules were working together
earlier, then the problem is definitely the
motherboard’s slot. If they were not, then the
three 128 MB modules may not be all actually
running at 133 MHz. This problem crops up if
you mix a 100 MHz module with a 133 MHz
module. One of the modules may be a 100 MHz
one—try replacing it with a 133 MHz module.
You can identify where exactly the problem is
by inserting the modules in pairs, in the two
slots that work.

Computer Hangs While Online

I have a PIII 933 MHz processor with 128 MB
RAM, running Windows ME. Whenever I try to

go online, an error appears on a blue screen that
says, “Windows protection error. You need to
restart your computer. System halted.” But it
doesn’t happen when I am offline. What do I do?

Shivkumar

Your computer is infected with the Blaster
worm. The worm shuts down the machine

whenever you connect to the Internet, which is
why nothing happens when you are offline. To
secure your PC, download the Blaster removal
tool from  http://securityresponse.symantec.
com/avcenter/FixBlast.exe and run it on your
system to remove the worm. If you have anti-

virus software, update the virus definitions. If
you don’t have one, install it from the Digit
DVD. Also, visit this link and patch your oper-
ating system: http://www.microsoft.com/down-
loads/details.aspx?FamilyID=e70a0d8b-fe98-493f-
ad76-bf673a38b4cf&DisplayLang=en. 

Cannot Read CD-ROM Discs

I have a Pentium 4 2.0 GHz processor on a
Mercury motherboard with 256 DDR SDRAM

and a 52X LG CD-Writer, running Windows XP
Professional running. For the past few days, the PC
restarts when I insert a CD. But this doesn’t
happen every time. Is this a Windows problem, or
has it got to do with the hardware?

Bhushan Thatte

If your PC restarts every time you insert
CD-ROM disc, then something is wrong

with the hardware. Try reading your disks on
other CD-ROM drives. If the other drives work
fine, then clean your lens using a drive-clean-
ing disk. If the cleaning disc does not do the
trick, it is time you upgrade to a new optical
drive. We recommend that you get a CD-Writer
and DVD ROM combo-drive. 

Monitor Display Goes Red 

I have a weird problem with my monitor.
When I switch on the system, the screen goes

red. The red display shows for about 10 minutes,
after which the screen returns to normal. My PC is
an HCL Beanstalk with a 17-inch monitor
(HCM780M). How can I solve this problem? My
operating system is Windows 98SE.

Nishant Paul

This isn’t a unique problem. It happens
during the monsoon, when the humidity

is very high. It also occurs if the monitor’s
colour chip malfunctions. To avoid this prob-
lem, keep the monitor covered with dust
covers throughout the rainy season. If the
problem persists, contact HCL’s service centre.

BloodHound Virus Removal

My computer is infected with the
BloodHound.W32.EP virus. I have Norton

AntiVirus installed, but it is unable to repair the
c:\windows\system32\tftp8636 file. Norton says
that the access to the file is denied. What is this file
and will it harm my computer?

Another problem is, when I type in Outlook
Express or in Microsoft Word, it automatically
adds some words. The icons for cut and paste keep
flickering all the time. I simply can’t type anything
and the cursor moves all over and adds words.
Does the BloodHound virus have anything to do
with this? 

C V Padmanabhan
Norton AntiVirus definitions prior to May
1, 2002 may detect the presence of a

W95.CIH variant as Bloodhound.W32.EP. You

E-mail us your 
computing problems,
and we may answer
them here! Since we get
more mails per day than
we can handle, it may
take some time for your
query to be answered.
Rest assured, we are 
listening!

sos@jasubhai.com

Your Questions, Our Answers

Ill
us

tr
at

io
ns

 F
ar

za
na

 C
oo

pe
r



91OCTOBER 2004 DIGIT

really need to update your
antivirus right now! Remove
the virus using the Kill CIH
tool. Download it from:
http://www.symantec. com/
avcenter/kill_cih.html

The tool actually disables
the virus from the memory.
After CIH is “killed”, update
your antivirus definitions and
run a full system scan. The
infected files will get removed
only after this.

The flickering problem
with Outlook Express or MS
Word may not be directly
caused by this virus. In any
case, update your antivirus
and try again!

Cannot Format 
Hard Disk

I have a 40 GB Seagate hard
disk with Windows XP,

which has stopped working. A hard disk utility
recognises the hard disk and shows the partitions.
I can delete partitions or create new ones, but
when the system restarts, the previous partitions
reappear. I have done a low-level format, but the
problem persists. What should I do?

Prashanth Siddapur
Bangalore 

It seems the Master Boot Record (MBR) area
of your hard drive has a bad sector. To tackle

this problem, download Disk Manager 5. Use the
Advance option to format your hard drive.
Instead of size, use cylinder numbers to create a
partition. Leave alone the first eight to ten cylin-
ders and start from cylinder number 11 or 12 to
create partitions. If this doesn’t work either,
you’ll need to replace the hard disk. If you
continue using the hard disk, take regular back-
ups of all your data.

Backing Up E-mail

My hard disk has developed bad sectors.
Before replacing them, I want to take a

backup of my Outlook Express files. Please help
me out with all the steps required to do it.

R. Siva Kumar

First, you need to back up both your e-
mails (.DBX) and address book (.WAB).

Follow these steps:
To back up your e-mail Outlook Express, go to

Tools > Options > Maintenance. Under the
Maintenance tab, locate the Store Folder button
and click on it

This will open a dialog box showing the
path where your .DBX files are stored

Copy this path and close the Tools window.
Click Start > Run, paste the path and press
Enter

The new window that opens will show

multiple .DBX
files. Copy all of
them

Create a new
folder and name
it appropriately,
such as “Mail
Backup.” Here,
paste all the
.DBX files, then
close the folder

To back up your
mail:

In Outlook
Express, go to File > Export > Address Book

In the window that opens, click the Comma
Separated Values check box, and then select
Export

Click Browse and locate the Mail Backup
folder made earlier (while backing up your e-
mail). Save your address book as an Address
Book Backup with an appropriate name, then
click Next

In the Window that opens, check the fields
that you think need to be backed up. Click OK
and then click Close.

Computer Won’t Hibernate

I have Windows XP Professional running on an
Intel Pentium 4 2.4 GHz processor. After a re-

install, I face several problems. Whenever I shut the
PC down, the system restarts automatically without
any error messages. In the shutdown dialog box, the
Standby option is disabled. And in the Power
Options on the Control Panel, the Hibernation tab is
missing! 

Also, when I open the registry editor, it stops
responding. What could be the problem? I don’t
want to reformat my hard disk.

Swarup

Can’t Open PageMaker Files 

Without any apparent reason, some  PageMaker 7.0
files on my D: drive were corrupted. When I try to open

these files, I get this message: “Cannot open file format not
supported…”. How do I solve this problem?

greyblue86@yahoo.co.in

Create a copy of any of those corrupt files, and open them
using File > Open in PageMaker itself, instead of double-click-

ing the files. 
Secondly, PageMaker stores information like plug-ins, features,

etc. in a preferences file called PM70.cnf. This file is located in the
Program Files\Adobe\PageMaker 7.0\Rsrc\Usenglsh folder. Exit
PageMaker and rename this preference file. Now, restart PageMaker
7.0 and it will re-create the same. 

The file will not open if the graphic link is corrupt. The graphic
link actually links you to the graphic stored on the hard drive. To
work around this problem, move the graphic to some other loca-
tion on the hard drive. Now, try opening the copy. If it opens
correctly, use the Link Manager in PageMaker to restore the graphic
link from the new location where graphic was later stored. You can
also try Symantec Norton utilities for restoring corrupt files. Find
all this at http://www.symantec.com/sabu/sysworks/basic/

Question 

of the

Month

Obtain th e path to your e-mail
folder from this dialog box
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How to...

Organise Your Digital Photos
If you own a digital camera or a

scanner, chances are you have loads
of pictures on your hard drive. You

spend most of your time hunting for a
specific file from your collection. Get
rid of this tedious process of rummag-
ing through your hard disk using a
simple tool such as Adobe Photoshop
Album. It sorts, stores, retrieves, and
scans your photos.

What Does It Offer?
Photoshop Album organises photos
according to the time at which they
were taken. It doesn’t matter if the
pictures are strewn across your hard
disk across numerous folders. It also
imports photographs from various
sources such as digital cameras or
scanners. You can organise your
photos and present them as a cata-
logue, an album or a slideshow. 

Photoshop Album can
make a video-CD or a
calendar out of your
photos. It even groups
the photos into audio
and video clips. You
can perform minor
edits on the digital
images, such as adjust-
ing the brightness, or doing
colour correction, using the tools that
come with Photoshop Album.

How Do I Use It?
Organise your photos as albums,
slideshows, video-CDs, greetings, e-
cards or calendars. Once you start
Photoshop Album, a quick guide pops
up that can gather your photos from
various sources. Navigate to Get
Photos on this window and browse for
the source of your images—hard drive,
scanner, camera, CD or mobile phone.
You can also click on File > Get Photos
to do the same, or click on the Get
Photos button placed at the bottom
the main menu. 

If you want to alter the lighting,
colour or sharpness of any image,
simply select that image and click on
the Fix button on the main menu. Then
select the option Fix Photo. Here, you
can edit and apply changes to your
photo. There is a preview box that
shows all the relevant changes. 

You can choose to see your photo
collection in any of these three views-
Photo Well, Organize and Calendar.
You will find these view options on the
View menu.

Photo Well view shows all your
photos with the date and time they
were created. You can choose to turn
these details off on the Section
Details, at the bottom of the screen.
This view comes with a zoom-slider,
also at the bottom of the screen,
which helps you enlarge or reduce the
size of the thumbnails.

In the Organize view, photos can
be tagged and categorised as People,
Places, Events, and Others. A tag will
link a photo to a pre-defined category.
All similarly tagged pictures will be
stored in the same category. 

The Calendar view shows you a
calendar, by month or year. It

also colour codes dates under
which a photo is found in

your collection. The
calendar can be
changed to a Month or
a Day view. 

To create an
album, select the
photos and click on
the Create button

just below the main menu, or go to
the Creations menu. Next, choose the
option that you want to create. In
Creation Wizard, you will find six
steps to finish the task. Here, choose
a pre-defined template of presenta-
tion, then put a title and all the infor-
mation it asks for. After this is done,
the final screen gives the option of
publishing your collection as a PDF
file, print it, e-mail it or burn it to an
optical disc. You can preview the
presentation and customise it. Once
done, the Creations Wizard saves the
file. Saved creations will be placed in
the Photo Well view along with all
your photos. These are identified
with a creations icon.

Show Off
Photoshop Album fulfils the need of a
photo viewer, an organiser, a presen-
tation maker and a CD-creator—all in
one easy package. Managing photos
with this software is really easy. Let
alone creating albums and slideshows,
you can even convert your photos to a
movie clip and enjoy it on TV!

Avinash Rai
avinash_rai@thinkdigit.com

Find Adobe Photo Album and
Picasa on this month’s Digit DVD

See DVD

Select the source from where you want 
to import your photos

The Photo Well view shows you the pictures with the
date and time of when they were created

With the Creation Wizard, you get to choose a
template and add a title

Finally, you can save the album as a PDF, print, 
e-mail, or even burn it onto a CD
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Since you are using a Pentium 4 processor,
it is likely that your motherboard supports

advanced power saving features. Therefore, you
need to update the motherboard drivers, assum-
ing you had installed them earlier. If you
haven’t, install them now! Restart your PC after
the drivers are installed. This should solve your
problems.

The registry editor may not be working
because of a data corruption of either the
regedit.exe or some other support file. We
suggest you re-install the operating system from
a different medium. Go to the Administrative
tool on the Control Panel, check the Event
Viewer there to scan the log. In this way, you can
identify the problem associated with restart.

Missing Memory

I have an Intel Celeron 2.4 GHz processor, with
an on-board 32 MB S3 Graphics ProSavage

chipset with 256 MB RAM. But in both my OSes, the
System tab in the Control Panel shows 224 MB of
RAM instead of 256 MB. How can I resolve this? 

Abhay Rana

Your video system is on-board, and is using
32 MB of your system’s 256 MB memory as

graphics memory. 

Can’t Boot

I have a PIII 800 MHz PC with 256 MB SD RAM
and two 40 GB hard disks. My computer shows

my partitions as follows: C: Samsung primary; D:
Seagate primary; E: and F: Samsung extended; G:, H:
and I: Seagate extended; J: CD-ROM. I have set up
the Samsung as the primary master and the
Seagate as the primary slave. I have installed
Windows 98 on C: and XP on E:. When I removed my
second hard disk, I couldn’t boot into XP, as the E
drive swapped with D. What should I do?

Purujit Deore

This is happening because the settings in
the boot.ini file are no longer correct, now

that you have removed the Seagate drive.
What you can do is edit boot.ini. To do this in

Windows 98SE, click Start > Run, then type cmd
and press Enter. In the command prompt, type
CD\ and press Enter. Now type Edit boot.ini and
press Enter again. 

This will open the boot.ini file, which will
display partition information as shown in the
screenshot. Here, you need to locate the
Windows XP partition string. It looks like this: 
multi(0)disk(0)rdisk(0)partition(1)\windows=”Mic
rosoft Windows XP Professional” /fastdetect.

Take the digit next to the partition tag;
subtract 1 from it, and save the file. You should
now be able to boot into XP.

Of Bandwidth And Servers

I have a Reliance FWP (fixed wireless phone). I
want to connect 20 PCs to this phone, 12 of

which are Intel Pentium 4-based while the remain-
der are Pentium 3-based. I have six computers on
the ground floor, six on the first floor, and eight on
the second floor. The Reliance FWP has an inbuilt
modem offering 115 Kbps of speed.
1. How do I make all the PCs run at 115 Kbps?
2. Does the length of the cable affect the speed of
Internet browsing and downloading?
3. What is a server?
4. Can a phone with an inbuilt modem act as a
server?
5. What are the components that I need to buy to
connect all the computers effectively?

Krishnan

1. Computers sharing Internet connectiv-
ity provided by FWP can’t go to 115Kbps.

Even a single PC that connects at a supposed
speed of 115Kbps doesn’t offer more than
15Kbps.

2.  The length of the cable must not exceed
1.5 metres for a CAT5 cable. Performance drops
drastically as the length increases.

3. The FWP cannot act as a server.
4. To connect 20 computers spread over

three floors, you need a Network Switch or
Hub. One of the PCs will have to run WinProxy
or some other Proxy server. Ideally, you need
three network switches, one for each floor.
This will shorten the length of cable running
from the switch to the client system. 

This dialog box lets you enable or disable hibernation

Locate the Windows XP partition entry in boot.ini 
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popular formats has its advan-
tages. When you copy something
in Konqueror, it can be pasted
using the browser itself. So there

is no need to launch a separate
application. An example will
make it clear. 

Say, you have copied a passage
of selected text using [Ctrl] + [C].
Next, browse to the destination
folder and press [Ctrl] + [V] to paste
that text as a new file. You can
handle images in the same way.
Simply press [Ctrl] + [Print Screen],
and do a [Ctrl] + [V] to paste the
image as a PNG file.

The best feature of the brows-
er is the Navigational Panel on the
left of Konqueror. Here, you can
frequent favourite locations via
the Bookmarks tab. To add a fold-
er as a bookmark, press [Ctrl] + [B]
while browsing it. You can even
browse your local or remote net-
work via the Network tab. Inter-
estingly, you can add a Web URL
to the Panel. Simply do a right
right-click, and go to Add New >
Web SideBar Module.

Kopete 
kopete in Run window
INSTANT MESSENGER
Kopete is the Instant Messenger
client for KDE. It supports popu-
lar networks such as MSN Mes-

senger, Yahoo! Messenger, ICQ,
and IRC. It can even send SMS
messages to cell phones. Click on
Settings > Configure Kopete, then
select Accounts, and click on New
to add a new network.

To change Kopete’s look to
make it look more familiar, click
on Settings > Configure Kopete,
and then on the Appearance tab.
Here, under the Chat Window
tab, select the MSN style. The
Emoticons tab lets you select an
emoticon set of your choice.

Kopete supports a plug-in
architecture. To configure avail-

able plugins, click on Settings >
Configure Plugins. You can
encrypt your outgoing messages
with a personal PGP key. Some
interesting plugins are Auto
Replace, Highlight, History and
Web Presence. The last one lets
you synchronise your online pres-
ence with your personal blog or a
Web site.

Desktop Sharing 
krfb in Run window 
REMOTE DESKTOP CONTROL
Desktop Sharing lets you share
your current session under Linux
with a user on another machine.
The remote user can use a VNC
client to view or even control
your desktop. This comes in
handy for a remote presentation,

Ahmed Shaikh

ith more than 3,000 soft-
ware packages, a GNU/
Linux distribution liter-

ally opens the floodgates to free
software. More often than not,
you will find yourself stuck
knee-deep in badly-written pro-
grams, struggling to cope with
frequent crashes. 

We took a fine-tooth comb to
a SuSE 9.1 Professional distribu-
tion, which had everything
installed, and separated the good
from the bad. Here, we will only
stick to KDE and its associated
applications.

NOTE: We tried to avoid the
KDE menu structure. The idea is
to simplify things. To launch a
program, click on Run on the
KDE menu and type the command
specified. Note that these
commands are case-sensitive.

Konqueror
FILE MANAGER
Let’s start with the File Manager.
Since we are dealing with the
KDE environment, Konqueror is
the application in charge.  

Konqueror can open a bevy of
files by default. Text, images,
PDFs, icons, movies, audio files…
the list goes on. 

Konqueror will insist on
opening them within its window,
instead of launching the associ-
ated application. To change this
behaviour, click on Settings > Con-
figure Konqueror, and click on
File Associations. 

The window on the right will
let you change associations or
instruct Konqueror not open a
file itself. Find this under the tab
Embedding on the Left Click
Action pane.

Of course, inbuilt support for

W

Making Sense of
LINUX A typical Linux installation is an

embarrassment of software choices.
We bring order to the chaos 

You can change the way Konqueror
handles files here

Giving Kopete a familiar MSN look

Launch
applications from
the Run command 
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across on refrigerators. The notes
get saved automatically once you
exit the program. When you open
the program again, the notes that
you were working on last time,
will show up. A note, once creat-
ed, gets automatically assimilat-
ed within the Kontact program,
which we will discuss in a while.

To print or e-mail your notes,
just right-click on the title bar of
any of the notes and select the
appropriate option.

You can customise the display
features of the notes. Do a right-
click on the title bar, select Pref-
erences, and adjust the colour,
font, etc. To make changes to each
note, right-click on the KNotes
icon on the KDE taskbar.

Kontact 
kontact in Run window
Personal Information Manager
A Personal Information Manager
lets you maintain  a central repos-
itory of vital information neces-
sary for communication in an
office environment. 

A typical PIM, for example,
lets you manage e-mail IDs, postal
addresses, photos, birthdates,
anniversaries, Web site URLs, etc.
You can use the PIM to schedule
events and add members of your
team as participants or overseers.
As the event nears completion,
the members will be sent timely
reminders. A person in-charge
can keep all the-members updat-

ed on the percentage of progress
of the event.

Kontact is the PIM of choice
under KDE. It combines applica-
tions such as KMail, KOrganizer
and KAddressBook into a single
interface to provide easy access to
mail, scheduling, address book,
and other PIM functionality.

Kivio 
kivio in Run window
FLOWCHART PROGRAM
Kivio is a basic flowchart and dia-
gram application. It lets you cre-
ate diagrams by arranging

pre-drawn shapes and stencils on
a virtual graph paper. Kivio offers
a fair amount of stencils to
choose from. Select them from
Tools > Add Stencil Set menu.

A file created under Kivio can
be saved as a PDF file. To do so,
click on File > Print, and under
Name select Print to file (PDF).

OpenOffice.org 
OFFICE SUITE
Although KDE has its own office
suite, KOffice, the collection of
programs that it spans are not as
well-integrated, or as easy to work
with, as those included with the
OpenOffice.org (OOo) suite. We
will consider the latter and cover
all solutions for word-processing,
presentation and spreadsheets.

Before we delve into each solu-
tion, a quick word on compatibil-
ity. If your company uses custom
macros created specifically for
Word, then it is likely that you
won’t be able to use them under
the OOo suite’s Writer program.
Third-party plugins will certainly
not work with Writer. 

Similarly, documents created
under Word will not translate
perfectly under Writer. You will
invariably lose formatting,
depending upon the nature of
your document. 

Thus, it is impossible to
expect 100 percent compatibility
between OOo and MS Office. OOo
makes sense for an organisation
looking to deploy a uniform set of
applications across its workers. 

It is good enough as an office
suite, but problems keep crop-
ping up whenever you need to

or when you want someone to
help you perform a task.

A good VNC client under KDE
is the Remote Desktop Connection.
All you need to do is type krdc in
the Run window.

The sharing is done by send-
ing out an invite. This can either
take the form of an e-mail or can
be done in person. In either case,
you have to supply the remote

user the IP address of your
machine along with a valid pass-
word. The password is randomly
generated and, by default,
remains valid for exactly an hour.

KNotes
knotes in Run window
STICKY NOTES
KNotes lets you jot down those
Eureka moments or manage your
day, one task at a time. It behaves
like sticky notes that you come

You need to send invites before sharing
your desktop with another user

Kopete has several useful plugins
which you can deploy piecemeal

KNote can print or e-mail notes

Kontact is a comprehensive and well-
integrated information manager

Kivio and its stencils

A Kivio file exported as a PDF

Kontact is
the PIM of
choice
under KDE
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spell-check are also present, in
the Tools menu. 

If you are accustomed to MS
Word, you will miss some useful
touches such as the right-click
access to the thesaurus or the
ability to hit a shortcut key to get
the word count for a document.
Right-click on the Main toolbar
located on the left, and click on
Configure. Then click on the Key-
board tab of the dialog box that
shows up. This is where you can
assign shortcuts to frequently-
used commands. For example,
assign [Ctrl] + [W] to give you the
word count of a document.

There are several other fea-
tures as well. You can directly
export to the PDF format (File >
Export as PDF). Writer also has a
series of wizards to automate
tasks located under File > AutoPi-
lot. These let you perform tasks
such as conversion of files from
MS or OOo formats to the OOo
XML format, create memos,
import new dictionaries, etc.

NOTE: If you find that you
can’t edit anything with Writer,
go to the Edit File icon (right next
to the Export as PDF icon) and
click on it.

CALC
OOo-calc in Run window
As Writer to MS Word, Calc is just
as worthy a replacement for MS
Excel, as far as functionality is
concerned. Another benefit is
that of a uniform interface
between the OOo suite applica-
tions. This extends to both tool-
bars and the menu structure.

You won’t face problems
exchanging data from one appli-
cation to another. A Calc table or

chart is there to co-exist within a
Writer document. Just as Writer,
Calc can also export a spread-
sheet as a PDF file.

IMPRESS
OOo-impress in Run window
Impress is the presentation tool.
As you launch it, Impress takes
you through a rudimentary wiz-
ard. But, the templates available

are minimal, and the wizard
itself isn’t quite useful. Despite
that, Impress is a decent tool,
with several interesting features.
You can add text animations,
page transitions, sound effects-
the usual whiz-bang to add the
gee-whiz to your presentations.  It
is not comprehensive by far, but
it is good enough to get the task
done. 

ahmed_shaikh@thinkdigit.com

share documents with others not
using the same suite. As a
workaround though, you can eas-
ily export an OOo file to a PDF for
sharing with outside clients. 

Before deciding to switch to
OOo, make sure you run a com-
prehensive test. As a worst-case
scenario, if you can’t work with-
out MS Office, consider that you
can use WINE to run MS Office
within a Linux distribution.

This discussion on compati-
bility is equally true for all aspects
of the OOo suite—right from the
word processor to the presenta-
tion tool.

WRITER
OOo-writer in Run window
Writer is an excellent replace-
ment for Microsoft Word. It does
everything that Word can do, and
has a few tricks that it can teach
the Windows behemoth. One of
the most interesting ones is that
of auto-completion.  It maintains
a database of all the words that
you have typed over a period of
time. Writer offers to complete
the words whenever it identifies
those that are repeated. The idea
is to boost the typing speed. Tools
that offer auto-correction and

Associating shortcuts to frequent
commands is simple

Impress is not very impressive

Table from Calc within Writer

I want to read PDF files: Use Acrobat Reader
(type acroread in the Run window) or KPDF
(KPDF in the Run window)
I want to zip and unzip files: Use Karchiver
(type karchiver in the Run window) or Ark
(ark in Run window)
I want a good calculator: Kcalc offers
exponential, logical, trigonometric, and
statistical functions apart from the regular
arithmetic. Type kcalc in the Run window
I want to take screenshots: KSnapshot,
ksnapshot in Run window, should do the
trick
I want something similar to Windows
Notepad: Kate is a good text editor. With a
view to helping programmers, it has some
project management options apart from an
inbuilt Linux terminal. Type kate to launch it
I want an XML editor: KXMLEditor should be

enough. Type kxmleditor at the Run window
I want to sync my Palm handheld: KPilot
offers familiar sections for your Palm To-dos,
Memos and Addresses. It can also push
applications to the handheld. Type kpilot on
the Run window to launch it
I want an alarm: KAlarm lets you set up
alarms. These can be triggered at specific
times that are set, and can be made to recur.
Alerts take the form of both audio files such
as Ogg or Real Audio, apart from a visual
alert. The alarms can also be set to trigger
the launch of an application or send an e-
mail. Type kalarm at the Run window to
launch the app
I want an audio player: amaroK was our
favourite player under KDE. It is fast, has a
simple interface, and supports features such
as an on-screen-display for song names.

Type amarok on the Run window
I want to burn a CD/DVD: K3b is the easy
choice here. It can burn both CDs and DVDs,
has a wizard to take you through the steps
and it works. Type k3b at the Run command
to launch this one
I want a video player: Kaffeine is our choice
of the bunch. You will have to download
codecs for some files. But that is the case
with all the players under KDE. Type kaffeine
to launch it
An IDE for programming: KDevelop is the
best you have, like it or not. Type kdevelop
in Run to launch it
An image editor: GIMP is your best bet. It
rivals Adobe Photoshop over certain
features. It offers layers, has lots of plugins,
fonts, scripts, etc to make image-editing
really easy 

What Do You Want To Do Today?

It is
impossible
to find 100
per cent
compatibili
ty between
OpenOffice.
org and MS
Office
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he Internet is an indispensable tool.
Whether it’s for communication—e-mail
or browsing—or for research, or running

corporate Web sites, most business houses rely
on the World Wide Web. But for companies that
have branches spread across the globe, the
major question is—how secure is the Internet? 

The issue does assume serious proportions,
given that almost all corporate communication
and research today, is done via the Internet.
Your company could be headquartered in, 
say, Bangalore, and have regional offices dot-
ting numerous places across India, or even
abroad. In such cases, the Internet is the only
bridge that connects the distant elements of
your business.

It is common knowledge that the WWW
plays reluctant host to a range of viruses, tro-
jans, social engineering attacks, DDoS attacks,
and other forms of cyber-nuisance. And it needs
little mention that business houses, which rely
heavily on the Web for communication, take a
major risk in doing so. Is there an absolutely
secure way for companies to exchange infor-
mation over the Internet?

A Virtual Private Network or VPN could just
be that answer. A VPN uses public networks
such as the Internet and exactly the same phys-
ical infrastructure of cable and routers. In
doing this, it not only drastically cuts down
costs, but also offers smooth services with fool-
proof security.

The Company
The Anglo-Eastern Ship Management Ltd is
located in a quaint area of north-central
Mumbai. It advertises itself as a liaison compa-
ny. In Mumbai, the company is the largest sup-

How Technology Can Help Your OrganisationThe Ultimate
Server Test

Business
Digital

104Data at Your
Fingertips

100-person strong Anglo-Eastern
Ship Management Ltd saved a
whopping 80 percent of their costs
on communication, when they
implemented Virtual Private
Network (VPN). Here’s how you can
communicate securely and cheaply
over the Internet using VPNs
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when additional backup lines had to be main-
tained. One additional line meant a constant,
heavy expenditure.

For an organisation that depends heavily on
round-the-clock, instant communication, this
posed a serious problem. So the hunt began for
another form of network—a substitute that was
more secure and cost-effective.

Enter Virtual Private Network
A Virtual Private Network uses ‘virtual’
connections routed through the Internet.
Unlike a typical leased line, this connection is
between the company’s private network and a
remote site or an employee. Imagine you are in
Country A and wish to travel to Country B. The
journey could be by road. 

But that makes you visible to all and
sundry who take the same route. Suppose,
now, that  Country A decides to build a bridge
to the other country, keeping in mind
exclusive direct access and better security. But
building bridges is an expensive affair. 

Given that VPNs play a similar role—that of
an ‘exclusive bridge’—the next big question is,
how does it tackle the expenditure angle of
the whole setup? We could give the
inhabitants of Country A a small plane. A
plane is ideal when it comes to speedy access
as well as security and privacy. 

This is exactly how VPNs work. Each remote
member of your network can communicate in
a secure and reliable manner using the
Internet as the medium (the sky or airspace, in
our analogy) to connect to the private LAN
(using a plane, in our example). And this is
precisely what Anglo-Eastern Ship
Management Ltd.

The headquarters and all the regional
offices were connected by a single network. All
that the Mumbai office had to do was to invest
in a dedicated leased line for a short distance,
right up to the service provider. The result:
with just a 2  Mbps line, the Mumbai office is
constantly connected to the head office and
regional offices all over the world.
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plier of Indian Sea farers on Foreign Vessels.
Set up 30 years ago, the company offers servic-
es such as ship management, technical servic-
es and crew management. The Mumbai office,
with a staff of 100, takes care of a major chunk
of the recruitment process.

The company is headquartered in Hong
Kong. It has a long list of offices spread all over
the globe—the US, Canada, New Zealand, Bel-
gium, the UK, Japan, Philippines and Singapore.
The communication network, thus, needs to be
impeccable to allow the head office to keep
track of all its regional branches.

The First Steps
Back in 2001, the company began reaping the
benefits of technology by streamlining much
of its work. During that year, Anglo-Eastern
went online, offering full details of ships,
including technical and financial reports. It
installed an online vessel-condition and ship-
management system. With such a setup, super-
intendents and owners could access technical
reports, audits, accounting reports, and finan-
cial analyses—all over the Internet.

The next year, Anglo Eastern set up a frame
relay network, connecting the head office in
Hong Kong with all the regional offices. The
idea was find an alternative for spending
heavily on communication, without compro-
mising on security. 

A frame relay network establishes a WAN
between the connected sites. The connection
uses private lines or circuit-switches over leased
lines. Despite a much faster rate of data
transfer, there were a few problems. 

According to Abbas Dean, IT Executive,
Anglo-Eastern, “Whenever the connectivity to
the Point of Presence (POP) through an MTNL
connection snaps, as it happened to us during
the monsoons, the connection simply goes
down. We were helpless and without any means
to communicate.” Abbas recalls those days

Suppose there are three or four Branch offices and one main office. Each branch office is
connected to one Point of Presence, provided by the main service provider. Together, all the
networks form a larger network that lets them communicate with each other

How Does A VPN Work? 

VPN: What To Look Out For 

There are many vendors providing such a
service, from VSNL to Sify. According to

Abbas Dean of Anglo-Eastern, keep the
following things in mind when opting for VPN:

Data Security: It is always not required to 
spend heavily on security. Spend on security
as much as the business requires. If 
possible, outsource security related issues 
to the service provider
Geographical Location: It is better to select 
a service provider who has POP in all 
countries or cities of your establishment
Reliability: Depends on the service 
provider’s infrastructure
Network Management: What kind of add-
ons does a service provider offer? Does he 
offer to manage Net traffic as well?
Telecom Infrastructure: A VPN requires a 
good telecom infrastructure

Head Office

Branch Office

Point of
Presence

One shouldn’t
stick to just one
provider. If my
leased line fails, or
if the service
provider is down, I
can still reach by
head office over
any other ISP
provided
bandwidth, and
pay only till the
time I use it
Abbas Dean
IT Executive
Anglo-Eastern Ship
Management Ltd
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Are VPNs Cost-Effective? 
Once a business house sets up a VPN, drastic reduction in
infrastructure costs follows. A VPN can extend across geo-
graphical boundaries without the use of dedicated leased
lines. Says P J Nath, Senior Vice-President, Enterprise
Solutions, Sify Limited, “We look at the number of users or
networks that the organisation needs, the level of service
required in terms of latency, uptime, and how far the organ-
isation wants us to manage the network.”

Abbas feels that it is always safer if an organisation does-
n’t get stuck to just one provider. “If my leased line fails or
the service provider is down, I can still reach by head office
over any other ISP provided bandwidth, and pay only till the
time I use it,” Abbas explained.

The money angle aside, security is a big concern.
Firewalls are used to make VPNs secure. Each remote user

has a firewall client installed, which filters internal clients
from external elements, and cuts down on chances of network
disruptions. All the regional offices need to run the network
on these two exchange languages, SQL or MS, to be able to deci-
pher the encrypted information. 

With firewalls in place, it becomes easy to restrict the
number of open ports. Abbas feels that since the data
exchanged is not extremely critical, a firewall is good enough
for security. 

Abbas feels that the kind of security required should be
given importance considering the business requirements.
Organisations that handle sensitive data should look out for
network security. They must use the IPSec (Internet Protocol
Security) Protocol and AAA Servers (Authentication, Autho-
rization and Accounting).

The Communications Revolution
For Anglo-Eastern Ship Management Ltd, the change to a VPN
has resulted in faster and better Internet speed. With the slash
in bandwidth and port charges, the company could do away
with leased lines and the mammoth costs they entailed. For
the 100-odd employees, a 2 Mbps line is enough to keep in
touch with the rest of the offices worldwide. Today, an Anglo-
Eastern employee can connect from his home to the VPN
without worrying about disruptions. 

Says Dean, “The number of hours put in the office doesn’t
require any one of us to use this facility from home.” And
employees get to enjoy a well-deserved weekend. In sum, a Vir-
tual Private Network cuts down on bandwidth costs for your
business, and allows you to stay connected without  night-
mares about security issues and cyber-threats. 

aparna_krishnakumar@thinkdigit.com

1/2 P V AD

Here Comes SSL VPN

VPNs have already been recognised by enterprises as the preferred
medium of connecting globally strewn offices to their intra-

networks. Even in India, VPNs are appreciated for offering significant
reduction in costs and a secure means of connection. There is a new
technology that is also gaining in popularity—SSL VPNs.

Secure Sockets Layer Virtual Private Network (SSL VPN) is an
application-independent security protocol. It gives users access to the
Web, server and file-sharing resources from Internet cafés, kiosks,
wireless devices, or PCs. The SSL protocol is already embedded in most
IP (Internet Protocol) stacks. Organisations that deploy SSL VPNs are
spared any additional cost. It is ideal for businesses with their
personnel always on the move.

The key considerations for evaluating SSL VPN products as a
remote access solution are encryption, application support, end-point
security and total cost of ownership.
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The top of the monitor should
be 2 to 3 inches above eye level

Back To Front!
Forget tech support,
think lumbar support—
from posture, to
furniture, to tools,
follow these guidelines
for healthy working

1

The back rest of your chair
should support your lower back3

1

3

4

6

Maintain a viewing distance of at
least 18 inches2 Your elbows should be close to

your body5

Chair height should be such that
your keyboard is at elbow-level4

Your feet should either rest flat on
the ground or be supported by a

footrest

6

Keep your work close

Do not over-reach

Type gently, do not hit the keys

Keep your wrist parallel to the table

x
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Working Right
A workplace should be
such that everything you
work with, is within easy reach.
To avoid muscle strain and back
ache, stretching and bending should
be kept at a minimum. Bring your work
closer to you, do not over-extend yourself

Use the Right Tools
Palm rests put your wrists in a neutral
position, preventing strain and ensuring
blood flow. Some keyboards, such as the
Microsoft Wireless Optical Desktop Pro,
split their key layout to make sure that you
do not need to move your wrists laterally
while typing. This reduces stress to the
tendons and muscles of the wrist

Proper Seating is Vital
While seated, your lower back is under
considerable stress. An ideal chair, such as the
award-winning Aeron from Herman Miller, offers
an adjustable support for your lumbar region.
The Aeron’s high and wide contoured back takes
weight off the lower spine. The back of your
knees are to be pressed to the ‘Waterfall’ front
edge to reduce pressure under the thighs. This
ensures that circulation isn’t restricted

Whether sitting straight or at a recline, ensure that your wrists remain parallel
to your keyboard. Moreover, your neck should be straight, in its neutral
position—not twisted or to one side. Use a head rest to ensure the same

Seen here is the Stratum from Blowplast Ergonomics

Seen above is Herman Miller’s Aeron chair. On the right is their
Mirra chair

On the left is Logitech’s Cordless Desktop, to the right is
Microsoft’s Wireless Desktop Pro

EE--mmaaiill::  ergomum@bpergo.com

PPhhoonnee::  +91-022-5660-3590 

WWeebb  ssiittee::  www.bpergo.com

EE--mmaaiill::  umesh_munot@hermanmiller.com PPhhoonnee::  +91-09845166570
To contact Umesh Munot of Herman Miller’s Bangalore office:

LLooggiitteecchh::  www.logitech.com MMiiccrroossoofftt::  www.microsoft.com

Text Ahmed Shaikh, Illustration Mahesh Benkar, Jayan Narayanan
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house has to go out of its way if it aims to excel
and not just survive. And this calls for innova-
tion. Contemporary organisations need to be all
the more eager and explore new ways to store,
maintain, and retrieve sales data quickly.

The good news is, there is a solution, in the
form of SFA—Sales Force Automation. How
would you like to maintain all your transactions
with clients, and their contact details, in a cen-
tral repository for everyone to access? Say a sales-
person sets off with a proposal for a client.
Wouldn’t it be of immense help to get a quick
history of the client at his fingertips? Or for that

It’s time you 
took stock of a
much-ignored
aspect of your
business—
maintaining sales
data. Automate
all your sales
tasks, before it
gets too late

Ram Mohan Rao and Aparna Krishnakumar

f you walk into any sales department
today, chances are you will find employ-
ees buried under reams of paper. Stock-

piles of invoices, request forms, delivery forms,
complaints, reports, and what not—the list gets
bigger as your sales force traverses the country.
The result: a mess of manual, paper records that
run the risk of getting damaged or misplaced.

Sales data is as critical for any business as its
transactions. Given the competition, a business

I
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How About Data At
Your Fingertips?
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matter, how about sales forecasting? This is
where sales force automation comes in—it helps
you automate anything and everything about
the sales process.

SFA is often defined as a technique of using
software to automate the day-to-day business
tasks of sales. These tasks include contact man-
agement, order processing, customer manage-
ment, information sharing, and order tracking.
This apart, SFA even takes care of inventory con-
trol, sales forecast analysis and performance
evaluation.

Ideally, marketing materials should be elec-
tronically forwarded to the sales force. With
such a system in place, salespeople have the
materials needed to promote the latest products
and services, right at their beck and call. Prices
and inventory can be checked on the spot, and
orders can be taken and transmitted electroni-
cally. SFA software makes estimation of sales
forecasts and expenses precise and brisk. The
business organisation can even maintain client
lists without creating much clutter, and metic-
ulously analyse buying patterns. 

SFA can revolutionise a business on the
administrative front. Salespeople can electroni-
cally file their time sheets, which eventually
makes it easy for management to track their per-
formance. Similarly, managers can analyse buy-
ing trends and profitability, and fine tune mar-
keting plans and product lines accordingly. 

With all the nitty-gritty of an SFA environ-
ment dealt with, a bottomline clearly stands
out. SFA drastically reduces the paperwork
involved in the sales process. It also cuts down
heavily on the time spent on paperwork. All this
leaves the business more time and resources for
actual sales. 

However, the decision to deploy sales force
automation can be fraught with risk, given that
the software doesn’t carry a clean slate. There
is no “one size fits all” SFA solution, and there
are several glaring stories of how SFA strategies
have flopped. Reasons range from poor imple-
mentation of the systems, to insufficient train-
ing for the employees to handle the software
well enough.

But implemented correctly, SFA brings

home huge benefits for the business. 
US-headquartered Phoenix Systems Integra-

tion recently conducted studies on successful
implementations of SFA—the results say that
proper implementation of the software pushes
up revenues by 30 per cent. In fact, profits can
shoot up even 60 per cent. These facts are proof
enough of what SFA can do to your business.

ACT! 2005
Let’s take a close look at ACT! 2005 Premium for
Workgroups as an example of SFA software.
Think of SFA software as Outlook on steroids.
Only, it does much more. ACT! Premium gives
you a powerful way to capture and share infor-
mation in a collaborative environment. 

You can  find the trial version of ACT! on the
Digit CD/DVD.

Contact and customer management is the
process of capturing and managing every aspect
of your business relationships, including

Contact details
Activity history and meeting notes
E-mail and other correspondence
Schedules, appointments and to-do items
Proposals and reports
Sales tracking and forecasting

The software stores detailed contact and cus-
tomer information, including e-mail messages,
history, attachments, activities, sales opportuni-
ties, etc. 

You can find anyone or any detail easily by
performing Lookups on any Field or by using the
Keyword Searches. Lookups can also be saved as
Groups.

For example, you can quickly define sales ter-
ritories by performing a Lookup on State, and
then you can simply save it for quick reference.
This, in turn, gives your team a complete picture
of the entire relationship.

ACT! creates and maintains detailed com-
pany records. All notes, histories and opportu-
nities related to the company are stored in the
same place. If core company information
changes, each related contact gets updated. You
can have Notes stamped with date and time,
and History tied with each contact to keep
track of important details, such as conversa-
tions and commitments.

ACT! includes features for individual as well

Zensar Technologies, a software
services company, is

headquartered in Pune. The
company’s sales operations are
globally distributed and the work
takes place across different time
zones. The problem that the company
faced was two-fold. 

The direct sales people required a
pre-sales support that included
updates on a client’s background,
expectation and need. On the other
hand, sales personnel were hesitant
to share their follow up of a client’s
information, but expected instant
organisational support. To solve the

problem, the company installed the
ACT! software in October 2003. The
results have been more than
satisfactory. 

The software helped them handle
both offshore and onsite activities
better. 

According to Shyam Kuddyady,
head, enterprise pre-sales, Zensar, “The
software has been a small investment,
but it has brought a change in work
culture. It has ensured a two-way
communication between the sales and
the support team.” For Zensar, the
software was all about reliability and
transparency of information.

Case Study: Zensar Technologies

Comprehensive
contact data-
base with more
than 60 fields

You can create,
send and track
e-mail using the
ACT! E-mail
Client

You can schedule
activities, individ-
ually or for your
workgroup

There are
more than 40
standard
reports

The Task List
gives a team a
comprehensive
view of what’s on
its plate

Your team can
view all sales
opportunities
at once

With SFA in
place, sales
people can
electronically file
their time sheets.
Eventually, it
makes it easy for
management to
track their
performance

Digital Business l Smart Business
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as team scheduling. There’s a Task List that
gives your team a comprehensive view of what’s
to be done. You can schedule activities, indi-
vidually, or for your workgroup. 

The software displays the availability of
your team at a glance. When you schedule a
group activity, a notification appears on each
team member’s status bar. Users have the
choice to accept or decline participation. 

You can create custom Activity and History
types specific to your business. For example,
you could create and track “Billable Hours” as
an activity type. Also, you can define a series of
activities around a specific event. 

Then simply schedule that series to auto-
matically put the activities on the other team
members’ calendars. The activities remain
linked, so when one activity moves, you are noti-
fied to move the related ones. If key information
changes, a call can be scheduled for a salesper-
son to ensure that he doesn’t miss it.

The software enables your sales team to meet
its goals using inbuilt tools to track sales and
make forecasts. You and your team can view all
sales opportunities at once and then access,
update and filter opportunities. 

If you have a range of products or services,
you can set them up in the Product List, and
then track the product or service name, item
number, cost and price. Once you have this 
set up, your users will consistently enter infor-
mation as they sell. Scrutinising consistent
information helps the analysts make better
sales forecasts.

An Online Approach
Oracle Sales Online is a Web-based application
for field sales representatives, resellers, and
sales executives. It automates the entire sales
cycle, right from account and contact manage-
ment, to opportunity management and
pipeline analysis, to order management. 

The key functions include Customer Con-
tact, Lead, Opportunity, Quote and Order Man-
agement. This application provides versatile
tools to help sales representatives carry out
their daily tasks smoothly. There is another fea-
ture called Oracle Field Sales for Palm that

comes with Sales Online. It enables salesper-
sons to take all information with them wher-
ever they go on their PDAs.

Users of Sales Online get to easily set up and
save frequently-used queries, such as which top
deals are in the pipeline, or which deals are clos-
ing in the next 30 days. There are Inbox Indica-
tors, which help users visually determine data
elements that are new or have been changed.

Sales Online provides sales professionals
with complete customer overviews at each stage
of the sales process. Before contacting cus-
tomers, salespersons get to review customer
information, including products installed, out-
standing requests, histories, contacts, opportu-
nities, etc. With the loads of information, sales
representatives find it much easier to manage
their customer accounts.

Sales Online features integrated calendars
for maintaining logs of daily tasks. Users can
actually keep track of all their appointments.
Group calendars can help users subscribe to a
common calendar across multiple users. You can
even set up Public calendars to air the company
goals and events, such as a common marketing
calendar. Users can synchronise their business
calendars with Palm and Outlook to maintain
common business and personal calendars.

With Sales Online, organisations can flexi-
bly manage forecasts. You can analyse forecast
data at geographic, deal and product levels.

Time to Go Automatic, or is it?
Today’s businesses are left with little breathing
space. Let alone vying for the lead in the gru-
elling race, organisations need to keep up with
the breakneck pace at which more and more
offices are exploring newer ideas. And when it
comes to taking stock of the more-ignored
aspects of business such as sales data, those
who choose to continue ignoring, are simply
left way behind. Sales force automation isn’t
magic, neither is it an overnight marvel. It is
designed with a purpose—it cuts down all cum-
bersome paperwork, easing the sales process
like never before. Are you ready? 

ram_mohan@thinkdigit.com
aparna_krishnakumar@thinkdigit.com

Keeping up with technology, sales force
automation has undergone loads of

changes. With portability in mind,
organisations are looking at how sales
personnel can access information on a
handheld. In India, companies such as Xserve
India Pvt Ltd have the AnexTEK SP230. This is
a handheld device with GSM Mobile
functionality and GPRS connectivity running
on the Intel Xscale processor and powered by
Microsoft Pocket PC 2003. Ramco Systems
have the Virtual Works Platform for Enterprise
that promises an end-to-end solution for back
office sales needs. The future of such
applications looks bright with the pharma and
the FMCG sector being the large customers for
such applications.

The Really Mobile Workforce

With Oracle Sales
Online, you can
analyse sales
forecast data at
all three levels—
geographic, deal
and product

Information
such as the
client's history,
their wants,
etc., is
maintained at a
central
repository. 

During a meeting or a
sales visit, a sales-
person accesses the
repository via a laptop,
an online interface or 
a PDA. The data helps
the person make
informed decisions and
close or reject deals.

Working of Sales Automation 
Infograph
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5 Things To Do
Before Leaving On A Vacation
A list of must-dos to keep in touch and to make the most out of your time away

DIGIT OCTOBER 2004
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Set up an e-mail auto-responder before

leaving such that your colleagues and

clients are aware of your absence and your

expected date of return. You can also

subscribe to a service which forwards your

e-mails to your cell phone. Orange, for

example, can forward MS Outlook mail to

selected handsets.

1 Purchase a water-proof case for your
camera, especially if you plan to hit the
surf and sands. Consider investing in extra
lenses if your camera supports them. A
zoom lens and a wide-angle lens can add
life to vacation pictures

2

Carry an extra battery-pack which will

serve as reserve power for your

laptop. For your other gadgets, such

as cameras and MP3 players, carry

lots of spare AA and AAA alkaline

batteries. Don’t forget to carry your

chargers!

3

If you wish to travel aroundEuropean cities and within the United
States, make sure that your cellphone is tri-band compatible andthat you have activated a roamingservice before leaving.

4
If you carry a PDA make sure it hasapplications for telling you the worldtime, displaying maps, convertingworld currencies, weather-trackingand maintaining your itinerary.WorldMate Pro, for example, can doall that

5
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Sanket Naik 

s a growing computerised enterprise,
whatever its size may be, sooner or later,
the need for a server will be felt. Count-

less tasks, such as sharing files and resources,
taking regular backups of your work, main-
taining a repository of your digitised documents
and other essential data and so on, can be done
effectively and efficiently with a server in place. 

But, can’t a workstation double up as a
server? A workstation PC with enough pro-
cessing power and memory may suffice, but a
server is more than computing power. There are
other aspects to this beast. 

For example, regular PCs are based on com-
ponents with a short shelf-life as compared to
those used in servers. So, if your server uses a
motherboard meant for a desktop PC, you will
have no option but to upgrade if something hap-

pens to it. And an upgrade is by no means a
simple task: older software such as the OS, a
client database, your sales figures, etc., would
require migration, re-installation or optimisa-
tion—which is a big waste of time and money.

However, this won’t be the case with a proper
server, since server vendors ensure that spare
parts are made available for a longer duration,
even if they come at a price.

In a growing business, greater demands are
placed on office infrastructure, and resources are
pulled to their limit—demanding induction of new
servers or upgrading existing ones. Investing in a
scalable server will save a lot of trouble later on.

A server needs to strike a balance between
performance, reliability, scalability and price.

State Of The Market
The words server and expensive were synonymous
not long ago, but this has changed significantly.
Basic servers today—deployed as file servers,

A

A workstation PC
with enough
processing
power and
memory may
suffice, but a
server is more
than computing
power. There are
other aspects to
this beast

Serves IT Right
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intranet servers or as small database servers—
cost no more than Rs 75,000. 

To test the best, we received six servers from
five vendors—two reputed for their servers,
namely HP and Acer (who sent in two for this
test), and the other three from Zenith, Wipro
and PCS respectively. All of them were based on
an Intel platform; most of them featured a Pen-
tium 4 processor, the exception being the Acer
G520, which had an Intel Xeon. The price varied
from Rs 40,000 to over Rs 1 lakh.

It is not possible to pin-point a perfect server,
since its performance varies dramatically with
the applications you run on it. However, it is pos-
sible is to test overall performance, from which
a buyer can guage a certain machine’s perform-
ance under the expected workload.

The Heart Of The Beast: The Chipset
For any computer, there are four vital subsys-
tems, namely the CPU, memory, I/O and
graphics. Apart from the graphics, the others
form a very important foundation for any server
under consideration.

The chipset dictates the server’s features, and
the strength and efficiency of the CPU-memory
subsystem. Know your chipset and you can make
a wise investment. Intel’s i875P and E7210 are com-
monly used by vendors for their servers.

The i875P is referred to as a Workstation
chipset by Intel, whereas the E7210 is called a
server chipset. Both are nearly identical in terms
of features, and both extend support to the new
Pentium 4 processor over an 800 MHz FSB (front-
side bus), with speeds touching 3.2 GHz. They
also support dual-channel DDR memory mod-
ules; the bandwidth this affords is rather crit-
ical from a server point of view.

Both the chipsets support Gigabit Ethernet
via a dedicated bus called the Communication
Streaming Architecture (CSA). This should help
alleviate PCI bottlenecks, since in other chipsets,
the Ethernet ports are tied to the PCI bus, which
has a low bandwidth.

The most notable difference between the two
chipsets is within the I/O sub-system. The E7210
natively supports PCI-X slots—64-bit avatars of the
regular 32-bit PCI; a PCI-X bus is generally used by
SCSI controllers, which demand higher band-
width. The i875P supports PAT—Performance
Acceleration Technology (See box ‘Jargon Buster’).

The AGP 8X bus, which
is not supported by the
E7210, is the reason for
calling the i875P a
Workstation chipset.

Also, since the
E7210 is designed to be
a server chipset, relia-
bility would need to be
an important aspect of
the chipset itself. An
i875P-based server is a
cheaper option than
one based on the E7210.

A third chipset in
this comparison was
the E7320 from Intel.
This brand-new server
chipset from Intel is
similar to the E7210
save for two major dif-

ferences. First, this chipset supports Intel Xeon
processors. Moreover, motherboards based on this
chipset can support two Xeon processors. 

Secondly, the inclusion of high-bandwidth
PCI-Express buses gives it the edge. This makes
the peripheral sub-system fast, robust and
future-proof. Solutions for this bus, however, are
not yet mature, nor are they widely available.

The i875P chipset is a good choice for
medium loads, offers good features, has a decent
performance and is well-priced. The E7210 offers
a stable server platform with a robust I/O sub-
system at a reasonable price. 

The E7320 chipset offers the best features
and, since it’s designed as a server chipset,
should serve you well.

The Contenders
Two servers—Acer’s Altos G310 and PCS Siirus
Compact V—use Intel’s i875p chipset. Zenith’s
Data Server, the HP ProLiant ML-110 and Wipro’s
NetPower 1120 use the E7210 as their backbone,
whereas Acer’s Altos G520 had the feature-
packed E7320 chipset.

The Processors That Power Them
The Intel Pentium4 2.8 GHz processor, based on
the Prescott core—with 1 MB of L2 cache running
over an 800 MHz FSB—formed the processing
powerhouse of servers using the i875P chipset.
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Which Server Is Best For You?

Before deciding on a server for your
enterprise, there are a few questions

that you must have the answers to:
What is the role of the server?
Is the server a multimedia application
server, streaming audio or video over a
network? Is it a less demanding Web Proxy
or an I/O transfer-dependent fileserver?
Based on the server’s designated role, you
will need the appropriate memory and
processing power.
Does it have room to grow?
Your business needs are likely to outgrow
your server offerings. Before buying a

server, ensure that the setup you’re
looking at has enough room for growth.
Look for sufficient number of extra drive
bays, memory slots, PCI slots, etc.
What about security?
In the event of a crash or a virus infection,
how does the server stack up in the
recovery department? Does it have an
efficient RAID setup? A RAID setup can
mirror the same set of data across hard
disks to minimise the risk of data loss.
Equally important are signed memory
modules with ECC (Error Checking and
Control) support.

How good is the support and warranty
offered?
When a server goes down, how quickly
can the dealer’s support staff help you
bring it back up? Does the warranty cover
all crucial components? 
How much can you spend?
Lower cost doesn’t translate to cost-
effectiveness. If the server has enough
processing power, but not enough
memory, the bottleneck created will
amount to wastage of CPU power. So pick a
well balanced, well-rounded configuration
that fits in your budget.

The chipset
generally
dictates the
features of a
server and the
strength and
efficiency of the
CPU-memory
subsystem. Know
your chipset and
you can make a
wise investment

Acer Altos G310; based on a i875P chipset



114 DIGIT OCTOBER 2004

Zenith’s 3 GHz-based server was the fastest
processor in this server shootout. Acer’s Altos
G520 had an Intel 2.8 GHz Xeon processor 
running at 800 MHz FSB with 1 MB of L2 cache.
Hyper-threading was common on all the 
servers tested.

Memory: Crucial For Performance
The memory subsystem is critical to the per-
formance of a server. Nearly all the servers
shipped with 400 MHz memory modules,
except for the Acer Altos G520. In the i875P cat-
egory, PCS was the only one to offer 512 MB of
memory, whereas HP and Acer came with just
256 MB. However, none of
these servers could take
advantage of the dual-channel
configuration, since they had
only one memory module. 

The Servers from Zenith
and Wipro were based on the
E7210 chipset. They had 1 GB
of memory and were config-
ured in dual-channel mode.
The Acer Altos G520, also in
dual-channel mode, had 512
MB of RAM.

The I/O Subsystem: A
chain is only...
Your system is only as fast as the
slowest component. The I/O sub-
system often comes across as
the bottleneck in a server
system.

A SCSI system overcomes

this problem, but  SCSI drives are expensive. They
cost nearly twice as much as IDE or SATA drives,
and the performance difference is not substan-
tial. But as of now, these drives are the fastest,
and until SATA drives mature enough to live up
to their potential, SCSI drives will remain the
backbone of most servers.

Some of the servers we received had the SATA
controllers onboard. Their performance did not
match that of SCSI controller cards. Also, an
onboard controller will hog CPU time, which
doesn’t happen with dedicated SCSI cards.

The HP and Wipro servers, as well as the Acer
Altos G520, had SCSI hard drives and were
hooked up to an Ultra 320 SCSI controller. RAID
controllers were also offered on these three
models. Wipro bundled three drives, whereas
the Altos G520 had two SCSI drives. In both cases
the storage space amounted to 80 GB. HP came
with just one 40 GB drive.

Zenith offered two SATA hard drives totalling
240 GB. The onboard SATA controller provided
the necessary support and RAID features. 

Acer’s Altos G310 offered two SATA drives,
each 80 GB, and these were driven by the
onboard SATA and RAID controllers. 

The PCS Siirus Compact server offered just
one 80 GB drive hooked on to the motherboard’s
onboard controller.

Of Network Adapters
Nearly all the motherboards had an onboard
Gigabit Ethernet controller, freeing up one PCI
slot. The Acer Altos G520, the Wipro Netpower
and the Zenith Data server all offered both a
10/100 Ethernet and a Gigabit Port. The graphics

We assessed the servers on three basic
parameters—Design, Features, and

Performance.

Design
We took into account the wiring of internal
components, proper tying and clamping of
wires, expansion bays, tool-free design,
ventilation system, etc. We opened up the
case and tried installing a new hard drive,
removing the existing PCI cards etc., to
assess how effortless it is to do these basic
things when the server goes down.

Features
Features included processor speeds and
type, amount of memory and the speed of
memory modules. Hard disk speed and the
controller in use, such as SCSI, RAID, etc,
make a lot of difference to the I/O speeds. 

More emphasis was put on the server
management software that should
accompany these machines. 

Performance
We ran the regular bunch of benchmarking
tests that we use on different hardware to
gauge performance at subsystem levels. 

These subsystem tests included PC
Mark 2004—a system suite; SiSoft Sandra;
Pov-Ray 3.5—a pure CPU test, the video
encoding test and ZD Bench’s Content
creation 2004. 

Being entry level servers, they will
perform the role of fileservers or Local
Intranet servers, or as Database servers.
You can use them as mail servers too. 

We used PC Mag’s NetBench 7.0.3
benchmark program that measures how
well a file server handles file I/O requests
from 32-bit Windows clients, which pelt the
server with requests for network file
operations. The final output of NetBench
reports throughput measurements. 

For gauging the performance of the
servers when used as Web servers, we ran
PC Mag’s WebBench 5.0 benchmarking
program. WebBench returns two scores;
requests per second and throughput as
measured in bytes per second. 

For Database performance, we used
Oracle 9i as the database application and
ran Oratools—Open source tools based on
the TPC-C benchmark. We used the ORABM
tool which typically answers the question,
“How does a server perform under a

CPU/memory intensive Oracle database
workload?” The load necessary for
benchmarking is generated using the
ORABMload script, which creates all the
necessary objects such as tables and
indices, and loads the data. The final result
gives the number of transactions per
second the server is capable of. 

For the Netbench and WebBench
benchmarks we used two clients that
pinged the server with requests. To avoid
the influence of network characteristics on
the results, we did these tests on isolated
networks consisting of a Compex DSG-1008,
a gigabit 8-port switch and CAT-6 cables for
connecting them. We used Windows 2000
Server as the operating system.

The Awards Process
The scores noted from Design,

Features, and Performance tests and from
the Price Index were given weightage. An
overall score out of 100 was calculated. The
product that scored the highest in the
overall score was adjudged the winner of
the Digit Best Buy Gold Award for its
category. The runner-up received the Digit
Best Buy Silver award. 

How We Tested

Your system is
only as fast as
the slowest
component. The
I/O sub-system
often comes
across as the
bottleneck in a
server system
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Zenith’s Data Server performs well for 
its price
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was the most underpowered sub-system on these
servers. The ATi Rage XL adapter found onboard
on most of them is more than sufficient, and
also saves one valuable PCI slot. 

The PCS and Acer Altos G310 were the only
ones to ship with Geforce Mx440 and SiS Xabre
AGP cards respectively. 

The Power Supply: Handling The Load
Both the Wipro NetPower and the Acer Altos
G520 offered high-wattage power supplies to
feed the most demanding of loads. The 600 and
460 Watts offered by the Wipro and the Acer sys-
tems respectively are enough juice for bundled
peripherals and more.

The PCS Siirus, Zenith’s Data Server and
Acer’s Altos G310 offered 300-watt power sup-
plies, which is barely adequate if there will be
upgrades. Similarly, the HP ProLiant ML-110’s
350-watt power supply is enough for the
present hardware, but would need upgrading
later. 

The Wipro NetPower and Zenith’s Data
Server were the only ones that offered a power
supply with an exhaust fan over the processor
area for effective cooling.

What Comes Bundled
15-inch monitors, keyboards, mice, driver CDs,
etc, were bundled with all the servers. Some,
strangely enough, missed out on manuals. CD-
ROM and floppy drives were common across all
the servers, except for the Zenith, which offered
a CD-RW—good for instant backups. Acer and HP
had the best package content.

EasyBUILD, the customised server manage-
ment system from Acer, was simple to use 
and understand. HP provided diagnostic 
tools. Zenith came bundled with Intel’s server
management tools, while both Wipro and 
PCS had tools that  allowed for some server
management. 

Accessibility, Ventilation, And More 
A good server is more than just a performance
machine. Being swtiched on 24x7 demands a
great deal of attention and care from their man-
ufacturers so that downtime is at a minimum. 

These machines need to be accessible—access
to hardware such as hard drives, memory mod-
ules, etc, should be easy to do without the need
for any tools. But from a security point of view,
access to the internals should be restricted to
system administrators. This is where locking
facilities come in. A chassis intrusion detection
system, for example, informs an administrator
in the event of unauthorised access. 

Ventilation is of paramount importance for
optimum operation of a server. Machines based
on the latest Intel chips, in particular, need
good airflow.

As a general rule, air should enter from the
front of the chassis and exit from the rear, with
the help of fans. Various factors determine this
flow—chassis design: the dimensions of the
server case, the placement of the fans, etc. The
internal wires from the power supply also need
to be clamped together so they don’t block 
air passage.

Wipro’s Netpower had the roomiest cabinet
of all—clutter was minimal. Ventilation is aided
by a well-designed cabinet and is amply sup-

Upgrades And Extras
When server loads increase, you’ll need to go
hardware shopping. Look for this:
Processor
If you need a streaming server, your tasks are
likely to be multimedia heavy. Consider adding a
second processor to fulfil client requests faster.
Memory
Heavy traffic can generate a lot of temporary data
on the server, making performance take a hit.
Minimise the need for disk paging by installing
additional memory modules.
Storage
If your server is going to be used as a file server,
consider getting an extra hard disk. Improve
performance using a RAID 0 (striped)
configuration, or increase reliability by using a
RAID 1 (mirrored) configuration, or better still, get
both performance and reliability by using a RAID
0+1.
Backup (Tape, DVD)
Get a tape drive or DVD-R and backup all your data
regularly. While tape backup is a very cost-effective
solution, data access is faster with DVD-Rs.

Ventilation is of
paramount
importance for a
server’s optimum
operation.
Machines based
on the latest Intel
chips, in
particular, need
good airflow

What A Well-designed, Easy To Manage Server Must Have

1

2
3

4

5

6

1. Removable Hard disk bay

2. Properly tied power
cables

3. Tool-free attachments for
optical drives

4. Properly clamped IDE
cables

5. Large fans to ensure
proper ventilation

6. Easy to use tool-free
clamps for expansion cards.

The Wipro NetPower 1120:  Feature-loaded, expensive
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ported by three fans. Component accessibility is
a non-issue due to abundant space. A screwless
design ensures tool-free maintenance and
installation of drives.

HP’s ProLiant comes within a regular ATX
cabinet. However, air flow is maintained well via
a large 120 mm fan. Additionally, the internal
wiring is clamped properly, thus avoiding
clutter. The ProLiant ML110 is a showcase for
tool-free design, easy accessibility to compo-
nents, etc. Chassis intrusion detection was, how-
ever, missing.  

Acer, too, had tool-free servers, clamped
wiring, and drives that can be removed and re-
attached without fuss. The server can be locked
to avoid unrestricted access, or to prevent people
from turning it off. A chassis intrusion-detec-
tion system is also present.

PCS does a great job on the ventilation front,
with the help of deflectors that direct air-flow.

Zenith’s Data Server was the worst-designed:
the wires were not clamped properly and dan-
gled dangerously close to the CPU fan. The front
was completely packed with little room for air
to be sucked in. The box is a typical desktop box,
and an administrator would require effort to
perform everyday maintenance.

Performance: Who Fared How
We did a two-tier performance test on these
servers. First, we ran the usual benchmark suites
to determine component-level performance.
Then tests such as NetBench, WebBench and
Oratools were used to evaluate the server’s
overall performance.

We take a look at how each server fared in
the component-level tests. In the PovRay and ZD
Bench Content Creation 2004, PCS’s server
topped. Following closely was Zenith’s Data

Server. These results were significantly better
than those of other servers. This was quite inter-
esting since there were better chipsets around,
and some good configurations too, but the PCS
server managed to beat the rest in Content Cre-
ation 2004. Also, this was the only server to have
a GeForce class graphics card, and hence would
make a good choice as a workstation.

In the SiSoft Sandra memory subsystem test,
the variation was striking. Wipro and Zenith
posted the best memory scores, followed by
Acer’s Altos G520. Both Wipro and Zenith had
400 MHz memory configured in dual-channel
mode, and therefore scored well. The Altos G520
runs on a DDR 333 MHz sub-system, which was
reflected in its score. All the other machines
were running 400 MHz RAM but were config-
ured in single-channel mode, effectively halving
their potential bandwidth. This clearly shows
the boost a server gets when memory is config-
ured in dual channel mode. 

The processor subsystem revealed nothing
much except for the fact that Zenith’s 3 GHz
processor was beating the rest, which were run-
ning on 2.8 GHz processors.

In the hard disk sub-system, nothing came

Jargon Buster

Hyper-Threading allows multi-threaded
server applications to execute multiple
threads at once, and in parallel on a
single-processor core.
PAT stands for Performance Acceleration
Technology, a technique Intel introduced
with their 875 Chipset, wherein the system
performance is improved by optimising
memory access between the CPU and
system memory.  
PCI stands for Peripheral Connect
Interface, a standard for connecting
various expansion cards in a micro-
computer system. It succeeded the ISA
standard used in older computers. This
interconnecting bus is 32 bits wide, and
runs at 33 MHz.   
PCI-X stands for PCI-extended; the

evolution of the PCI bus saw the bus speed
increasing to 66 MHz and the width
extending to 64 bits. PCI-X is often used for
connecting high-bandwidth requirement
devices such as RAID cards and SCSI
controllers.
PCI-E stands for PCI-Express, a new
standard that promises to replace the
older PCI standard due to its high
bandwidth and other advantages. Each
device connected on this bus will have
four times the bandwidth offered by a
regular PCI bus.
RAID stands for Redundant Array of
Inexpensive Disks. The technique behind
RAID is to use small, inexpensive disks to
build an array of disks, which provide fault
tolerance by making redundant copies of

data. There are various architectures,
from RAID 1 to RAID 5.   
SCSI stands for Small Computer System
Interface. This is an interface that allows
for the connecting of internal or external
peripheral devices via a SCSI card, which
can connect up to 15 devices per channel.
It can reach a peak speed of 320
megabytes per second. There are various
types of SCSI, classified on speed, such as
Ultra 320, Ultra 160, etc.
SATA stands for Serial ATA, the new
standard that is soon to replace the PATA
interface standard, often used for
connecting devices such as hard drives
and optical drives. Being serial, it is a
point-to-point interface, and hence offers
higher bandwidth.

To sum it up, if
you are looking
for an all-
rounder, nothing
beats the Acer
Altos G520. It is
also the best
from a
scalability point
of view

Telephone E-mailCompany Web siteBrand

Contact Sheet

Acer
HP
PCS
Wipro
Zenith

Acer India (Pvt) Ltd
Hewlett Packard India Ltd
PCS Industries limited
Wipro Infotech 
Zenith India

080-25219520-23
1600-444-999
022-28521177
080-28440188
022-28377300

Shishir_Singh@acer.co.in
india.iss@hp.com
arunnarayan@pcsil.com
sameer.mutalik@wipro.com
info@zenith-india.com

www.acer.com
www.hp.com
www.pcsil.com
www.wipro.co.in
www.zenith-india.com

The Acer G520: The best when it comes to 
performance and scalability
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Score Board

ACER
Altos G310
21.81

i875P
0/ 5/Yes
One
Yes
4 GB

Pentium4
2.8/800/1 MB/Yes

256 MB/400
256 MB x 1

SATA /7200/160 GB

SATA
via onboard controller

No/Yes

SiS Xabre

300 W

CD-Rom
Yes
Yes
Yes
Yes

Yes
Yes
Yes
None
6.05
Yes
Yes-Uses Rails
Yes
one - 80 mm 
3.5
3.5
4
24.33
2880
20.7

2897/2917

8151/3179
21240/28459

32028
47
8
45
10
6

141
593
6.109
553
7.78
62,990
59.77

Brand
Model
Features
Motherboard Specification
Chipset 
No of PCI-X / PCI / AGP slots
Number of processor supported
Dual Channel Memory support
Maximum memory support
Processor 
Type of processor
Speed (GHz) / FSB (MHz) / L2 Cache / HT
Memory
Amount / Speed (MHz)
Configuration (no of modules)
Hard Disk
Type / Speed (RPM) / Capacity (GB)
HDD Controller
SCSI / IDE / SATA
RAID 
Network Adapter 
Ethernet / Gigabit 
Graphics 
Type 
Powersupply 
Wattage
Miscellaneous Features
Optical Drive 
Floppy drive 
Monitor 
Keyboard 
Mouse
Package Contents
Driver CD's
Server management software
Manuals
Miscellaneous
Design 
Screwless Cabinet 
screwless Drive attachments
detachable HDD bay
Number of cooling fans
Air Flow (Scale of 5)
Internal Wiring (Scale of 5)
Accessibility of Components (Scale of 5)
Performance 
Pov-Ray 3.5 
ZD Bench Content Creation 2004 
Sisoft Sandra 2004 Pro Memory sub-system
ALU / FPU
CPU sub-system
CPU Dryhstone / Whetstone
Multimedia CPU  Integer /  FPU SSE
Disk drive 
Drive Index MB/sec
Sequential Read MB/sec
Random Read MB/sec
Sequential Write MB/sec
Random Write MB/sec
Average access time
Real world Test
Video Encoding (Dr. DIVX)
ORATools (Transactions per second)
NetBench (Mbits/second)
WebBench (Requests/second) 
Price Index 
Price
Overall Score

Acer 
Altos G520
28.88

E7320
2/2/No
Two 
Yes
8 GB

Xeon 
2.8/800/1 MB/Yes

512 MB/333
256 MB X 2

SCSI 10,000/80 GB

Ultra 320 SCSI 
Via LSI 1020S card 

Yes/Yes

ATi Rage XL

600 W

CD-Rom
Yes
Yes
Yes
Yes

Yes
Yes
Yes
None
7.00
Yes
Yes 
Yes
Two-80 mm and 120 mm
3
4
3.5
27.04
3095.31
20.6

3582/3581

7675/3225
19779/26451

44259
61
16
61
18
3

148
800
6.211
583
5.57
87,999
69.42

Wipro
NetPower 1120
24.78

E7210
2/2/No 
One
Yes
4 GB

Pentium4
2.8/800/1 MB/Yes

1 GB/400
512 MB x 2 

SCSI/10000/80 GB

Ultra 320 SCSI
Adaptec 2010S Card

Yes/Yes 

ATi Rage XL

460 W

CD-Rom
Yes
Yes
Yes
Yes

Yes
No
Yes
None
7.78
Yes
Yes
Yes
Three- 80 mm 
4
4.25
4.5
26.59
3094.17
20.8

4833/4787

7505/3222
19809/26624

34641
52
18
20
11
2

146
692
6.112
592
4.19
1,17,000
64.61

PCS
Siirus Compact UP V
14.97

i875P
0/5/Yes 
One
Yes
4 GB

Pentium4
2.8/800/1 MB/Yes

512 MB/400
512 MB x 1

SATA/7200/80 GB

SATA
Via onboardController

No/Yes

Geforce MX-440

300 W

CD-Rom
Yes
Yes
Yes
Yes

Yes
No
Yes
None
4.15
No
Yes-Uses Rails
No
Two- 80 mm
3
4
3
24.42
1973.19
25.4

2022/2024

7179/2048
17363/20545

32779
48
7
47
10
7

124
575
6.108
547
11.95
41,000
55.84

Zenith 
Data Server
19.46

E7210
3/1/No
One
Yes
4 GB

Pentium4
3/800/1 MB/Yes

1 GB/400
512 MB x 2

SATA/7200/240 GB

SATA
Via onboard Controller

Yes/Yes

ATi Rage XL

300 W

CD-RW
Yes
Yes
Yes
Yes

Yes 
Yes
No
None
3.65
No
No
No
Two- 80 mm
2
2.5
3.5
26.66
2867.45
24.4

4870/4796

8254/3568
21190/28421

33789
50
8
46
14
7

138
586
6.103
595
8.70
56,300
58.81

HP
ProLiant ML-110
23.79

E7210
3/ 2/No
One
Yes
4 GB

Pentium4
2.8/800/1 MB/Yes

256 MB/400
256MB x 1

SCSI/10,000/40 GB

Ultra 320 SCSI
Via LSI 1010s card

No/Yes

ATi Rage XL

350W

CD-Rom
Yes
Yes
Yes
Yes

Yes
Yes
Yes
Power Cables
7.40
Yes
Yes
Yes
One - 120 mm
3.5
4.5
4
26.62
3083
17.5

2962/2964

7691/3223
19845/26705

38241
52
15
51
14
3

146
754
6.311
702
8.18
59,900
65.51
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close to Acer’s Altos G520 performance. This is
despite the fact that HP and Wipro both had an
Ultra 320 SCSI controller. This clearly indicates
the superb I/O sub-system of the E7320 chipset,
which is a good buy for a fileserver.

This was followed by good scores from HP and
Wipro servers using the Ultra 320 SCSI controller.
Zenith’s Data Server, with the onboard SATA con-
troller, also delivered good performance.

In the ORABM test, which gives the transac-
tions handled per second, Acer’s Altos G520
took the top spot. Coming second was HP fol-

lowed closely by Zenith and Wipro. If you plan
to run database applications, the Acer Altos
G520 is for you.

The HP ProLiant Ml-110 returned the best
throughput and the lowest response time in the
NetBench test. Acer’s G520 was a hair breadth
away from the HP machine but it returned a
higher response time.  Wipro turned in a third
position. HP will make a good fileserver.

WebBench saw the HP ProLiant ML-110 top-
ping the chart and handling the load well.
Zenith’s Data Server cruised past Wipro’s Net-
Power 1120 and Acer Altos G520 to claim the
second position, while the two followed respec-
tively. This was the only arena where the Altos
G520 lost to the others.

To sum it up, if you are looking for an all-
rounder, nothing beats the Acer Altos G520. It is
also the best from a scalability point of view: it
can take an extra processor, and you can ramp up
the on-board memory to a mammoth 8 GB. For
all these reasons, the Acer Altos G520 gets our
Best Buy Gold award. 

The runner-up is the ProLiant ML-110 from HP;
with its super I/O sub-system and good overall per-
formance, it takes the Best Buy Silver award. 

The Wipro NetPower 1120 came close but
stumbled on its price—the Acer Altos G520 with
a Xeon processor, and plenty or room for scala-
bility, costs less. 

If you are looking for a cheap but reliable
solution that offers good performance, has good
features but is little more than a desktop PC,
look to Zenith’s Data Server.

sanket_naik@thinkdigit.com

A good I/O sub system makes the HP-ML 110 an ideal
fileserver

OCTOBER 2004
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12 Great Tips T
Follow That Mail
Some service providers, such as
Orange, allow access to your mail
Inbox for MS Outlook. This is
possible for both a GPRS-enabled
as well as a normal phone

Group Hug
A Closed User Group, such as the
one offered by Reliance, lets you
call within the group for free. The
connection charges apply, only
when you make calls between
cities. Evaluate its benefits

Catch the Web
If you own a GPRS-enabled
cellphone or a smartphone with a
Web browser, such as the Sony
Ericsson P900, you can browse
the Internet via the phone

Cross Talk
Make sure that both your PDA and your cell
phone support the Bluetooth wireless
format. This way, your PDA can access the
Internet using the phone as a modem—you
get the benefit of a larger screen!

At a Distance
A PDA with WiFi connectivity can access the
Internet over a much wider range than
afforded by a Bluetooth connection. Make
sure you carry the charging cradle along; WiFi
drains battery fast

Bluetooth
A Bluetooth connection forms a
Personal Area Network. The range
is within a few dozen feet.
Bluetooth devices are common and
cover the gamut—from hand-free
sets to keyboards and mice

WiFI
A WiFi wireless connection allows for
greater range. However, it drains battery
extremely fast. Make sure that your PDA, if
it has WiFi also, has a greater-than-1,000
mAh battery for practical WiFi usage

Wherever You May Roam
Before leaving on your vacation,
make sure that you enable
roaming service for your
cellular phone

Going on holiday,
but can’t afford
to miss family or
work? Here’s
how you can
keep in touch
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To Stay in Touch
Your PC Online
Online services, such as GoToMyPC, let you access your
home or office computer from any Web browser. But first,
you have to open an account. Do that before you are on
your way, at: www.gotomypc.com

Virtual Private Network
Use a Virtual Private Network to connect to your work PC while away
on vacation. A VPN is cheap and secure and is an ideal way to access
your office work while away. (See Case Study, Digital Business, for a
detailed account of a company that successfully implemented VPN)

Wireless Connectivity
Make sure that you laptop has either Bluetooth support or WiFi
support—having both will be ideal. This will allow you to use either a
similarly enabled cellular phone or a PDA to stay in touch wirelessly. WiFi
hotspots are common internationally—in airport lounges, hotels, etc.

Use a Card
If you do not wish to use your cellphone to
connect online, invest in a PCMCIA GPRS card,
such as Reliance’s GTRAN solution. This will
enable connectivity sans the phone

Text Ahmed Shaikh, Photograph Jiten Gandi

Model Gurpreet Singh
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Manage Client
CUSTOMER RELATIONSHIP MANAGEMENT (CRM) is a software solution that
helps businesses manage customer relationships in an organised manner. By
the end of 2002, market analysis firm IDC estimated the CRM market in
India to be worth Rs 40 crore. Is CRM the ideal customer management
solution? We present views from five industry experts who have deployed
CRM in their domains

Oracle CRM leverages Oracle’s single data model to provide
organisations with a single version of ‘truth’ about their
customers. It enables customers to move from fragmented,

high-cost architectures, and improve the quality of their data. The
CRM application is designed to help both marketing and sales aspects
of an organisation by providing sales users at all levels through daily
business intelligence, transaction reports and ad-hoc analyses. It is an
application that can be implemented across different sectors—from
banks, to telecom, to insurance. Training in CRM applications is not
very difficult and helps them manage CRM optimally. However,
unless there is someone at the top who can drive change across the
company, and make decisions when departmental silos disagree, the
technology will never be adopted.

W e specialise in selling solutions.
Unlike a product, a typical sales
cycle for selling a solution would be

between nine to 10 months. The CRM Module
is used as an interaction tool between the
sales people in the US and the support team
in India. The number of companies
approached, contacts made, and the whole
sales loop can be tracked by a support person
in India—with the help of CRM. It helps sales
directors all over the world in accessing data
anytime. The CRM module helps them in
strategising, campaigns, and design the sales
approach. In this way, the sales cycle is
reduced to six to seven months. It
subsequently translates to much higher
profits for the company, and better utilisation
of resources. The training required for the
module varies on its complexity. A CRM
module makes sales management more
effective and shortens the sales cycle of a
solution.

Argho Chatterjee
Inside Sales Specialist
Lionbridge Technology

S P S Grover
Senior Director, Government
Education & Health, Oracle India
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Pritesh Thakker
Manager 
UTI Bank

Rajesh Dixit 
Senior CRM Specialist
SAS India

Like any hospitality entity, Le Meriden uses Fidelio, a Property
Management System. Like any conventional CRM module, we get
anytime data on the number of guests arrived, their duration of

stay, the food they eat. It all helps us judge their likes and dislikes, and
convert them into loyal customers of Le Meriden. In addition, the
module helps keep a list of contacts of people who bring orders for us,
and companies that regularly use our rooms for seminars or business
stay. So, we are in the know of things of who gives us more business. The
module should be ideally implemented in two phases, but most hotels
implement it at one go. The prices for such modules specific to the
hospitality industry also varies. We were charged $76 per room, and a
training stint of 20 days cost us $350 a day. We have been using the
module since 2000. For us, it’s like a magician that helps retain
customers and build lasting relationships.

Harish Chandra
Manager, Area Information
Systems, Le Meriden

At UTI Bank, we always felt the need to provide a uniform and
standard response towards customers. We did keep in mind the
necessity to cater to customer queries on banking products, with

standard answers, and conformed to our intention of customer
satisfaction. We also considered customer feedback, since it forms the
basis of value-added services. Hence, the UTI committee decided to
implement the standard Oracle CRM Suite to manage our
requirements. We just finished implementing the query phase last July.
This tool will be used by our 150-seater call centre to handle customer
queries. All our call centre executives have been trained to maintain
the standards that UTI subscribes to. With this system in place, we
expect to relieve our branches of day-to-day queries. This would help
the staff speed up work. CRM without analysis is like food without salt.
Apart from being used to service customers via phone-banking, the
CRM tool assists in analysing customer behaviour. It enables the bank
to gauge the effectiveness of services, product penetration, and
marketing information. 

As told to Aparna Krishnakumar

Delight
With ever-changing customer expectations and increasing

competition in markets that are already saturated, survival is
getting more and more difficult. Part of the problem is that

most organisations still don’t have a comprehensive view of their
customers. They still don’t understand who their customers are, which
ones are the most prospective or profitable, what their preferences and
attitudes are, and what they respond to. CRM bridges this information
gap by leveraging the organisation’s existing investments in
technology, as well as all of data from multiple sources to give a
complete view of all the customers across channels. CRM enables
organisations to collect, analyse and interpret customer information,
have confidence in the results, and communicate the results across the
enterprise. It helps organisations build more profitable customer
relationships, and retain their existing customers, thereby, providing
them with measurable return on investment. 
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Security: Outsource it?
How does an organisation handle its security? We ask two experts with contrasting views

“Outsourced security gives us
peace of mind”

Shashi Bhusan
IT representative, Students Council, IIM Calcutta

Atul Bansal 
IT Head, BLA Industries Ltd. 

FACE-OFF
Photograph MM

eexxyy  XXaavviieerr

Indian Institute of Management, Calcutta, has 500 students
on campus. Like any other organisation, we have some crit-
ical data that needs protection, such as e-mails exchanged

between the professors and the students, CAT results, Web
casts, message boards, etc. Add to this, the servers and
Internet gateways that need to be filtered for junk mails. The
placement season is a critical time when students’ profiles,
resumes and company-related information become vulner-
able to misuse.

The list of to-do things for IT security may seem large and
one might ideally want a third-party to take care of security
issues. But we have realised that it isn’t healthy to outsource
security completely, or to be entirely dependant on consult-
ants. We have a LAN Squad that consists of 12 members
drawn from both years of management. The Squad is headed
by an IT representative elected by the students. Every
member of the squad is in charge of one server, apart from
the proxy servers. 

We have Norton Firewall for Internet security and the
proxy servers are running on Linux, which has IPtables. Our
gateways also have an Access Control List (ACL) that restricts
the illegal access to our proxy server. Swatch and Trip is used
for intrusion detection. 

Managing the security is a little hectic for the students,
especially during placement season. But it’s a hands-on expe-
rience; from the design to the implementation of a security
system—something you usually don’t get once you start
working for organisations.

We are a 70-year-old company, manufacturing met-
allurgical coke. The link between factory, the coal
mine, and the corporate office used to be a closed

LAN/WAN line. As our usage of the Internet increased, we
realised the need for greater security. Threats keep
changing in names and forms. Prevalence of hacking, need
for constant security updates, and increase in the number
of users prompted us to secure our networks more fiercely
than before.

However, we were just three people managing the IT
needs of the company. We decided that it would be prudent
for a third party to handle the security of the company. After
internal discussions on the kind of security needed, we
approached Trident Infotech Securities to manage our net-
work security. 

Trident has dedicated personnel for every aspect of secu-
rity—anti-virus, firewalls, and storage. We had earlier met
the company in a few seminars for security, had further
meetings on what the company offered, and finally opted for
their services. During the few months during which we had
firewalls installed, we haven’t faced even a single virus
threat. 

An unprotected network is far more expensive than
investing in its security. Having outsourced security, we have
some peace of mind in terms of security updates, patches
and improved versions.

— As told to Aparna Krishnakumar

“It’s not healthy to be entirely
dependant on consultants”



Meera Vankipuram and
Aparna Krishnakumar

orty-year-old Jomiben
Jairanbhai of Madhura
village in Satalpur,

Gujarat, has studied up to Stan-
dard VII, but is adept at using e-
mail—“I learnt how to e-mail
during a workshop conducted by
SEWA. I was a little doubtful, but
equally determined to learn about
the computer and make my world
a little easier.” Jomiben, who is
proficient at Bharathaam, a tradi-

tional form of tapestry, vividly
recalls, “When the designs were
made on paper, we had to maintain
records with great care. Now, with
the PC, we create all our designs on
the computer.” Gauriben B of
Satalpur is also a Bharathaam
artisan, she says, “our art is recog-
nised not just in India, but we also
get orders from abroad, thanks to
our Web site.  Our designs are
stored on a computer and we can
customise them depending on our
customer’s needs.” 

Mobile phones have allowed
these artisans to stay in touch with
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their peers from other villages
about new designs and on the
status of orders.

In a country where women’s
empowerment is a work-in-
progress; a voluntary organisation
has deployed technology to help
women help themselves.

Founded by social worker
Elaben Bhatt, the Self Employed
Women’s Association (SEWA),
based in Ahmedabad, is one of the
most powerful and well-known
NGOs in India. SEWA strives to
achieve self-reliance for women. 

Registered as a trade-union in

Photographs Jiten G
andhi Im
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arayanan
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Women on Top,
the Tech Way

Touched by Tech
Here’s SEWA, an 
all-women NGO that
believes in self-reliance
through technology. No
wonder it bagged
NASSCOM’s Best IT User
of the Year Award



1972, SEWA is an organisation of
self-employed women, mostly
employed in the unorganised
labour sector. The body currently
has a membership of about seven
lakh women, with five lakh in
Gujarat alone, spread over 14
districts. 

This NGO was recently chosen
by India’s apex software body
NASSCOM as the country’s Best IT
User 2004, in the NGO category.

Apart from setting up co-oper-
atives and conducting awareness
campaigns, SEWA provides
supportive services for women—
savings and credit schemes, health-
care and child-care initiatives,
insurance, legal aid, and commu-
nication services. It has also devel-
oped monsoon- and disaster-proof
housing methods, set up fodder-
banks. Interestingly, SEWA has
developed community-based
health centres in a tie-up with
WHO and the Gujarat government.

What sets SEWA apart is its
innovative use of Information and
Communication Technologies
(ICTs) to streamline its operations
and achieve its goals. 

Going Fully Tech
SEWA hit the ICT road with the use
of radio, video, mobile phones, fax
machines, computers and video-
conferencing. These serve as a
means of communication and as

an alternate means of employ-
ment to the rural poor. 

Says Bhatt, “SEWA  provides
computer-based training to
women in local languages. Team
leaders are given mobile phones
and we use video-conferencing and
satellites to communicate with
women in other countries.”

During emergencies, SEWA
uses a satellite talkback commu-
nication programme to convey
relief and rehabilitation meas-
ures to villagers. “SEWA aims to
eliminate middlemen and make
members self-reliant.” 

Technology has also helped
people avert disasters. She cites the
example of a situation in the Kheda
district of Gujarat. When heavy
rains and floods ravaged the
village, the team leaders swiftly
contacted the SEWA District Asso-
ciation offices in Anand, Gujarat
using mobile phones. 

They informed them about the
nature of the damage, and eventu-
ally sought help from the block
administration office. They could
also call the District Development
Officer and the Collector and asked
for medical support  and damage
assessment teams.

Computers Galore 
In trying to increase computer
awareness and literacy, SEWA has
installed 400 computers across
nine districts in Gujarat. Women
are given basic training in
computer literacy skills, with
instructions imparted in the
regional language. Community
Learning Centres (CLCs) have been
set up in several districts to
encourage interest in computer-
based and general education. 

SEWA employs telecommuni-
cation and satellite communi-

cation devices to conduct
educational programmes

on themes such as leader-
ship building, forestry,
water conservation,
health education, child
development, and
financial services.

The organisation

uses radio broadcasts and video
devices to educate people and
study community initiatives.
Video-conferencing makes it
possible for women labourers in
rural areas to interact with their
counterparts in countries such as
Afghanistan, and Pakistan. 

The organisation plans to set
up information kiosks to commu-
nicate government schemes to
people at nominal charges. The
kiosks will offer surfing and e-mail
facilities in rural areas. 

They also plan to provide
community-specific infotainment
content, and create IT-enabled
jobs, such data-entry tasks for
government agencies and SMEs.
SEWA plans to set up region-
specific call centres, in collabora-
tion with local private companies.

SEWA is planning tie-ups with
some big names, such as Reliance,
Tata Consultancy Services and
Oracle India to expand the reach
of its ICT-enabled initiatives.
Oracle India will help SEWA
develop a complete database of its
members. The idea is to trace
their income, health status,
education of their children,
access to savings and credit,
among other things. 

SEWA’s ICT initiatives are
helping women across Gujarat
become tech-savvy and self-reliant. 

Jasodhaben Bhil, 24,  of Vallab-
hnagar, Radhanpur taluka, did
not study beyond SSC. She uses a
laptop with consummate ease to
maintain accounts of savings and
credit groups in her village.

“Initially, I was very appre-
hensive about learning to
operate computers. But after a
ten-day training stint and a little
practice, I am able to use the PC
fairly well.”

Jasodhaben’s excitement is
apparent—“My husband is illit-
erate, but he is proud of the fact
that I know how to work on a
PC!” A shot in the arm for the
women’s movement in India,
courtesy  SEWA. 

meera_vankipuram@thinkdigit.com
aparna_krishnakumar@thinkdigit.com

Digital Leisure l Touched by Tech

I learnt how
to e-mail
during a
workshop
conducted by
SEWA 
Jomiben
Jairanbhai of
Madhura village,
Gujarat

IT User Awards: How SEWA Did IT 

According to NASSCOM, the IT User Awards were based on a survey
model developed by research firm IMRB to assess an organisation’s

“e-Readiness or preparedness to adopt ICT infrastructure to boost their
business excellence.” According to Sangeeta Gupta, Vice President,
NASSCOM, “We realised that IT-usage among the NGO community in India
was quite low, and decided to find out how many voluntary sector
organisations are IT-savvy. Out of the 10 organisations surveyed, SEWA
showed how best IT could be leveraged to achieve the ‘digital unite’,
through their innovative use of computers, mobile phones, et al.”

Riyaben Rana
Aaiyer uses the
mobile phone to
replenish supplies
for her
Bharathaam
embroidery
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Before eBay or eTrade, this
Web site was the first ever to

conduct a secure retail transaction
over the Internet on August 11,
1994. It sold the CD “Ten
Summoner’s Tales” by Sting for
$12.48. Name the Web site.
a. Amazon
b. Orbitz
c. NetMarket
d. Traf-o-Data

Nichia Corporation and former
employee Shuji Nakamura

have locked horns over a patent of
a product that Nakamura had
supposedly invented. Six months
ago, the Tokyo High Court ordered
the company to pay 20 billion yen,
which Nichia is contesting. What is
this product they are fighting over?
a. Blue LED 
b. CD 
c. DVD
d. Paper Disc

Microsoft had to recall
2,00,000 pieces of Windows

95 from India. What was the
reason behind the big move?
a. It had 8 pixels in different colour
representing Kashmir, which, for
them, was “disputed territory”
b. Faulty registration codes
c. Poor packaging
d. The Spanish version got shipped

WWiSE, a group of
technology companies,

including Texas Instruments Inc.,
STMicroelectronics and Broadcom
Corp., recently proposed a new
wireless networking standard—a
version of an 802.11n standard.
What is the speed that this
technology offers?
a. 400 megabits per second
b. 500 megabits per second
c. 540 megabits per second
d. 640 megabits per second

The eBay rulebook says that
one cannot sell stuff that one

doesn’t own, and so they had to
stop the auction of a European
country that was being sold for six
pounds! Can you name the country?
a. The Netherlands
b. Belgium
c. Finland
d. England

US-based Turbine
Entertainment Software will

release a virtual world in 2005
that would allow thousands of PC
owners to step into their favourite
world and create characters as
well. Can you identify the book on
which this virual world is
modelled? 
a. The Age of Empires
b. The Harry Potter series
c. The Lost World
d. The Lord of the Rings
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Crossword 
Across: 1. Limit, 4. Monitor, 8. Content, 9.
ISP, 10. Logo, 11. Web, 12. ECAT, 15. Norton,
16. Canada, 19. Time, 21. TCP, 22. Edit, 26.
Day, 27. Extreme, 28. Numbers, 29. MIS
Down1. Local, 2. Manager, 3. Tree, 4.
Motherboard, 5. NIIT, 6. Topics, 7.
Rosetta, 13. Dot, 14. CAT, 15. Netizen, 17.
Address, 18. Access, 20. Modem, 23.
Theta, 24. Byte, 25. Item
Quiz
1: a, 2: c, 3: a, 4: a, 5: c, 6: b, 7: d, 8: b

Across
1. Extreme value (5)
4. Computer display of tropical 

lizard (7)
8. Swindle portable shelter for

subject information (7)
9. Internet Service Provider (abbr) (3)
10. Company emblem (4)
11. ‘w’ in www (3)
12. Electronic Card Assembly and Test

(abbr) (4)
15. Symantec’s anti-virus solution (6)
16. Country with domain ‘ca’ (6)
19. Fundamental unit scatters mite

(4)
21. Transport Control Protocol (abbr)

(3)
22. Changes in a file reverses a

current (4)
26. Period of 24 hours (3)
27. ___________Programming (XP) (7)
28. Numerals (7)
29. Management Information

Systems (abbr) (3)
Down

1. ‘L’ in LAN (5)
2. A conductor of programme for

basic computer operations (7)
3. _____ Structure, parent-child

data organiser (4)
4. Main circuit________board in a

computer (6)
5. NUST Institute of Information

Technology (abbr) (4)
6. Subject of study upsets optic

(5)
7. Tech target site disrupts

toaster (7)
13. A period or decimal point (3)
14. Computer Aided Testing

(abbr) (3)
15. Cybercitizen (7)
17. Location of an e-mail user (7)
18. Log on a straight line, we hear (6)
20. Hardware device connecting a

computer to a phone line (5)

23. 8th letter of the greek alphabet is
an object-oriented
language (5)

24. Eight bits(4)
25. Strange moat is the smallest

component of an element(4)

Compiled by Nitaa Jaggi

Crossword 

Answers

Got an
interesting
question? 
Send it in with
the answer to
editor@thinkdig
it.com

LED Wars, And Countries On Sale

According to research firm
IDC, the number of

mobile phone users
worldwide will touch 1.4
billion by the end of 2004,
of which India accounts for
40 million.

Did you
know?

David Beckham’s text
messages with PR

executive Rebecca Loos has
not affected his status of being
the brand ambassador of this
telecom company with whom
he signed a new one-year
contract to promote its live
mobile portal service. Name
the company. 

a. Hutch      b. Vodafone
c. Viacom    d. Samsung

8

Jeffrey Lee
Parson

pleaded guilty for
creating a variant
of the original
worm that
affected an
estimated
1,20,000 computers around the
world in the summer of 2003. Can
you guess which variant this is?

a. MSBlast.B    b. MSBlast.A
c. Sasser A      d. Sasser B

1
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Not In iTune With Asia
ASIA IS THE hotbed of new technology, at least when it
comes to adopting personal entertainment systems.
MP3 players are one of the hottest selling
gadgets here, but in a continent riddled
with piracy, is it any wonder that buying
music online is almost non-existent? Time
magazine’s Bryan Walsh tried to find out
why:

All Nick Freer wants is his digital music,
and he’s even willing to pay for it. When the
Hong Kong-based client-services director
bought an iPod, it came with software to link
with iTunes, Apple Computer’s fee-based
Internet music store that now dominates 70%
of the online-music market. From his
computer, Freer can browse every one of
iTunes million-plus songs. He just can’t buy
any of them—consumers can only purchase and download
iTunes tracks now in the U.S., the U.K., France and Germany,
because the service only takes credit cards issued in those
countries. “I find it very annoying,” says Freer, who instead
swaps music with friends and uses file-sharing networks. 

Commercial online-music sites have hit it big in the US
and Europe, thanks to the success of iTunes, which recently

sold its 100 millionth song. Even Microsoft is
shouldering its way into the business. Last week,
the software giant launched its U.S. online-music
store, MSN Music. But to the frustration of
millions of willing Asians with MP3 players and
broadband connections, buying the latest hits
online is difficult, because the big U.S. music
sites are ignoring the region and local
alternatives are few. 

An Apple spokesman declined to discuss why
iTunes is not offered in Asia, saying they don’t

talk about future marketing plans in the press. But
according to industry experts, the added complexity of
licensing music and handling digital rights in unfamiliar
territories and fractured markets has dissuaded heavies
such as iTunes, RealPlayer and Wal-Mart from catering to
Asian users for now. Rampant online piracy in places like
Taiwan and South Korea also means that many recording
labels in Asia still view the Internet as an enemy, not a sales
opportunity. They don’t want to license tunes to online
sellers, fearing songs downloaded legitimately would soon
be widely circulated illegally. One of the main online
priorities right now, says Yashudi Ide of Sony Music
Entertainment, the Japanese electronic giant’s record label,
“is to protect copyrights.” 

A handful of enterprising entrepreneurs find that
attitude anachronistic. They’re trying to make space in
Asia’s $5.2 billion music market for legal downloads. In
1999, Sudhanshu Saronwala quit his job as the managing
director of MTV Asia to co-found the Singapore-based
online-music store Soundbuzz. The venture made little
progress for four years, but after iTunes proved a
commercial success last year, Saronwala is trying again.
“The labels have seen that online can be a real, viable
distribution channel,” says Saronwala. 

To read the entire article, visit http://snipurl.com/whereisthemusic

Time Magazine

Jobs Galore, Or Just A Mirage?
HERE’S AN INTERESTING article from Time that talks us
through the paradox of the job market in the IT sector in

India. It’s an insightful piece on the
crushing unemployment problem despite
the trumpeted hiring spree:

For job seekers in India’s tech sector, it’s
the best of times—and the worst. When
Venugopal Rao Moram, a 29-year-old software
engineer living in Bangalore, began looking for
a new job in June this year, it took him just two
weeks before he found the work he wanted—a
position with Microsoft in the city of
Hyderabad. “The moment you put your résumé
on the Internet, the offers start coming in,”
says Moram, who’s been working in the tech
sector for six years. “Everyone looking for a
job has at least five offers.” 

Lalit Kumar, a 22-year-old resident of New Delhi who
works part time as a data-entry operator, hasn’t found the
job market quite as receptive to his talents. Kumar, one of
the tens of thousands of young Indians who thronged a giant
IT job fair in the city’s Pragati Maidan exhibition center on
Aug. 23, squats in a corner of the hall at the end of a long

day. He’s been trying to hand
out résumés all morning, but
no recruiter has bothered
taking one. “Everyone in Delhi
wants to be in IT right now.
There are a hundred applicants
for every post. It’s impossible
to get a job unless you have
experience,” he says. Pankaj
Kamboj, a 22-year-old recent
engineering graduate who has
come with a half-dozen friends
from the neighboring state of
Haryana, complains: “We’ve
traveled 200 km for nothing.

There are no software positions here, only call-center jobs.” 
India’s tech sector is in the grip of an extraordinary

paradox. With almost all tech companies on a hiring spree,
there’s never been more demand for élite employees who
have attended the right colleges or have a few years’
experience at a prestigious company. Yet for hundreds of
thousands of starry-eyed young men and women who are
drawn to the IT sector in the hope that it will provide a way
out of India’s crushing unemployment problem, the promise
of a high-paying job is turning out to be a mirage.

India’s tech companies are expected to hire 75,000 to
100,000 people this year—a 50% increase compared with
last year-because after years of relatively sluggish growth,
the sector is roaring again. Revenues for India’s IT
businesses will grow by a heady 40% this year, according to
Vijay Baoney, a technology analyst at Indian brokerage
house Enam Securities. The problem for companies is finding
enough midlevel executives who can train, groom and
oversee the influx of raw recruits. “Experienced hires are not
there on the scale that the industry needs them,” says Hema
Ravichandar, head of human resources at Infosys, one of the
three largest Indian IT companies.

For more, visit http://snipurl.com/indiajobs

MediaWise



Wired, September 2004

Churning Out Warriors,
Virtually

HOW LONG DOES it take to
convert tech fiction to
become science fact? If you
are in the US army, not
much. Wired, the magazine
that redefines writing, sent
contributing editor Steve
Silberman to the facility
where the next generation
US soldiers are being
trained. He came back with
this report.

Twisted rebar, concrete,
and splintered furniture lay scattered across the floor of this
room. Our view through a jagged hole in the wall looks out on
the city, showing steady civilian traffic crossing a bridge over a
river below. Sparrows flap through the gray haze, and Arabic
music and the voices of merchants filter up from the street.

An Army major beside me, Paul Tyrrell, scans the high-rises
on the other side of the river through his laser rangefinder. He
is the frontline eyes of the coalition, responsible for calling in
air strikes. A platoon sergeant named Donald Prado tells Tyrrell
that an office tower half a mile to the west is an enemy
stronghold.

In eight minutes, coalition soldiers will storm across the
bridge. Prado radios in for the Air Force to drop a smoke screen
for cover. He’s also spotted snipers on the roof of a hospital to
the north but cautions the major that the civilian facility is off-
limits to targeting.

Then Tyrrell sees something Prado missed: Three of the
antennas on the roof are tactical radio masts, a tip-off that
insurgents are using the hospital as a communications base. 

“That’s a high-payoff target,
brother,” says Tyrrell. He gets approval
to deliver a “limited lethality”
fragmentation bomb to the hospital
roof. The office tower will receive the
full treatment—a 1,000-pound GPS-
guided bunker buster.

Seconds later, the missiles smash
into their targets in perfect synchrony.
Smoke and dust billow out in bright
plumes, followed by shouts and the
keening of ambulance sirens.

The air is thick with heat, but it’s
not the merciless 120-degree swelter of
Baghdad. It’s late spring in Lawton,
Oklahoma. We’re in the battle lab of an
Army base called Fort Sill, and the air-

conditioning is on the fritz. The river, the bridge, the civilian
traffic, the birds, the bombs, and Sergeant Prado are all
virtual—a simulation generated by flat-panel displays on the
walls, a subwoofer in the floor, and half a dozen Windows and
Linux boxes down the hall. Only the smashed furniture, the
officer standing beside me, and the adrenaline spikes are real.

This is the new way soldiers will train for battle. 

To read the entire story, visit http://snipurl.com/warroom
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The Best Thing To Go Around With!
No, not the girl in this ad. It’s the Motorola V80. For the
creative mind, life does come a full circle with this cell phone
that would put a contortionist to shame. Mind-spinning ads,
money-spinning products—Motorola is truly an allrounder

Honey, How Do I Look? 
It sometimes pays to stop beating about the bush, and call a
spade, a spade—or, a plaything, a plaything. Canon doesn’t
mince words in this ad. Forget finesse, art, travel, memories—
here are digital cameras that are designed to pamper you
like never before.

Michael Macedonia
Head of the Simulation Office



132 DIGIT OCTOBER 2004

FirstEscape

Rumours about finding
an alien civilisation
spread across the

Internet on September 1,
following a report by New
Scientist that an interesting
signal had been picked up
by SETI@Home’s radio
telescope in Puerto Rico.

New Scientist quoted Dan
Wertheimer, chief scientist
at the SETI@Home project,
as saying that the signal
was the “most interesting”
identified thus far. “We’re
not jumping up and down,
but we are continuing to
observe it.”, he remarked.

Now that’s just the kind
of stuff rumours are made
of, and Wertheimer had to
tell the BBC the next day,
September 2, that the idea
of contact with an alien
civilisation was all “hype
and noise”. “We have
nothing that is unusual”,
he said, “It’s all out of
proportion.”

Out of proportion it may
have been, but what
prompted the initial report
that something interesting
was picked up? It turns out
that the signal was picked
up at one of the main
absorption frequencies of
hydrogen-SETI’s favourite

place to look for deliberate
signals from other worlds.
Scientists at SETI said that
the signal had not been
observed long enough for it
to be properly analysed, and
there is plenty of room for
explanations. It could be a
natural phenomenon, they
said, or ground-based
interference-or even the
possibility that somebody
had hacked into the
SETI@Home program!

PHISHING

Hijacking is
Fun, Jail isn’t

Phishers were suspected
of having managed the
domain-hijacking of

the eBay Germany site on
August 28. But on
September 4, German police
arrested a 19-year-old

responsible for
the act. 

For several
hours, visitors to
eBay Germany
were redirected
to a site hosted by
Internet provider
Intergenia AG. This
caused quite a loss in
revenue for the auction
giant.

It came as something of
a surprise that the 19-year-
old is not a computer nerd,
as the police confirmed.
What he did was to request
a DNS transfer for several
high-profile sites including
Google, Amazon, Web.de
and eBay Germany. Most of

Think you have the most
beautiful, most innovative

desktop around? Send it to
mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm,,  and
Digit shall publish the most 
eye-catching of them every month.

PLANE SILLY: Where ‘crashing’ takes on a new meaning.
Sent by Vaibhav Joshi

My Desktop

Bankofindia.com

Ever tried applying for a
credit card with Bank of

India? Their Web site has a
section for card products.
However, the only link to
download a credit card
application form is missing.
The bank boasts of being in
the credit card business since
1988 and claims to be a
pioneer in the field! In the
age of virtual money, when
128-bit encryption and similar
security measures are giving
credit card transactions the
long-awaited recognition as a
viable online shopping
option, this hurdle in the very
first step comes across as a
major put-off for customers.
Talk about unusable!

Navigation Headed For A Whole New Way
Navigation software specialist ALK will allow Windows
Mobile-based smartphones to be used as in-car map-
readers this September. The software will provide both
2D and 3D maps with spoken directions for navigation
while in motion.

Enough Of SPIT, Time For It To Quit
First there was regular spam, then cell spam. And now
there’s SPIT, or Spam over Internet Telephony. Not many
companies received SPIT so far, but there’s one out
there that aims to nip SPIT in the bud. Qovia Inc filed
two patent applications for SPIT-thwarting technology.

SEARCH FOR EXTRA-TERRESTRIAL INTELLIGENCE

The Day Aliens Came Calling!

Illustrations Farzana Cooper

The winning entry will win a
KUSBDTI/128FE USB stick
worth Rs 1,300. This month’s
winner is Utpal Pande.
Sponsored by
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the transfers were denied,
as expected, but for some
reason the eBay request
went through.

Interestingly, the boy
says he did it for fun, and
that he didn’t believe it
would be possible. He used
existing tools on the
Internet, without any
sophisticated hacking
techniques. This leaves open
the question of how many
other, high-profile sites are
in danger of being hijacked.

Also, if it’s so easy, why
hasn’t something like this
been done more often -
especially when it turns out
that the tools to do it are
right there on the Net?
There’s a lot of money to be
made off attacks like this
one. Once the site is
hijacked, the hijacker has
potential access to users’
usernames, passwords,
credit card numbers and
other such juicy stuff.

ONLINE DATING

Divorce And
The Internet

Statistics from the UK’s
Office of National
Statistics recently

reported that divorce rates
in England and Wales have
risen for the third

successive year, from 2001
to 2003. Can there be a link
between divorce and online
dating sites? There can,
according to Relate, a UK-
based counselling service.
Christine Northam, a
counsellor at Relate, said
that sites such as Friends
Reunited bring together
former lovers, which in turn
hastens the breaking up of
existing relationships.
However, Northam also said
that there were other
factors at play here as well -
including work pressure
and a decrease in the
stigma associated with
divorce.

The number of Web sites
that act as a bulletin board
for people seeking old
school friends and
colleagues have risen in the
past five years.

A spokeswoman at
Friends Reunited said that
it was incorrect to suggest
that such sites are

undermining marriages and
families. Explaining the
innocence of sites such as
Friends Reunited, she said,
“We are no more to blame
for divorce rates than the
advent of the telephone. We
are an intermediary and we
... reunite …what occurs
afterwards is beyond our
control.”

FriendsReunited.co.uk
does seem to make it really
easy, though, to find old
flames - there are over 11
million members, and it’s
free to search for old
friends.

DVD OVER INTERNET

Ring One 
Up For
Panasonic

It may seem like luxury to
the point of uselessness,
but still, it’s a first.

September 8, Panasonic
announced a DVD recorder
that you can programme
over the Internet and via
cell phone as well. The DMR-
E500H has a 400 GB hard
drive, which makes for 700
hours of recorded video. It
will be available in Japan
beginning September 21.
This, and similar players let
you watch a program from

The Age of Software, Not Soft Toys

“Child’s Play” sent in by Frederick Noronha, Goa. Congratulations!

This year, the pixel turns
50. Yet, how many of us

are aware?
1954, the year the tran-

sistor radio was invented,
also saw the birth of the
pixel in New Jersey, USA. At
Princeton’s Institute for
Advanced Studies, an enter-
prising team of mathemati-
cians and engineers created
the first ever computer
graphic. Their breakthrough
effort saw the first instance
of digital typography-on a
computer the size of a
Manhattan apartment! The
Princeton’s pioneers used a
small matrix of glowing vac-
uum tubes to spell out let-
ters. It was the first ever
instance of mapping com-

puter memory directly to
dots in a display.

Soon, the earliest person-
al computers, with 300 x
200 screens, sprung up.
They came with a separate
‘text mode’, which still fea-
tures in Intel-based comput-
ers. 30 years after the
geniuses at Princeton’s cre-
ated the first pixel,
Macintosh entered the
scene. And we saw the first
PC that treated on-screen
text as just another graphic.

Fast forward to 2004-pix-
els are everywhere. Today,
most of our sources of enter-
tainment and work are bro-
ken down into pixels, and
disseminated digitally
through satellite, cable,
compact discs, and the
Internet. The brainchild of a
bunch of New Jersey mathe-
maticians and engineers has
revolutionised the way we
see the world.

The Pixel

People Who
Changed

Computing

WIN!
An APUS Pen Drive worth
Rs 2500 just by sharing an
amusing picture which a
tech angle to it.

Send your picture to
ddiiggiippiicckk@@tthhiinnkkddiiggiitt..ccoomm..  
prize-winning picture will
be published every month.

Sponsored by



an earlier moment in a live
broadcast - courtesy: the
hard drive.

Panasonic said the
recorder offers high-speed
dubbing from its hard drive
onto DVD-RAM and DVD-R
disks. It can record a 1-hour
program onto a DVD-R disk
in just 56 seconds, the com-
pany claims. 

Connections include an
Ethernet port and a broad-
band receiver. Use the
Ethernet connection to
view MPEG4 video and JPEG
photos on a PC in another
room. Using two such
recorders, you can access
MPEG2 video on one by the
other via the LAN.

P2P SUES RIAA

Poetic
Justice

For a change, a P2P
company has sued the
RIAA over a patent.

Altnet, a subsidiary of
Brilliant Digital
Entertainment, says the
RIAA infringed on one of its
patents in the course of its
efforts to enforce copyrights
on P2P networks. Also
named in the lawsuit are
Overpeer, a copyright
company, and
MediaDefender.

Altnet has been looking

for funding
sources and
ways to
strike back at
the record
labels’ efforts
to
undermine
P2P
networks. In
2003, it
announced
that it
purchased
patent rights
to the
process of identifying files
on a P2P network using a
hash, or digital fingerprints
based on the file’s contents.

Altnet’s lawsuit centres
on the fact that despite
being notified several times
in 2003 about the patent,
RIAA executives continued
to support Overpeer, and
conducted their own
enforcement procedures on
the KaZaA network, thus
infringing the patent.

Overpeer is a ‘spoofing’
company that posts
millions of false or
corrupted files on networks
such as KaZaA, which
makes real files hard to
find. Media Defender uses
‘interdiction’ techniques,
which clog networks with
requests that block
download efforts. Both
these services use
unauthorised versions of
KaZaA and the underlying

FastTrack P2P technology.
Altnet contends that this
means they are using their
patent without permission.

PRIME NUMBERS CRACKED?

A Disaster 
For All 
e-commerce?

September 7, 2004, The
Guardian newspaper’s
headline screams:

“Maths Holy Grail could
bring disaster for Internet.”
That headline is as
tabloidish as they get. But
then, maybe not. It depends
on whether Louis de
Branges has really solved
the Riemann hypothesis. If
he has, “Financial disaster
might follow. Suddenly all
cryptic codes could be
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System
Administration
Saturday Night Special
TA quick and dirty hack written
to save your weekend! These
programs routinely break every
rule in software development
books but are still popular
because of a simple reason - they
work!
BOFH:  Bastard Operator
From Hell
The role model. Someone who
will not stand acts of stupidity
perpetrated by users on their
servers. The steady state that
every sys admin strives not to
attain but invariably ends up in
after a few months of
administration.
MCSE: Must Consult
Someone Experienced
Used to denote some of the rare
situations when someone really
experienced has to be called for
help. Usually results in a few
sleepless nights on mailing lists
where ordinary mortals would
not dare to venture.
Shebang
Probably the most frequently
typed character-pair by a
sysadmin, it stands for the “#!”
typed at the beginning of every
script to set the location of the
interpreter/shell executable that
has to run the script.
Snark
Refers to unexplained (hence
suspicious) activity reported in
system logs which if investigated
properly could avert disastrous
events such as a security breach.
Sanity Check
A “simple, routine” procedure
undertaken to ensure that all is
normal in server land, it includes
a variety of scripts (off-the-shelf
and homegrown) that report any
suspicious activity to the
concerned IT staff.
Playpens
A special environment in which
the server is configured such that
attackers and malicious users are
first detected and then actively
misled into believing that they
are gaining a strong foothold into
the system. In the mean time
security-staff track them
continuously to gain valuable
forensic data.

Once in a while , here at Digit, process-
es change hands, people are intro-

duced into entirely new situations, and
responsibilities. Why? Because it helps to
build a stronger organisation, and gives
our employees firsthand experience of
varying processes, and newer, more
uncomfortable places to sleep.

Raaabo (Robert
Sovereign-Smith to the
world) was given one
such opportunity. He
went from copy editing the magazine to
content coordinating the DVD and CD.
Sounds simple enough, right? Wrong!
The only similarity was the thousands of
little things he had to worry about? It
went from thousands of words to thou-
sands of MBs!

Somewhere along the way, he realised
that the DVD needs to be sent for replica-

tion long before the magazine! Ouch!
Shorter deadlines! Which obviously
meant longer hours in the office? Caused
mainly due to his bumbling about, and
deleting the wrong folders in his sleep!
We walked in a few mornings and found
him sound asleep on his chair, and other
mornings, he seemed to have disap-

peared...until we found
him asleep under his desk.
For over a week, his life
revolved around his 4x4

foot workspace, and he finished the DVD
just three days past his deadline!

So cheers to Raaabo! Hope he’s got
the hang of things, and finishes the
DVDs on time from now on...mainly
because none of us wants to tell his wife
when she calls, “No, you can’t speak to
him because he’s drooling over the car-
pet under his desk...sound asleep!”

The DVD Hollowcast



breakable. No Internet
transaction would be safe.”

So what is the Riemann
hypothesis? It’s too complex
to explain in its entirety
here, but in essence,
proving it would explain
the seemingly random
pattern of the sequence of
prime numbers. And prime
numbers are at the root of
cryptography, and hence,
security of transactions on
the Internet and elsewhere.

What has happened is
that this year, Louis de
Branges, a French-born
mathematician at Purdue
University, claimed a proof
of the Riemann hypothesis.
His colleagues have
remained unconvinced thus
far, and the mathematical
community is sceptical.

Prof Marcus du Sautoy
of the Oxford University
explains, “The whole of e-
commerce depends on
prime numbers. I have
described the primes as
atoms: what
mathematicians are
missing is a kind of
mathematical prime
spectrometer. If the
Riemann hypothesis is true,

it won’t produce a prime
number spectrometer. But
the proof should give us
more understanding of how
the primes work, and
therefore the proof might
be translated into
something that might
produce this prime
spectrometer. If it does, it
will bring the whole of e-
commerce to its knees,
overnight. So there are very
big implications.”
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Om Malik on Broadband
http://www.gigaom.com/2004/09/the_voice_over_i.php

The Voice over IP Insurrection
The VoIP insurrection over the last decade marks a
milestone in communication history no less dramatic than
the arrival of the telephone in 1876. We know data
networks and packetized voice will displace the long
standing pre-1995 world rooted in Alexander Graham
Bell’s invention. It remains uncertain whether telecom’s
incumbent carriers and equipment makers will continue
to dominate or even survive as the information
technology industry absorbs voice as a simple application
of the Internet.

Mike 
http://www.techdirt.com/

Why Online Newspapers Require Registration
The main reason most sites require registration: spam.
Direct mail marketing companies are offering ridiculous
($300 CPM) fees for email lists of registered newspaper
readers for spam purposes. 

Never mind the fact that many of those email
addresses are bogus dirty data, the newspapers see cash
from spam. This isn’t, as they claim, about having more
detailed demographic info to “more accurately target
advertising,” but about having your email address to sell
to spammers. Once again, BugMeNot becomes a useful
anti-spam tool. It seems hard to believe selling email
addresses to spammers could be a successful long-term
business strategy.

JC (Knight)
http://www.seochat.com/showblog/282/The-new-face-
of-cybercrime

The New Face of Cybercrime
Today’s hacker isn’t just out to show off, they’re just

in it for the $$$. Read the ‘full story’ for a very insightful
look into today’s state of affairs, and the means
necessary for protection. 

[Reference URL: http://news.com.com/2010-1029-
5275150.html?tag=nefd.acpro]

Most spammers want to “phish” your credit card
number. Messages now zip around the Internet purporting
to come from trusted companies and asking you to “verify
your account.” This is the new face of cybercrime.

Alex D
http://killthespam.blogspot.com/

Respect and the Internet 
On television, in print, or on the radio, ads disguised to
look like an emergency warning would be pulled
immediately. Why is this practice permitted online?

We humans have turned the world of computers into
virtual living. As a computer operates like an individual
mind, the Internet mimics the global community.

When you are online, you are virtually taking a
walk down the street. Entering a site is like being
welcomed as a guest into another person's house. If
you're rude and attempt to start disrespectful
arguments or fights, the owner has the right to throw
you out and repair damage. 

Here’s taking a look
at a few riveting
posts from the world
of blogs. This month,
we examine a
discussion on the
VoIP revolution,
across the globe.
More on spam—why
online newspapers
require registration,
the new face of cyber
crime, and why
spamming is “the
online equivalent of
the teenagers who
drive around
smashing mailboxes.”

S
ome say, it’s impossible to
foretell death, some say,
it’s not. Some don’t give a

hoot about kicking the bucket,
while some freeze at its
thought. Here’s a Web site that
actually tells you when you are
going to die-exactly when! As
you visit www.deathclock.com,
you will be greeted with the
punchline—‘Death Clock: The
Internet’s friendly reminder
that life is slipping away...’ 

An info box, laid out with utmost matter-of-factness, asks
for your date of birth, sex, and whether you are a pessimist,
optimist, sadist, and what not. That’s not it. It has something
called a body-mass index, which is calculated using your
height and weight. Deadly jargon, eh? After this ludicrous
round of inputs, hit the blood-red ‘Check your Death Clock’
button. And Voila!—the exact date of your looming death!

Don’t waste time in trying to get over the shock-there’s
work to be done. A Deathclock poll invites you to cast your
vote on exactly how you think you are going to die! Deadly
democracy, isn’t it? Draft your Will, or take your time and com-
pose that last prayer. And have faith people, a section actual-
ly helps you postpone your death, with the perfect recipe to
boost your longevity!

While you keep rummaging Deathclock to find out how to
die another day, we try to figure out why on earth they made
such a site. Chances for both are dead as a dodo. Woody Allen’s
famous confession keeps haunting—“It’s not that I am scared of
death. I just don’t want to be there when it happens.”

whatweretheythinking.com

www.Deathclock.com



GRANT IMAHARA IS no amateur. He
works on animatronics and model-
making for George Lucas’s Industrial
Lights and Machines and was one of
the geeks behind R2-D2 in Star Wars.

Imahara sticks to the basics and
practicalities of serving his passion-
designing and building robots fit for
the battles of BattleBots. And in this,
he leaves nothing out. Right from
picking up the paper, designing the
robot components, selecting tools, to
assembling drives and control systems,
to what not.

A better part of the 500-page book reads like a
starter course on workshop technologies. If you
have been nurturing that fantasy of having a wire-
bristling pet someday, go get a copy of this book.
Don’t worry about skipping a page or two and
landing up clueless. You can trust the detailed
troubleshooting sections.

The book is also a must-read for those who love
tinkering with homegrown mechanics. The richly-

illustrated pages will guide you through
metalworking, fasteners, housing and
installing motors, mountings,
transmissions, wheels and tracks, power
system, and even pneumatics for
gizmos.

The book doesn’t shy away from
doing the mathematics wherever
required, sprinkling essential formulae
at several places. However, the
Appendix provides all the specs in
American standards.

Grant gives us a lowdown on IFI
system programming without actually
intimidating with gory details, in the
Appendix. Another gem is a wealth of

online resources provided in the Appendix.
In Grant’s own words—“This is an expensive

sport, and you should have an idea of what you are
getting yourself into.” His introductory robot costs
around $4,000.

Rahul Singh
Robo Toys: An Illustrated Step-by-Step Guide To Building Robots
Publisher Wiley Publishing, Inc.
Author Grant Imahara Price Rs 349 
E-mail wdt@vsnl.net Web site www.wileydreamtech.com
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One For the Bot Killers

YOU PLAY JACK Carver—stranded on an
island with a pistol, a bad temper, and a
taste for bot gut. Before each mission,

you have to endure a singular long
load. This is one of the primary
reasons that there’s a seamless

transition as you move from coast to
coast or the indoors to the outdoors.

Whilst playing the game, there aren’t
any loading hassles in between, but the
territory comes with an irritating
encumbrance in terms of the save
mechanism. The game will only pause
occasionally during checkpoints, which
is where a save point is created. You
cannot save your progress in the game
whenever you feel like, and in a game
such as FC—offering more than 20 hours
of reasonably tough game play—this can
be tiring.

The AI in FC is something else. Bots
show their inhospitality rather
vehemently. Once they see you, fighters
will summon fellow coded gun slaves, or
follow you for a considerable distance.
All-in-all, Crytek has come up with a
gem of a game.

SKOAR! 

Shocking and Awful!

BACK TO BAGHDAD picks up from where its
predecessor left off. Surprisingly, BTB is
still set in 1991.  

BTB, however, disappoints hugely on all
fronts. America may have won the war, but
Pivotal Games is fighting a losing battle
against bad gameplay. To its credit, the
missions are varied.

You start off by rushing to the rescue
of a downed chopper à la Black Hawk Down,
then blowing a communications station to
Kingdom Come, getting caught by a bunch
of ferocious Iraqis, escaping (and blowing

up a chemical weapons plant, if you
please), and finally neutralising ‘super-
guns’. There are 10 agony-filled missions.

The default view is from a third-per-
son perspective, where moving around is
relatively easy, but accurate firing is
impossible. The first-person mode just
doesn’t have the FPS feel to it.

There isn’t a single hotkey for any
weapon in the game. It might be excused
on the grounds of trying to make combat
more realistic. If any joy was to be wrung
out of the game at all, it’s killed by the
poor ‘inventory management’.

SKOAR! 

Desert Storm II—Back To Baghdad
Publisher SCi Games 
Developer Pivotal Games 
Web site www.conflict.com

1. Driver 3 PlayStation 2 
Rs 2,999
Milestone Interactive Software Pvt Ltd

2. Need for Speed Underground
Rs 1,299
Gayatri Impex Pvt Ltd

3. Jumpstart 
Rs 699
Express Interactive Software P Ltd

4. Counter-Strike
Rs 699
World Wide CDRoms

5. Harry Potter: Prisoner Of 
Azkaban
Rs 1,299
Gayatri Impex Pvt Ltd

Far Cry
Publisher Crytek  
Developer Ubisoft
Web site www.farcry-thegame.com
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Smart Cards, Smarter Bar
Codes
Sachin Kalbag's editorial on the incorrect
use of smart cards was enlightening. The
purpose of a toll booth is to collect toll on
a monthly basis from regular users and
spot toll from casual users. 

The sticker he referred to was for the
monthly user, the purpose being to
identify the vehicles who have paid for
the month.

A simpler solution would be to print a
sticker with a bar code. As soon as the
vehicle approaches the toll booth, the
attendant with a simple bar-code scanner
scans the barcode into the PC, the PC
would authenticate and if the vehicle has
paid for the month a green light would
light up, else a red one would light up
along with an audible beep, and the gate
at the far end would not open. 

For this new regime, only a new bar
code sticker would be required instead of

the expensive smart card. Even if this bar
code sticker is lost, stolen or damaged, a
new one could be issued at a ridiculously
low price of less than a rupee. 

This simple solution costs far less
than a smart card-based solution, and it
is much faster. There is no need of a “dog
tag” and it is simpler to implement. 

Apart from providing another unique
Identity Code to each vehicle (first on
being the registration number), which is
also not needed, I see no purpose of using
smart cards in toll booth kind of usage.

Sanjive Mehta,
New Delhi

Phone Moan
Many people wonder why Internet
services in India are most hated. I used
to wonder, too. Until I found out for
myself a few weeks ago. I have an MTNL
Internet account. I could not get past the
login screen. I called the MTNL Internet
Services Hotline. Here is what happened: 

The person who picked up the phone
(let’s call him A) told me to check the
number of the error. I did so and called
back, only to find a different person
(let’s call him B) on the line. 

I had to explain my problem all over
again. This person told me to dial a
different number and find the duration
for which I can hear a fax tone. I did so
and called back. This time A picked up
the phone. I disregarded the fax line
report and told him the number of my
error. He told me to dial MTNL’s phone
line number. 

I called that number only to find
that it was not in use! So I dialed the
Hotline again; now B picked up the
phone. So I gave him the duration of the
fax tone. He asked me to dial the same
number which A had given. I told him
the number was not in use. He asked me
to find the number MTNL's phone
service to ask them to repair my line as
he felt the problem was in my phone
line, and not the Internet connection.

Three days, and numerous attempts
later, I found the ‘working’ number for
MTNL's local phone service in my part of
Delhi, only to find that my phone line
was perfectly ok! So I dialed the Hotline
again, and a third person picked up the
phone. 

With a sinking heart I told him my
problem all over again. This person,
however, immediately gave me a new
password and told me to try again.
Miracle! It worked.

While I was happy to get my Net
connection back, it was a harrowing five
days for me. With such customer service,
is it any wonder that MTNL complains of
very few customers! Oh, and by the way,
did  I mention the slow speeds?

Amrit,
Delhi

I Won, Thanks To Digit
I am a computer applications student. I
am not a subscriber, but I make sure I buy
Digit every month. Some time ago, the
institute where I study had a Digital Fest
between four selected houses—Microsoft,
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Subject Whats my wish-list

vinitg
Analogue Novice
Location: Mumbai

Hi guys, 
This is my first topic as I am new to the
forum (needless to say completely
hooked). I am a gadget freak with a never
ending wishlist. Just yesterday, I read
about the new digital cameras launched
by all major companies. But not even one
of them featured Bluetooth. Now if only
digital cameras had Bluetooth, it would be
so easy to transfer pix. So rite now I would
love if some company (Sony?) came up
with Bluetooth digicams. 

****************************************

krazydude
In-House Geek
Location: Follow me and I shall set u free

I wish for a mobile phone on which my
friend and I can play DOOM 3 multiplayer
at 1024 x 768 with all the eye candy.

****************************************
gxsaurav
Digitized!
Location: Lucknow

Publicly, I wish for peace on Earth. 
In actuality, here’s the list: 

AthlonFX 55, 2 GB Kingston DDR1, 6800
Ultra, a Zalman reserator with GPU Block,
a Ducati S400, an nForce 4, 10 MBPS
VDSL, a 20-inch Dell 2001FP, a 76 GB
Raptor, a PS3, an MS Optical Desktop
Comfort edition and a job as the
Marketing Manager for nVidia in India.

****************************************

plasmafire
Warmed-Up Nerd
No 12 will be hell 4 u.. I'm dead serious. 
I called up the guy's office. So I know.

I also believe u r missing out a
speaker system.

I wish for a Powermac G5 running
Half-Life 2 and a Microsoft OS that never
crashes.

****************************************

techno_funky
Digitized Spammer
Location: Mumbai

A Swatch (still using a Timex) | AthlonFX
55 | Ferrari F430 | A job at Nasscom | A
Bajaj Pulsar (as of now) | Sony Ericsson
P900 | PS3 | a T1 Net connection | Creative
THX S750 7.1 speakers | Creative Sound
Blaster Audigy 2 ZS Platinum Pro Sound
Card | To become a DJ

Digit Forum

To post your comments on Digit Forum, 
visit www.thinkdigit.com/forum



Linux, Oracle and Cisco. I was lucky
enough to be the House Captain of
Microsoft House. One of segments was a
Multimedia Crossword with topics
ranging from general knowledge to
information technology. I am happy to
report that Digit’s 1001 Amazing Tech Facts
helped us win the crossword, and
eventually made us overall champions. 

Chhama Chenkual
Aizawl

Thank You For SP2
The best thing about the September issue
was the inclusion of Microsoft Windows
XP Service Pack 2 Final Release. Even
better was the review that went in the
magazine. It rightly pointed out the

compatibility problems of SP2 with over
200 programs.

I also find your Upgrade to DVD offer
remarkable. It is a perfect excuse for
buying a DVD-ROM. 

Shailesh Moolya
On e-mail

More Game Reviews, Please
I am truly impressed with the new-look
Digit, and the changes you have brought
about in the magazine, especially the
new, practical way of looking at
technology, and it applications. It is
also great news for Digit readers that
you will now bundle a DVD with every

issue.
But I was disappointed not to find

many game reviews in the September
issue. I also miss Agent 001. Despite all
these minor irritants, Digit remains my
favourite magazine.

Kiran K
Kerala

Lost In The revolution?
I have been a faithful reader of Digit for
the last three years. Undoubtedly, I like
Digit and the revolution it has created in
technology media in India, but there are
some things still missing in the
revolution. 

Agent 001 is lost somewhere in
Lamington Road

Celebrity wallpapers no longer
enhance my desktop

My Winamp no longer looks great
Something called desktop themes is

now Extinct
My PC finds many common files in the

DVD and the CD
May I also request you to add a

complete manual of how to use a Linux
distro, and its complete set of commands,
preferably in PDF.

Kunal Patankar
On e-mail

Negative? What Negative?
As a regular subscriber of Digit, I am
pleased to see it in its new avatar.
A few readers may not like the latest
version. The primary reason being the
rigidity of the human mind to remain
attached to older and ‘safer’ realms. I
could not, honestly, find a single minus
point with the current format.

It is easier to read and talks about
everyday application of technology, and
how it transforms our thinking. All I can
say is: carry on the good work

Shobhit Agarwal
On e-mail

Inbox

In the September issue, the scores
for LG laptops in the Lifestyle cate-

gory got mixed (Page 118). The over-
all score for the LG LM50 was 53.23,
and not 51.63 as mentioned. We
apologise for the error. 

The Digit Team

Notice any goof-ups? 
Write to goof@jasubhai.com

Goof ups

Write to the Editor
E-mail editor@thinkdigit.com

Snail Mail The Editor, Digit, D-222/2, Om Sagar
Building, MIDC, TTC Industrial Estate,  Nerul, 
Navi Mumbai 400 706. 

Digit will publish the best letters on these pages.
Letters may be edited for clarity

For subscription queries, call the Help Desk at 
022-27629191/9200 Fax 022-27629224, or send an e-
mail to help@jasubhai.com
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Change Is The Only
Constant!
Change is inevitable in life, and Digit
has managed to change at the right
moment, with the right content. This is
the real reason behind Digit being the
No 1 technology magazine in India. 

The other day when I was surfing
the internet, I came across a forum
posting that was rather hostile to
Digit. The members seemed
angry because your company
promoted big games in Skoar
magazine rather than giving it
in Digit. The common complaint
was that Digit neither provides full
version games nor big software.
Therefore, they felt Digit readers were
not given a good deal. They were also
not happy with anniversary issue.
Hence they were planning to boycott
Digit en masse.

But your timely changes proved
that you are better judge of market
than anyone else, and that you are a
forward thinking organisation. You
have not only begun giving full games
on the Digit DVD, but also provided a
fabulous offer to upgrade to DVD at low
prices. This is surely a double blow to
both your critics and competitors.

If you allow me, may I also suggest
some changes that will make the
magazine much better?

Make the Contents page simple. Can
you provide page numbers on the cover
so that people can navigate directly to
the page they are interested in?

Can you include Indian astrology
software every month?

Digit can even start giving readers
hardware prices prevailing in the
market.

Do provide full-sized games on the
Digit DVD which have been old
favourites like IGI 2: Covert Strike,
Unreal II: The Awakening, The Great
Escape XIII, World Racing, Lock On,
Silent Storm, Sindbad: Legend of the
Seven Seas, Halo: Combat Evolved, etc. 

CD-ROMs will soon go out of use.
Maybe Digit can then start giving two
DVD and create another revolution just
like you did when you started giving
two CDs years ago.

Upgrade 2 DVD offer should be kept
valid for a longer time.

Sartaj Sharma
On e-mail

Letter 
of the
Month



Bumpy-headed aliens from
the Class M planet Qo’noS

can now get the latest news
beamed live from the Third
Rock from the Sun, The Milky Way,
The Spiral Arm. German
broadcaster Deutsche Welle
(DW) recently added Klingon,
spoken by the alien species
from the science-fiction
franchise Star Trek, to the 30
languages used on its Web site. 

The pages at http://klin-
gon.dwworld.de/english/index.
php were added to celebrate
the site’s 10th anniversary. The

portal-within-a-portal covers
snippets of information on the
Klingons, their customs, their
rituals, their history and their
culture. “The dialogue of cul-
tures does not end at the edge
of our solar system,” Deutsche
Welle Director Erik
Bettermann said. The senti-
ment will surely be shared by
the late Gene Roddenberry, the
creator of Star Trek. 

Deutsche Welle was
Germany’s first public broad-
caster to go online in 1994
(www.dwelle.de). 

Follow
That Nose!

Klingonese, The New Lingo

You can sell anything
on eBay. In fact, you

can also sell ‘nothing’
on it, as people have
done in the past. But
news is made by people
selling next to nothing,
for quite a lot of money. 

Jay Loewer, from the
US, had an old beer can
lying about his house for
as long as he could
remember. The front of the

can has a camel
draped with a blanket
that reads “Are you
thirsty”. 

His friends
suggestd it might
fetch him some
money. Well it did—
$10,999.99 (Rs
5,06,000) to be exact.

Three cheers for
eBay, and remember, be

careful what you throw away!People And Events That Grabbed Headlines—For Better Or For Worse

The Klingon ambassador 
congratulates Erik Bettermann
of Deutsche Welle

AWeb site (Kavkazcenter.com) hosted on
Lithuanian soil pledged $20 million for
the capture of Russian President

Vladimir Putin. The Web site has accused the
President of war crimes. 

The Russian Foreign Ministry wasted no
time in requesting Lithuania’s ambassador
Rimantas Sidlauskas to pull the shutters on the
offending Web site. 

The request was denied. The site used to
operate from servers in the US and Britain, but
was removed after it was accused of being a
source of spam. It is now hosted by Elneta on a
server located in the apartment of renowned
Soviet-era dissident and political prisoner
Viktoras Petkus.

The Lithuanian Foreign Ministry said that
the site cannot be shut down as yet. A court
ruling is expected next year from the country’s
Constitutional Court on a pending case. The
case will determine the site whether goes
against the Lithuanian law.

Putin’ A High Stake

Vladimir Putin: The 20-million-dollar President!
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You move your head and the
cursor follows your nose.

Blink the right eye and it is
translated to a right-click, blink
the left one for a left-click.

Dmitry Gorodnichy, an
inventor from the Institute of
Information Technology,
Ottawa, has developed a com-
puter navigation system that
uses your nose to direct a cur-
sor, New Scientist reports.

The nose-steered nouse is
expected to make using a com-
puter easier for people with
disabilities, or for gamers who
would like nothing better than
to slay monsters with a blink of
an eye or play tennis by bob-
bing the head.

The technology uses a USB-
connected Web cam to track
the user’s nose. Gorodinchy
chose the nose because it is the
easiest facial feature to track.
Motion detection software is
used to pinpoint the blink of a
user’s eye. A double-blink
switches the nouse on.

Dmitry has a nose for innovation

Sell Nothing For Anything
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